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The Aspire Logic 
Aspire has been developed to allow the production of decorative and artistic dimensional carved 
parts. As well as drawing and modeling tools, it includes both 2D and 3D machining, along with 3D V-
Carving / 3D Engraving to allow a huge variety of jobs to be produced as quickly and easily as 
possible. The general work flow logic to apply to most jobs is explained in the diagram below. 

 

Layout 2D Design 
Import Vectors 
Draw Vectors 

Import Bitmaps 

Create 3D Components 
Create shapes from your 2D design vectors 

Create (texture) shapes directly from Bitmaps 
Import 3D Clipart and other CAD systems models 

 

Manipulate 3D Components to create the 3D composite 
model using the Component Tree 

Change location, depth, size, angle etc. 
Group and change relationship to other Components 

 

Create 2D, 2.5D and 3D Toolpaths 
Create or edit vector boundaries for 

toolpaths 
Specify tool details for each strategy 

  
 

Preview Final Part 
Visualize the part as it will actually look 

Create proof images for customer 
Check estimate for cutting time 

 

Save the CNC Code 
Save the final cut file to send to the 

CNC machine 
 

Loop through 
processes until 

model is finished 
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Design 
Aspire includes drawing and editing tools that allow designs to be created and modified. Functions 
for vector creation and editing are very easy to use and multiple design elements can also be drawn 
or imported, scaled, positioned and interactively edited to make a new design. Text can also be 
created using any TrueType or OpenType fonts installed on your computer, or the single stroke 
engraving fonts supplied with the software. 

Model 
Once you have got your 2D design ready, you can start to create 3D components from your 2D 
drawings. This will probably involve adding and changing your 2D artwork a bit as your 3D design 
evolves, so Aspire’s interface makes the drawing and modeling tools easily accessible.  

In addition, existing 3D models can be imported to be incorporated into a design, these could be files 
previously created in Aspire, 3D Clipart that has been purchased and downloaded or models from 
other CAD design systems in a supported format. 

Toolpath 
A comprehensive set of 2D, V-Carving, Engraving and 3D toolpath strategies provide you with 
efficient ways to use your tooling to carve the finished part. This process is usually relatively 
independent of drawing or modeling (although toolpaths are often created directly from some of 
your 2D drawings, as well as your 3D composite model) so, when you are ready, Aspire provides 
some simple interface buttons to toggle screen layout to assist the shift in focus from design to 
toolpathing.  

Output 
Finally you can use Aspire’s vast selection of post-processors to save your toolpaths in precisely the 
format that your particular CNC machine tool requires.
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Overview of the interface  
      

 

1) The Main Menu Bar (the Drop Down Menus) along the top of the screen (File, Edit, Model, 
Toolpaths, View, Gadgets, Help) provides access to most of the commands available in the software, 
grouped by function. Click on any of the choices to show a Drop-Down list of the available 
commands. 

2) The Drawing & Modeling Tabs on the left side of the screen is where you can access all the 
general 2D drawing and 3D modeling tools. On the Drawing tab you will find the tools for creating, 
editing, sizing, alignment and layer control of vectors. On the modeling tab are all the tools that 
relate to the creation, management and editing of 3D components, as well as the Component Tree, 
which shows you all the currently created 3D components and allows you to define how they are 
combined to form your final composite 3D model. 

3) The Toolpath Tab on the right side of the screen is where toolpaths are defined, calculated, edited 
and deleted. The Material set-up and Job Preview tools are also in this area. 

4) If the selected tool has further options it will display a Form where you can specify these settings. 
The Tool’s form generally appear in the tools page from which they were selected. 
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5) The 2D Design window is where the design is drawn, edited and selected ready for machining. 
Designs can be imported or created directly in Aspire. This occupies the same area as the 3D View 
and the display can be toggled between the two using F2 and F3 or the tabs at the top of the 
window.  

6) If you wish to see the 2D and 3D views simultaneously, or you wish to switch your focus to the 
Toolpaths tab at a later stage of your design process, you can use the interface layout buttons 
(accessible in the 2D View Control section on the Drawing Tab) to toggle between the different 
preset interface layouts. 

7) The Modeling and Toolpaths tool pages are split between a list of the current components or 
toolpaths (respectively) and the list of commands that relate to them. The amount of space 
allocated to each area of the page can be adjusted by clicking and dragging the splitter bar up or 
down.   

8) The 3D View is where the Working Model, 3D Components, Toolpaths and the Toolpath job 
preview are displayed. 
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Managing Aspire’s Interface 
The Drawing, Modeling and Toolpath tool pages have Auto-Hide / Show behavior which allows them 
to automatically close when not being used, thus maximizing your working screen area.  

Aspire includes two default layouts, which can automatically and conveniently set the appropriate 
auto-hide behavior for each of the tools pages. Toggle layout buttons on each of the tools pages 
allow you to switch the interface as your focus naturally shifts from the design stage to the 
toolpathing stage of your project. 

Accessing Auto-hidden tabs 
If a tools page is auto-hidden (because it is currently unpinned, see pinning & unpinning tools pages, 
below), then it will only appear as a tab at the side of your screen. Move your mouse over these tabs 
to show the page temporarily. Once you have selected a tool from the page, it will automatically 
hide itself again. 

 

 

 
 
 

Drawing Tab 
 

Modeling Tab 
 

 

Note: If you find that you are using the tools on an auto-hidden tab frequently, you may 
wish to use Aspire’s preset layout buttons to toggle the interface to a more appropriate 
default. Alternatively you can pin the hidden tab out to prevent it from auto-hiding (see 
below). 
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Pinning and unpinning tools pages 
The auto-hide behavior of each tools page can be controlled using the push-pin icons at the top right 
of the title area of each page. 

 

 
Pinned Out (auto-hide disabled) 

 
Un-pinned (auto-hide enabled) 

 

Default layout for Design and Toolpaths 
Aspire has two default tool page layouts that are designed to assist the usual workflow of design, 
followed by toolpath creation. 

On all three of the tools pages there are ‘Switch Layout’ buttons. On the Drawing and Modeling tabs, 
these buttons will shift the interface’s focus to toolpath tasks by ‘pinning-out’ the Toolpaths tools 
page, and ‘unpinning’ the Drawing and Modeling tools pages. On the toolpaths page, the button 
reverses the layout – unpinning the toolpaths page, and pinning-out the Toolpath & Modeling pages. 
You can toggle between these two modes using the F11 and F12 shortcut keys. 
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View Controls 
The View Control options available when working in the 2D Design and 3D Preview windows are, 

2D Design Window 

 

 

Zoom Interactive 

Mouse with Middle Wheel – Push / Pull 

Mouse without Middle Wheel – Shift + Push / Pull 
with Right Mouse button. 

 Zoom Box 

Click top left corner 

Click bottom right corner 

 Pan 

Click and hold the Left mouse button – Esc to cancel 

Shortcut: Click and drag the Middle mouse button or 
if using a 2 button mouse, CTRL + drag with Right 
Mouse button. 

 Zoom Extents Zooms to show material limits in the 2D window 

 

Zoom Selected 

Click to select an object or objects 

Zooms to the bounding box of the selections 

 

Mouse with Middle Wheel can be used to interactively zoom in / out. 

3D Window 
 

 
3D Twiddle Click and drag Left mouse button in the 3D window 

 
Zoom 

Right mouse button – Push / Pull 

Mouse with Middle Wheel –  Rotate wheel 

 
Pan 

Click and drag Right mouse button + Ctrl 

Click and drag Right and Left mouse button  

 
Zoom to Fit 

Zooms the whole 3D part to fit within the current 3D 
View window 

 
Isometric View 

Shows the model in a 3D isometric view in the 3D 
window 
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Plan View (Down Z) 

Shows the top view of the model in the 3D View 
looking down the Z axis 

 
Side View (Down X) 

Shows the side view of the model in the 3D View 
looking down the X axis 

 
Side View (Down Y) 

Shows the side view of the model in the 3D View 
looking down the Y axis 

Pressing F2 & F3 will toggle between displaying the 2D & 3D windows 
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File Operations - Setting up and managing the part 
The first stage in any project is to create a new blank part or import some existing data to work with. 
At this stage a lot of parameters need to be defined relating to the size of the part and its position 
relative to the datum location on the CNC machine. Once the part has been defined and during the 
development process you may want to change the size of the material, import additional data and 
generally manage the project operation. In this section of the manual the initial creation of a part 
will be covered along with all the icons which appear under the File Operations section of the 
Drawing Tab: 

 

How to Start 
When you first start the program you will see two Startup Task options on the left hand tab and also 
a list of your 4 most recently opened Aspire parts. 

The first choice is whether you want to Create a new 
file or Open an existing one. Creating a new file 
allows you specify a size and location for a blank 
work area, set your material thickness and also set 
the model quality and even the shading 
color/material. The process to do this will be 
covered in the next section (Job Setup Form 
Options). 

The second choice, “Open an Existing File” will allow 
you to open a pre-created file from your computer. 
This may be a file you previously created in Aspire 
(*.crv3d), a VCarve Pro job (*.crv) or a 2D vector 
layout from another CAD system (*.dxf, *.eps, *.ai 
and *.pdf). A CRV3D or CRV file will have the necessary information for material size etc. already 
embedded in it, the 2D formats will import the data at the size and position it was created,  but will 
require you to go through the Job Setup form to verify/edit all the parameters for the part. This 
process will be covered in the next section (File Operations) under the “Open File” heading.  
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Job Setup Form Options 

Size 

Width 
The material length along the X axis 

Height 
The material length along the Y axis 

Material 

Z Zero 
Indicates whether the tip of the tool is set off the 
surface of the material (as shown in the diagram) or 
off the bed / table of the machine for Z = 0.0. 

Thickness 
The material thickness along the Z axis 

XY Origin Position 
The X0, Y0 origin for the job on the CNC machine. This 
can be set at any corner or the middle of the job. 

Use origin offset 
Moves the selected material origin relative to 
absolute X0, Y0. 

Units 
Defines the units of measurement that will be used, 
either inches (imperial/English) or mm (Metric). 

Modeling Resolution 
Sets the resolution/quality for the 3D model. When 
working with 3D models a lot of calculation and memory may be required for certain 
operations. Setting the Resolution allows you to choose the best balance of quality and 
speed for the part you are working on. The better the resolution quality chosen, the slower 
the computer will perform. As this is completely dependent on the particular part you are 
working on and your computer hardware performance, it is difficult in a document like this 
to recommend what the setting should be. Generally speaking the Standard (fastest) setting 
will be acceptable for the majority of parts that Aspire users make. If the part you are 
making is going to be relatively large (over 18 inches) but still has small details, you may 
want to choose a higher Resolution such as High (3 x slower) and for very large parts (over 
48 inches) with small details then the Highest (7 x slower) setting may be appropriate. The 
reason that the detail of your part needs to be taken into account is that if you were making 
a part with one large item in it (e.g. a fish) then the standard resolution would be OK but if it 
was a part with many detailed items in it (e.g. a school of fish) then the High or Highest 
setting would be better. As previously stated these are extremely general guidelines as on 
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slower/older computers operations with the highest setting may take a long time to 
calculate.  
As the Resolution is applied across your whole work area it is important to set the size of 
your part to just be big enough to contain the part you plan to carve. It would not be 
advisable to set your material to be the size of your machine – e.g. 96 x 48 if the part you 
plan to cut is only 12 x 12 as this would make the resolution in the 12 x 12 area very low. 

Appearance 
This sets the color or material effect which will be applied to the base 3D model in Aspire. It 
is possible to change this at any time and also to apply different colors and materials to 
different Components using the Component manager. 

In most cases a new job represents the size of the material the job will be machined into or at least 
an area of a larger piece of material which will contain the part which is going to be cut. Clicking OK 
creates a new empty job, which is drawn as a gray rectangle in the 2D Design window. Dotted 
horizontal and vertical purple lines are drawn in the 2D design window to show where the X0 and Y0 
point is positioned. 

Job Setup Form Options (for Open Existing File) 
When an existing 2D data file is opened the same options are presented as for creating a New File 
except there are two additional settings under Data Scaling 
which are explained below. Refer back to the Create New 
File section for all the other options on the form.  

Data Scaling 

Center data in job 
Checking this option automatically moves the vectors in the 2D file into the middle of the 
specified material block. 

Note: Do not select this option if the job needs to stay in its original drawn 
position! 

Scale data with job 
Checking this option automatically scales the vectors in the 2D file to fit the specified 
material block. 

If one or both of these options are chosen, then as the Material Size is changed, then the vectors and 
any components will automatically be scaled or located as the size changes as per the selection.  
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File Operations 
In this section of the manual all the icons under the File Operations section of the Drawing Tab will 
be covered.  

 

 

Create a 
New 
File 

This option opens the Job Setup form (below), which is used to create a 
new blank job of the width (X), height (Y), and thickness (Z) required. 
The relative origins for X0, Y0 and Z0 are also specified at this point, and 
the measurement units can be set in either inches or metric. The 
Modeling Resolution and default 3D shading color/material can also be 
set at this stage.  

 

 

Open 
File 

This option opens the File Open dialog window, allowing existing Aspire 
files (CRV3D extension), VCarve Pro files (CRV) and importable 2D vector 
files to be selected and opened. 

 

 

CRV3D 

Files previously created and saved in Aspire will be opened and displayed in the 2D 
Design window and 3D View if they contain 3D data. All calculated toolpaths are 
stored/opened from the CRV3D file. 
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CRV 

Files previously created and saved in VCarve Pro will be opened and displayed in 
the 2D Design window. All calculated toolpaths are stored/opened from the CRV 
file. 

DXF & 
DWG 

Files from other CAD or graphics software packages such as AutoCAD will be 
opened in the original size and position. The Job Setup Form is automatically 
opened showing the maximum X & Y dimensions of the opened design. The actual 
size of the material can then be specified along with the required thickness and 
appropriate X0, Y0 and Z0 origins. 

EPS 

Files from typical design software such as Corel Draw can be opened. The Job Setup 
form will automatically be opened so the required material size can be specified. By 
default the EPS file will be placed with the lower left corner of the design at X0, Y0. 

AI 

Files from typical design software such as Adobe Illustrator andCorel Draw can be 
opened. The Job Setup form will automatically be opened so the required material 
size can be specified. The AI file will be placed with the lower left corner of the 
design at X0, Y0 

PDF 

Software such as the Adobe product range can be used to convert files from other 
design and word processing software into the industry standard PDF file format. 
The text and vector content of PDF files is extracted when imported into Aspire. 
When importing multiple page PDF documents each page is placed on a separate 
layer.  

 

 

Save 
File 

This option opens the File Save As dialog window and allows the job to be 
saved as a .CRV3D Aspire file. Navigate to the required folder, enter a 
suitable name for the job and click the Save button 

 

 

Import 
Vectors 

This opens the File Open dialog window and allows 2D DXF, EPS and AI 
and PDF files to be imported into the 2D View. The imported vectors 
will always be read in at the size and scale they were created in their 
original design software. Once open they can be scaled and edited in 
the same way as vectors created in Aspire. All the Vector tools will be 
dealt with in that section of this manual. Toolpaths from PhotoVCarve 
and Cut3D can also be imported. 

 

Import 
Bitmap 

This opens the File Open dialog window and allows image files to be 
selected and imported into the current open job. File types - BMP, JPG, 
TIF, GIF, PNG  

Images are imported to trace/vectorize or sketch vectors over the top 
of them or to used to generate a 3D Component directly from the 
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image. This function will be covered in more detail in the 2D and 3D 
design section of this manual.  

 

 

Set Job 
Dimensions 
and origin 

This option allows the Job Setup form to be accessed for the 
current part. All the same options as were detailed in the Open 
New File section are available (material size, thickness, origin, 
scaling, units and color/material) NOTE that 3D resolution can 
only be changed if the working model is empty.  

 

 
Cut 

The Cut tool removes the selected 2D objects from a design in a similar 
way to pressing the Delete key, but the selected objects are copied to the 
clipboard and can be Pasted into either the current file or a new file if 
required. 

 
Copy 

The Copy tool copies selected 2D objects to the clipboard, leaving the 
original in place and allows duplicates to be made and re-used in the 
design by pressing the Paste icon. 

 
Paste 

This Paste option places the contents of the clipboard (created by Cut or 
Copy) into the design, allowing elements to be re-used in different areas of 
a design or in other Aspire parts.  

The Cut, Copy and Paste functions in Aspire can be used on Vectors, Bitmaps and also 3D 
Component Grayscale’s. When a Component Grayscale is pasted the 3D data associated with it will 
also be pasted into the 3D View and the Component Manager.  

 
Undo 

Clicking this option steps backwards through the design changes made by 
the user.  

 
Redo 

Clicking this option steps forward through design steps that have been 
Undone using the Undo command (see above) to get back to stage that the 
user started using the Undo function.  

This concludes the section on the File Operations area of the Drawing Tab.
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2D Design and Management 
The 2D View is used to design and manage the layout of your finished part. Different entities are 
used to allow the user to control items that are either strictly 2D or are 2D representations of 
objects in the 3D View. A list of these 2D View entities is described briefly below and more fully in 
later sections of this manual. 

Ultimately the point of all these different types of objects is to allow you to create the toolpaths you 
need to cut the part you want on your CNC. This may mean that they help you to create the basis for 
the 3D model or that they are more directly related to the toolpath such as describing its boundary 
shape. The different applications and uses for these “2D” items mean that organization of them is 
very important. For this reason Aspire has a Layer function for managing 2D data. The Layers are a 
way of associating different 2D entities together to allow the user to manage them more effectively. 
Layers will be described in detail later in the relevant section of this manual 

Vectors 
Vectors are lines, arcs and curves which can be as simple as a straight line or can make up complex 
2D designs. They have many uses in Aspire, such as describing a shape for a toolpath to follow or 
being a controlling 2D shape for use with one of the 3D modeling functions such as the 2 Rail Sweep. 
Aspire contains a number of vector creation and editing tools which are covered in this manual. As 
well as creating vectors within the software many users will also import vectors from other design 
software such as Corel Draw or AutoCAD. Aspire supports the following vector formats for import: 
*.dxf, *.eps, *.ai, and *.pdf. Once imported, the data can be editing and combined using the Vector 
Editing tools within the software.  

Bitmaps 
Although bitmap is a standard computer term for a pixel based image (such as a photo) in Aspire it is 
used as a generic term for any of the supported types of raster (pixel) based images. Aspire allows 
the following image file formats to be imported: *.bmp, *.jpg, *.gif, *.tif, *.png and *.jpeg. These file 
types are images made up of tiny squares (pixels) which represent a scanned picture, digital photo or 
perhaps an image taken from the internet. In Aspire there are two uses for these, one is to use it to 
fit a vector around specific colors in the image, the second is the ability to take an image and convert 
it into a 3D (texture) Component. Both these functions will be covered in more detail later in this 
document. It should also be noted that many of the Vector Editing tools (Scale, Move, Rotate etc.) 
will also work on a selected Bitmap. 

2D Component Previews 
To make 3D models simple to create, Aspire uses a method which lets the user break the design 
down into manageable pieces called Components. In the 2D View a Component is shown as a 
Grayscale shape, this can be selected and edited to move its position, change its size etc. Working 
with the Grayscale’s will be covered in detail later in this manual. It should also be noted that many 
of the Vector Editing tools (Scale, Move, Rotate etc.) will also work on a selected Component 
Grayscale. 
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Vectors 
Vectors have two very important uses in Aspire, 

1) To describe the shape/boundary/direction of a toolpath 

2) To control 3D shapes created using the icons under the Modeling Tools 

As they are such an important part of two of the fundamental areas of the software there are a lot 
of tools to create, edit and manage them. In this section all these tools and vectors options will be 
briefly described. For practical examples of these tools you should review the tutorial videos.  
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Vector Import 
Decorative vector designs and shapes will often be imported from another drawing package such as 
Corel Draw, AutoCAD etc. rather than being completely drawn in Aspire. The Vector Import icon 

 is located in the File Operations area of the Drawing Tab. Once a vector has been imported 
then the imported vector shape(s) can be modified, moved, scaled, rotated, mirrored or deleted the 
same as vectors created within the software.  

The following Vector file formats can imported into Aspire.  

DXF & 
DWG 

Files from other CAD or graphics software packages such as AutoCAD will be opened 
in the original size and position. The Job Setup Form is automatically opened showing 
the maximum X & Y dimensions of the opened design. The actual size of the material 
can then be specified along with the required thickness and appropriate X0, Y0 and 
Z0 origins. 

EPS 
Files from typical design software such as Corel Draw can be opened. The Job Setup 
form will automatically be opened so the required material size can be specified. By 
default the EPS file will be placed with the lower left corner of the design at X0, Y0. 

AI 

Files from typical design software such as Adobe Illustrator and Corel Draw can be 
opened. The Job Setup form will automatically be opened so the required material 
size can be specified. The AI file will be placed with the lower left corner of the 
design at X0, Y0 

PDF 

Software such as the Adobe product range can be used to convert files from other 
design and word processing software into the industry standard PDF file format. The 
text and vector content of PDF files is extracted when imported into Aspire. When 
importing multiple page PDF documents each page is placed on a separate layer.  

Note: Any bitmap information in the PDF file is ignored. 

While every endeavor is made to keep up with other software companies’ changes in their file 
format it is possible that files in the above formats may not always be readable in Aspire. In that case 
going back to the original design systems and saving the file in an earlier version may enable it to be 
loaded into Aspire.  
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The Create Vectors Tool Group 
Simple shapes and designs can be drawn using the Circle, Oval, Rectangle and Polyline options. 
Shapes can be created by either entering exact dimensions in the Command Window or simply 
clicking the left mouse button in the 2D window to specify the parameters and coordinates 
dynamically by clicking/dragging with the mouse cursor. 

 

The first row of icons in the Create Vectors section of the Drawing Tab are all used to draw different 
types of vector shapes. The second row of icons under Create Vectors are mainly to do with Vector 
Text creation and manipulation plus the plate layout tool and the tool to trace vectors onto the 
colors in bitmap images. 

 
Drawing Shapes 

 
Creating Text 

 
Plate Production 

 
Fit Vectors to Bitmap 
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Drawing Shapes 
There are seven basic shape drawing tools on the Drawing tab. Each tool gives you the option of 
dynamically drawing with the mouse in the 2D View, or entering precise data using the form. When 
you click on a shape tool icon its associated form will open on the Drawing tab. Here you can see the 
precise dimensions of the shape you are working on, which you can edit directly, as well as other 
options specific to the type of shape you are editing. 

If you click on a shape drawing tool when nothing is selected in the 2D View, you will be able to 

create new shapes using the Create  button. If you select a previously created shape, you will be 

able to modify its properties using the same form and update the shape using the Apply  button. 

All these commands and the options within these forms are covered throughout the video tutorials 
included on your installation DVD. 
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Draw Circle 
 Circles can be created interactively with the 
cursor or by entering the exact coordinates 
and diameter/radius with typed input. 

Interactive 
This is the default mode and the procedure for 
drawing circle is: 

• Click & drag the Left mouse to indicate 
the center point and radius / diameter 

Exact Size 
• Accurate circles can be drawn by 

entering the required XY origin point, 
selecting either Radius or Diameter and 

entering the required size. Click Apply  to 

update the circle. 

Edit 
Open the Draw Circle form and select the circle to modify. 

• The selected circle is displayed as a dotted Magenta line 
• Edit the Center Point and Radius or Diameter 

• Click Apply  to update the circle 

Close the form 
To finish drawing with tool, you can: 

• Click Close  on the form 

• Press the Esc key 
• Click the Right mouse button in the 2D View. 
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Draw Ellipse 
 Ellipse / ovals can be created interactively 
with the cursor or by entering the exact 
coordinates for the center point, height 

and width with typed input. 

Interactive 
This is the default mode and the procedure 
for drawing ovals is: 

• Click & drag the Left mouse to 
indicate the Anchor point and the 
required Width and Height. 

Exact Size 
• Accurate ovals can be drawn by 

entering the required XY origin point, 
with the Width and Height of the 

oval. Click Apply  to update the view. 

Edit 
Open the Draw Oval form and select the oval to modify. 

• The selected shape is displayed as a dotted Magenta line. 
• Edit the Width and Height values. 

• Click Apply  to update the shape in the 2D View. 

Close the form 
To finish drawing with tool, you can: 

• Click Close  on the form 

• Press the Esc key 
• Click with the Right-mouse button in the 2D View 
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Draw Rectangle 
 Rectangles can be created interactively 
with the cursor or by entering the exact 
coordinates, type of corners (square, 

internal or external radius) and Width and Height 
using typed input. 

 

Interactive 
This is the default mode and the procedure for 
drawing rectangle is: 

• Click and Drag the Left mouse button 
to indicate the first corner followed by 
releasing the button at the required 
size. 

Options 
• Holding Shift and dragging creates a 

rectangle from the middle point. 
• Holding Ctrl and dragging creates a 

square. 

Corner Type 
Corners on the rectangle can be Square, Radiused Externally and Internally. 
 

 

Exact Size 
• Accurate rectangles can be drawn by entering the required XY origin point with the 

Width and Height of the rectangle. 

• Click Apply  to update the circle. 
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Edit 
Open the Draw Rectangle form and select the rectangle to modify. 

• The selected shape is displayed as a dotted Magenta line 
• Edit the Width and Height values. 

• Click Apply  to update the circle 

Close the form 
To finish drawing with tool, you can: 

• Click Close  on the form 

• Press the Esc key 
• Click with the Right-mouse button in the 2D View 



 
25 Navigation Homepage 

 
 

Draw Curve 
 This tool creates a smooth flowing continuous curve through clicked points. Simply move 
the cursor to the point where a point is required and click the left mouse button. 

 

Note: Draw Curve does not require an associated form, just use the mouse cursor directly 
within the 2D View. 

Notes 
• Placing the cursor close to the first point on the curve will snap the curve closed. 
• Pressing the Space bar finishes the current curve and keeps the Draw curve mode active so 

additional curves can be drawn. 
• Clicking the Right mouse button or pressing the Esc key finishes the operation 
• Use the Node editing tool to modify the shape of a curve 
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Draw Polyline 
 This tool creates continuous straight 
lines through points clicked or 
entered coordinates. Move the 

cursor to the point where a point is required 
and click the left mouse button to create a new 
line. Or enter the appropriate XY position, 
distance or angle.  

Click the Add  button to enter a new point. 

The Undo  button deletes the last point 

entered and allows a new point to be added. 

The Finish  button completes drawing the 

current line and leaves the form open to allow 
additional lines to be drawn. 

Notes 
• The X Y position uses absolute 

coordinates. 
• The Angle, Length and dx / dy positions are incremental from the current position. 
• Placing the cursor close to the first point on the polyline will snap the polyline closed. 
• Pressing the Space bar finishes the current polyline and keeps the Draw line mode active so 

additional lines can be drawn. 
• Clicking the Right mouse button or pressing the Esc key finishes the operation 
• Select the Node editing tool to modify the shape of a polyline and use the Right Hand mouse 

form option Properties to specify the exact position of a node. 
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Draw Polygon 
 Polygons (eg. Triangles, Pentagons, 
Hexagons etc.) can be created interactively 
with the cursor or by entering the number 

of sides, exact coordinates and radius using typed 
input. 

Click and drag the Left mouse button to add a polygon 
with the specified number of sides. 

First click specifies the middle point for the polygon 
while dragging the cursor sets the Radius / outside 
diameter for the completed shape. 

Notes 
• The X Y Center Point position can be 

typed or the first point clicked in the 
2D view. 

• Clicking the Right mouse button or 
pressing the Esc key finishes the operation 

• The properties of a polygon can be edited at any time by selecting the star and 
clicking the Draw Polygon icon. This opens the form with the current size and 
position of the selected polygon and these values can then be edited. 

 
6 sided Polygon 
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Draw Star 
 Stars can be created interactively with 
the cursor or by entering the number of 
points, exact coordinates and outer radius  

and inner radius percentage using typed input. 

• Click and drag the Left mouse button to add 
a polygon with the specified number of 
sides. 

• First click specifies the middle point for the 
polygon while dragging the cursor sets the 
Radius / outside diameter for the completed 
shape. 

Notes 
• The Inner Radius is specified as a 

percentage of the Outer Radius. 
• Clicking the Right mouse button or 

pressing the Esc key finishes the 
operation 

• The properties of a Star can be edited at any time by selecting the star and clicking 
the Draw Star icon. This opens the form with the current size and position of the 
selected star and these values can then be edited. 

 
6 Pointed Star 
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Creating Text 
There are a number of tools dedicated to the creation and editing of text. These can be found on the 
Drawing tab, below the shape creation tools. 

Use the Draw Text, or Draw Auto Text, to create text within your design. The Text selection tool then 
allows you to dynamically alter the text positioning, spacing or even to bend your text into an arc. 
For even more flexibility, use the Text on Curve tool to place your text along any vector curve or line 
that you have drawn. 

The text tools are accessed using the following icons: 

 Draw Text 

 
Draw Auto Text 

 
Text Selection 

 
Convert text to Curves 

 
Text on Curve 

 

Draw 
Text 

Draw 
Auto 
Text 

Text 
Selection 

Convert 
text to 
Curves 

Text on 
Curve 
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Draw Text 
 This option allows text to be created at any 
height using the units the model is being 
designed in (Inch or MM). 

Options 
The Larger Edit…  button opens a larger text entry 

window that makes it easier to enter text that needs to 

run on longer line lengths. Clicking OK  accepts any text 

entered into the window and Cancel  will throw away 

any changes. 

Text Alignment 
Positions text relative to the selected bounding 
box or material size with options for left, center 
and right aligned. 

Anchor 
Sets the position of your text block. Either enter 

values directly and click Apply , or click in the 2D 

View with the mouse cursor to set the position 
values interactively. 

Edit Text 
To edit text properties or content 

• Click the Left mouse to select the appropriate 
text object 

• Click the Draw Text icon 

The Text Editing form is displayed in the Drawing Tab, where the content and properties can be 
modified as required. 

• Click the Apply  button to update the changes in the 2D View. 

• Click the Cancel  button to finish or cancel the editing and close the form 
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Draw Auto Text 
 This option automatically sizes a block of 
text to fit inside the boundary box (width 
and height limits) of a selected vector or 

vectors. If no vectors are selected the text is scaled to 
fit the size of the material. 

When the Text form is open the Dimensions for the 
Width and Height of the selected vectors or job 
dimensions are shown, and these are used to 
constrain the font size of the text. 

Entering Text 
The procedure for Drawing Text in the 2D Window is: 

• Select the vector inside which the text is to 
be fitted 

• Click the Draw Text icon 
• Enter the required text content 
• Select the font either True Type or Single Line 

as required and alignment options 

• Click Apply  

Engraving Fonts 
Engraving Fonts that are very quick to engrave are 
also available by selecting the Font option for Single 
Line characters. The available fonts are then 
displayed in the list. 
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Note: If no vector(s) are selected to define the bounding box, the text is sized to the material and 
positioned centrally 

Options 
The Larger Edit…  button opens a larger text entry window that makes it easier to enter text that 

needs to run on longer line lengths. Clicking OK  accepts any text entered into the window and 

Cancel  will throw away any changes. 

Text Alignment 
Positions text relative to the selected bounding box or material size with options for left, 
center and right aligned. 

Bounding Box Dimensions 
These the actual size of the box into which the text will be fitted. If the text is scaled 
interactively (by left clicking twice on the text) or precisely using the scale tool, the new 
bounding box is updated and displayed as a light gray rectangle. 

Margin Size 
The distance between the text and the bounding box where: 

None 
Scales text to fit the rectangle width or height of the bounding box 

Normal 
Scales text to fit within 80% of the bounding leaving a 10% border to the left and right. 

Wide 
Reduces the size to 60% of the rectangle width leaving a 20% border to the left and right. 
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None Normal Wide 
 

Note: The font size is automatically scaled to give the selected margin size. 

Options 

Vertical and Horizontal Stretch  
Allow the text to be stretched to fit inside the bounding box by changing the line or letter spacing, or 
stretching the character height or width. 

Note: The Auto Scaling functionality calculates the maximum text size that can be fitted 
into the selected bounding box. The result will depend on the aspect ratio of the bounding 
box and either the width or height of this box will determine the size of the text. 

Only one of these stretching options will be applicable at any one time. The example below 
shows how text is being constrained by the width of the bounding box, not the height. 
When the text size is limited by the width of the bounding box it's then possible to stretch 
the Vertical height of the text block as shown below. 

   
No Vertical Stretch with the text being 

constrained by the width of the box 
 

Stretch Line Space to fit 
 

Stretch Characters to fit 
 

The next example shows text aligned to the Center and being constrained by the height of the 
bounding box. So in this case the Horizontal Stretch options are applicable. 

No Horizontal Stretch with the text being 
limited by the height of the box 

 

Stretch Spaces between words 

 

Stretch letter Kerning (spacing between 
letters) 

 

Stretch Character size 
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Edit Text 
To edit text properties or content 

• Click the Left mouse to select the appropriate text object 
• Click the Draw Text icon 

The Text Editing form is displayed in the Drawing Tab, where the content and properties can be 
modified as required. 

• Click the Apply  button to update the changes in the 2D View. 

• Click the Cancel  button to finish or cancel the editing and close the form 
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Text Selection 
 Character and Line spacing can be edited interactively using the Edit Text Cursor. 

Interactive Letter kerning and Line Spacing 
Select the cursor and click to select the Text to be edited. The text will be displayed as 

Magenta lines with 2 Green handles in the middle, as shown below, 

 

Letter Kerning  
The interactive kerning and line spacing cursor is shown when placed between letters or lines: 

 

The interactive letter kerning allows default text to be modified so that adjacent pairs of letters sit 
more naturally together. A typical example is shown above where the capital letters W A V are 
placed next to each other and the default space is excessive. 

• Place the cursor between 2 letters and click the Left mouse button to close the gap. 
• Holding the Shift key and clicking the Left mouse button moves the characters apart. 
• Holding the Ctrl key when kerning doubles the distance each letter moves on each click 
• Holding the Shift & Ctrl keys together and clicking the Left mouse moves the letters closer 

together in larger increments. 

Line Spacing 
Line spacing can be modified by placing the Edit Text cursor between lines. It will change to the line 
spacing cursor: 

 

• Clicking Left mouse button will move the adjacent lines of text closer together - Default 
mode 

• Holding the Shift key and clicking the Left mouse button will move the lines apart 
• Holding the Ctrl key doubles the distance each line moves on each mouse click. 

Text Arcing 
The interactive rotation and movement cursor is displayed when the cursor is placed over either of 
the Green Handle to indicate that the text can be arced either Upwards or Downwards: 
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Bend Text Upwards Bend Text Downwards 
• Click & Drag the Bottom Green box to arc the text Downwards 
• Click & Drag the Top Green box to arc the text Upwards 

The text can easily be dragged back into the horizontal position using the green boxes 

After arcing text additional Red and Blue handles are displayed for Rotating and Moving the text. 

 

Clicking and dragging the Red boxes rotates the text around the center point of the arc. 

Holding the Ctrl key forces the rotation to be in 15 degree increments. This allows the text to be 
positioned exactly on the horizontal or vertical quadrants, even after it may have been moved 
slightly. 

Clicking and dragging the Blue boxes moves the text vertically and changes the radius onto which the 
text is mapped as shown below. 
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Convert text to Curves 
 In most cases all Text created in Aspire can be VCarved, Engraved, Pocketed and Profile 
machined or used with the 3D modeling functions. Some fonts do occasionally include 
loops and problems that need fixing using the Node Editing tools before it can be utilized 

for other functions. This text first has to be converted to Curves, creating lines, arcs and Bezier spans 
that can be interactively edited to fix the problem areas.  

Script style fonts that are based on overlapping characters can be VCarved or Engraved without 
having to first convert the characters to curves. 

 

If the individual characters contain overlapping vectors or loops these will need fixing manually using 
the Node editing tools. 

When Profile Machining with Tabs is required the text must first be converted to curves. Opening 
the Tab form on the Profile machining form will show a message stating that the text must first be 

converted to curves and clicking the Yes  button will automatically make the conversion. 

Text can be converted to curves at any time by selecting the icon or clicking the Right mouse button 
and selecting Convert Text to Curves. 

Note: After converting text to curves it cannot be edited as a text block. 
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Text on Curve 
 This tool creates requires the user to select 
a single line of text and a single vector 
curve/line. It will take the text and fit it onto 

the selected vector to follow the curvature. Options 
within the tool allow position, space and location 
against the line to be edited. 

Text Size 

Maintain text Size 
Will not change the size of the text block 

 

Scale text to fill curve 
Will increase the character size in order to fit 
along the entire length of the selected curve. 

 

Text Spacing 
The slider can be used to increase or decrease 
the word and character spacing. 

Text Position 
The position of text relative to the curve is 
calculated using the height of the largest letter 
in the selected text string. 

Above Curve 

 

On Curve 
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Below Curve 

 

Text on other side 

 

Offset Distance 
Allows the text to be moved away from the curve by a specified distance. 

Text Alignment 
The 3 options allow the text fitted to the curve to be aligned to the left, middle or right hand 
side of the selected curve. Or, when using a closed vector curve, relative to the Start Node. 

Remember the Start node can be changed using the Node Editing Tools available 
from the Right mouse menu. 

Characters in the text string can also be aligned 'normal' to the drive curve or left in the 
original vertical position. 

  
Align to Curve Keep Vertical 
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Plate Production 
This command is for designing and engraving multiple badges or nameplates using 
variables for positioning imported data from a text file list. The production plate 
functionality is typically used by engravers making badges from a database file supplied by 

a customer, but could also be useful for making nameplates for hotel rooms with consecutive 
numbering.  

 

Note: This function cannot be used with 3D Data or 3D toolpaths. 

Procedure 
The general procedure for using the Production Plate functionality is, 

Draw and Setup the Master Template 
Create a New job and specify the Material Size = the Sheet size the badges will be cut from. 

Layout the badge / plate at the required size and using the Text Tools add variables where imported 
data / text is required. Variables are defined using double exclamation marks!! at the start and end 
of the variable name. 

 



 
41 Navigation Homepage 

 
 

 Calculate Toolpaths 
Select and calculate the toolpaths for each of the elements on the design. For example, calculate an 
engraving toolpath for the text and logos and a separate Profile cut-out toolpath around the outer 
edge to cut out the design. 

 

Note: A Profile cut out toolpath can also include Tabs and these will be added to each of 
the badges holding them in place if required. 

Toolpaths are optional and Production Plate functionality can be used to simply create the necessary 
vectors and text etc. for a batch of plates. 

Use the Plate Production Tool on the master template 
With all of the vectors that make up the master template selected, click on the Plate production tool 
to open the Plate Production Dialog window. 
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The Plate Production Dialog 
The left side of the Plate Production form is used to layout the plates / badges on the selected sheet 
of material, and shows the total number of plates that can be engraved / machined from each sheet 
of material. 

 

Material Size 
This is the material sheet size that the badges will be engraved onto. If the number and size of the 
badges requires additional sheets of material to be used the software automatically creates a 
separate layer for each sheet required. 

Plate Size 
This is the size of the selected Template / Badge and is based on the bounding box of the selected 
vectors. 

 Sheet Margins 
This specifies the border margin between the edge of the material sheet and the plates. 

Independent margin spacing can be set for the Top, Bottom, Left and Right sides of the material 

Equal Margins ensures the same space is added around all 4 sides of the plates. 

Spacing 
This is the horizontal and vertical spacing between each plate / badge. 
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Number of Plates 
The number of plates that will fit on to the specified material sheet size is automatically calculated. 
This calculation takes the plate size and adds the Sheet Margins and Plate Spacing to determine the 
maximum number of plates that can be made from each sheet. 

Toolpath Options 
If toolpaths have been calculated for the master Template this option is available. 

Checking this option automatically calculates toolpaths for all the plates / badges in the project. 

Unchecking this option only creates the vectors for each plate / badge. 

Import the Data to be Merged into the Template 
The right-hand side of the Plate Production form is used to select the data that will be merged into 
the template, and how the data will be interpreted to create each plate / badge. 

Import From File 

Import the required text / data file and select the appropriate format separator. 

The data file is commonly created using a spread sheet such as Windows Excel. Use the option to 
Save As or Export to obtain the required file format that includes the correct Separator information. 

Separator 
The separator is the method used in the data file for dividing each set of information into columns. 
The most commonly used options are: Comma, Tab, Semicolon and a Space 

First row is column names 
It's very common for the first row of data in a file to simply show what each of the field 
names are, and this information is not used on the badge or plate. Checking the box First 
row is column names tells the software to start working with data from row 2 

 Assign the Variables to the data in the text file 
All of the variables specified on the template - text with double exclamation marks !! on ether side !! 
are automatically listed on the form. These variable names are each assigned to a data field (column 
of text) inside the data file. 
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Variable Assignment 
Click to select a Variable Name then select the data field from the imported file that is required on 
each badge / plate. ie the persons name 

 

Repeat for each of the Variable Names listed on the form 

Number Formatting 
Variables can be assigned to Text from a data file - Names, Dept etc. or to a Counter number that 
can be formatted and incremented using the Number Format options. 

 

Calculate 
Click Calculate  to create all Badges and associated Toolpaths 

If toolpaths have previously been calculated for the vectors in the Master Template, the option to 
automatically Create Toolpaths for each badge / plate is switched on in the bottom left corner of the 
form. 

Close 
Click Close  to finish plate production and close the form 



 
45 Navigation Homepage 

 
 

Multiple Sheets 
Multiple Layers are automatically created if multiple sheets of material are required to engrave all of 
the badge data from the imported text file. Layer named Sheet 1 is displayed in the 2D view showing 
the badges on this sheet. 

Each of the Sheets is on a different layer and can be set visible or invisible using the Layer Manager. 
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Multiple Toolpaths 
When Toolpaths are automatically calculated a separate toolpath for each operation on each sheet 
of material is calculated and named using the convention S1 - Name. Where the Name is the name 
of the toolpath previously calculated for the template. 

 

The example above shows the original 3 toolpaths calculated for the master template - Logo, Text 
and Cut Out. Plus the 2 sets of new toolpaths created to engrave onto 2 sheets of material. 

• Sheet 1 3 toolpaths - Logo, Text and Cut Out 
• Sheet 2 3 toolpaths - Logo, Text and Cut Out 

Note: Using Edit Undo directly after calculating a batch of plates / badges will 
automatically delete all vectors, layers and toolpaths created by the calculate operation. 
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Fit Vectors to Bitmap 
 This tool automatically traces or fits vectors to image files so they can be machined. 
Import and select an image in the 2D view, then open Fit Vectors to Bitmap. 

After importing an image the Tracing option allows vector boundaries to be created 
automatically around regions in the image.  

Images can be traced either in color or black and white mode. 

 

All these commands and the options within the forms are covered in more detail in the Help File in 
the software (from the menu bar select Help and then Help Contents and click on the relevant part 
of the interface to jump to the Create Vectors section). In addition vector drawing will be touched on 
throughout the video tutorials enclosed with the software. 

This tool automatically traces or fits vectors to image files so they can be machined. Import and 
select an image in the 2D view, then open Fit Vectors to Bitmap. 

Working with Color Images 
Color images are automatically reduced to 16 colors and the slider allows the visible number of 
colors to be set as required. Colors are merged with the closest match. 

Colors can be temporarily linked together by clicking the check boxes next to each of the color’s 
displayed. This changes the color displayed in the 2D view to the selected Trace Color. This is very 
useful for merging similar color’s together to allow complete regions to be traced. 

If a new Trace Color is selected the linked color’s are displayed using this color in the 2D view. 
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The Reset button unlinks all the checked color’s and the image displayed in the 2D view reverts back 
to the original 16 color image. 

Working with Black & White Images 
When working with Black & White images the slider can be used to change the Threshold and merge 
the levels of gray between all white (min) or all black (max). 

 

When the image being displayed in the 2D view looks correct then clicking the Fit Vectors button 
automatically creates vector boundaries either around the selected Trace Color or the grayscale. 

The options available on this form control how closely the vectors fit / follow the selected color 
boundaries and these can be modified to obtain improved results. 
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Corner Fit 
The Corner Fit control determines how accurately the vectors are fitted to the corner edges in an 
image. 

  
Loose Tight 

Loose 
Loose will create smooth curves that may not follow corners very precisely but will create smooth 
free-flowing vector boundaries, with few nodes. 

Tight 
Tight inserts nodes to ensure the vector accurately follows the color boundary, to create sharp 
detail. 

Replace 
When Replace Existing Vectors is selected, clicking the Fit Vectors button will delete the last set of 
calculated vectors with the new vectors. This is very useful as it allows the settings to be modified 
and a new set of vectors calculated to see what the results will look like without ending up with lots 
of duplicates 

Un-checking Replace Existing Vectors will add a new set of vectors every time the Fit Vectors button 
is clicked. This will typically result in unusable duplicate vectors. 

When using the Trace Color option it's sometimes useful to link a region of color’s together, fit 
vectors and then link a new region or color’s together, un-check the replace existing vectors option 
and fit another set of vector boundaries. 

Noise Filter 
The Noise Filter slider controls the minimum size of pixels that are traced / vectorized, preventing 
small unwanted vectors or noise being created. 

For example, if an image contains single or very small clusters of pixels that aren't needed for 
machining a design. Then using the noise filter slider set at 4 pixels will ignore 2 x 2 or smaller pixel 
clusters. 
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Note: It's often useful for the vectors to be created on a different layer to the Bitmap layer. 
Therefore, remember to select a different layer before creating any vectors. 
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The Edit Objects Tool Group 
The tools in this section of Drawing Tools page all relate to objects that you can see in the 2D View, 
in particular vector drawings, and is where you will find the tools used to organize, manipulate or 
modify these objects. 

  

The tool group is organized in the following way: 

 
Object Selection Tools 

 
Grouping & Ungrouping 

 
Measure Tool 

 
Distort Tool 

 
Move, Scale & Rotate Tools 

 
Copy Object Tools 

 
Nesting 

 
Offsetting 

 
Object Merge tools 

 
Filleting, fitting & Trimming tools 

 
Joining & Closing Tools 
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Object Selection Tools 
Once vectors have been created within Aspire or have been imported from other design software 
packages you may want to make changes to them. These changes may be to prepare for machining 
or for use as construction vectors for making 3D shapes using the Modeling Tools. There are a 
number of functions for editing vectors which will be covered in this section of the manual. All the 
icons under the Edit Vectors section of the Drawing Tab will be referenced along with the icons 
under the Align Objects section of the menu.  

Editing Modes 
From the 2D view a vector can be selected and then 3 different editing modes allow different 
dynamic edits to be made to the vector(s) depending on which option is selected from the Edit 
Vectors section.  

The three editing modes are; Vector Selection, Node Editing and Interactive Selection. By default the 
software is normally in the Vector Selection mode. 

Vector Selection Mode 
 Selected from Edit Vectors section 

When the Vector Selection Tool is chosen, the selected vectors are shown as dotted purple 
lines. Vectors need to be selected before any of the editing tools such as scaling and moving etc. can 
be used. 

Vector selection methods 
Multiple vectors can be selected in the following ways. 

Manual multiple selection 
Hold down the Shift key while clicking the Left mouse button on each vector required. 
Objects can be deselected by simply clicking on the object again with the Shift key pressed. 

Moving the cursor from Left to Right selects only FULLY enclosed objects. 
Click and drag the left mouse button moving from Left to Right selects all objects fully inside 
the selection rectangle. 

Moving the cursor from Right to Left selects all objects INSIDE the selection rectangle 
and also any objects that the selection rectangle TOUCHES. 
Click and drag the left mouse button moving from Right to Left selects all objects inside the 
selection rectangle + any that the selection touches. 

Pressing the keyboard keys Ctrl + A will select all vector objects in the design 
Selected vectors are displayed as dotted purple lines. 

Vector deselect 
• Selections can be cancelled by simply, 
• Left clicking on an area outside the selection  
• Pressing the Escape key 
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• Pressing the Right mouse button and selecting Unselect All (top option) from the list. You 
must click on the white drawing background to get this option in the menu. 

Node Editing Mode 
 The Node Editing tool can be selected from the Editing window or by pressing the Keyboard 
shortcut N to toggle between Selection and Node Editing modes. 

  
Vectors selected Bezier node editing 

 

When the Node Editing tool is active the cursor changes to a Black Arrow indicating that individual 
points (nodes) can be edited. Nodes can be interactively moved by clicking and dragging the left 
mouse button on a node to select and move the node to a new position. 

The shape of lines, arcs and Bezier (curve) spans can be edited by clicking and dragging on the nodes 
or control points to move them. Multiple nodes and control points can be selected and moved by 
using the multiple selection options such as the Shift key and dragging to make a selection. 

If you right click on nodes or spans a context sensitive popup menu will be displayed which allows 
you to insert or delete points and nodes, cut the vector, move the start point etc. 

Node editing vectors is a very powerful way to be able to make changes to the vectors in your part. 
The node editing options are covered in a lot of detail in the Help Contents section of Aspire’s Help 
file.  

Interactive Selection Mode 
The Interactive Move, Scale, Rotate Selection tool is used to quickly and easily modify  

Clicking twice on one of the selected objects and the interactive scaling, movement and rotation 
handles are displayed in the same way as selecting this icon. Lines, arcs and bezier spans will be 
displayed as Dotted Magenta Lines and Text and Grouped objects will be displayed as Solid Magenta 
lines as in the image shown below. 
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When in this mode the mouse is used to click on one of the handles which has appeared on the 
selected Vector/s. Each handle is used for a specific editing operation as detailed here: 

Handle Operation Additional options 
White Middle box Move the selected objects Hold Shift for linear X or Y moves 
White Corner boxes Scaling proportionally Hold Shift for scale from middle 
Black Corner boxes Rotating dynamically Hold Shift 15 degree increments 
White Edge boxes Scaling non-proportionally Hold Shift for symmetrical scale 
 

You can deselect objects by clicking on the white background area, unless the Shift key is pressed. 

Objects can also be deselected by pressing the Esc key or click Right mouse > Unselect All. 
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Grouping & Ungrouping 
Grouping objects allows you to select, move and manipulate them as if they were one entity. The 
process is entirely reversible by Ungrouping. 

Group selected Objects 
 Vectors can be Grouped allowing any number of vectors to be included as a single object 
that can easily be selected, moved and scaled etc. ShortCut key for this operation is G. 

Grouping vectors is particularly useful for machining purposes, where different vectors will be used 
for a single toolpath operation. Clicking any member of the group will select the entire group. 

Ungroup Selection 
 Ungroups a set of Grouped vectors back to its individual vectors before it was grouped. 
ShortCut key for this operation is U. 

 

Ungroup to the group’s layer 
By default, when grouped objects are ungrouped they revert to the layers on which they had 
previously been located before the grouping operation. However this is sometimes inconvenient. For 
example, when you have copied a group of vectors to a new layer, it is easier for subsequent editing 
if the copied vectors to remain on the new layer, even after ungrouping. An alternative right-click 
pop-up menu command has been added to make this process easier.  

A shortcut key combination is also available to provide support for both of the ungroup operations. 
In summary, therefore, the group and ungroup shortcut options are as follows: 

Shortcut Action 
G Group the selected objects 
U Ungroup the selected objects to their original layers, sub-groups remain grouped. 
Ctrl + U Ungroup the selected objects to the group’s layer, sub-groups remain grouped. 
Shift + U ‘Deep’ ungroup the selected objects to their original layers. Sub-groups are also 

ungrouped. 
Ctrl + Shift + U ‘Deep’ ungroup the selected objects to the group’s layer. Sub-groups are also 

ungrouped. 
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Measure Tool 
The Measure tool allows you to find important 
information about your model or drawings. 

It has two modes (please note that the options 
available in both modes are shown in the image here 
for convenience of documentation, but they are not 
normally available simultaneously). 

Measure Between 2 Points 
With this option selected, you can click on two points 
in the 2D View and the form will report all the salient 
measurements between the clicked locations 

Distance 
Straight line distance between the two points. 

Angle 
The angle (in degrees) of the line joining the 
two points, where horizontal is zero degrees 
and vertical is ninety degrees. 

X Distance 
The separation between the two clicked points 
in X only. 

Y Distance 
The separation between the two clicked points 
in Y only. 

First Point 
The precise X and Y coordinates of the position first clicked. 

Cusor Position 
The dynamically updated coordinates of the mouse cursor position. 

Span / Contour Properties 
This mode allows you to find precise information about the individual spans of a vector 
shape in 2D View. Use your mouse pointer to click on any part of the shape and the 
information relating to the entity you have clicked will be displayed on the form. 

Type 
The type of span you have clicked. Possibilities include: 

• Line 
• Arc 
• Bezier Curve 
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Length 
The length of the clicked span. 

Start Point & End Point 
The precise coordinates of the node forming the start and end of the selected span. 

Vector 
Information relating to the whole vector, of which the selected span is part, is shown in this 
section. 

Area 
The total area of the selected vector 

Perimeter 
The total length of all the spans forming the perimeter of the shape 

Num. Spans 
The total number of spans in the shape. 



 
58 Navigation Homepage 

 
 

Distort Tool 
This tool allows you to bend and flex a vector or component by manipulating a distortion 
envelope using Aspire’s standard node editing tools. You can select one or more vectors 
or components and then use one of the three different tool modes to create your initial 

distortion envelope. 

If you try to use this tool to modify multiple, grouped or distorted components you will first be 
prompted to ‘bake’ your selection components into a single object. For more information on what 
this means, please see the section Baking Components. 

Note: You can distort several vectors at once, or several components, but you cannot distort a 
mixture of vectors and components together in a single operation. 

Once the distortion envelope has been created, you 
can use Aspire’s node editing tools to add or edit its 
nodes and spans. As you alter the shape of the 
envelope the associated object will be distorted to 
reflect the changes.  

Baking Distortion into an Object 
Once an object has been distorted, node editing will 
always relate to the object’s distortion envelope. If you 
wish to edit a distorted vector directly again, you will 
first need to permanently apply the distortion to the 
shape.  

If you select an object that already has a distortion 

envelope while in the Distort Object tool, the Bake  

Distortion  button will be available. Clicking this button 

will permanently apply your current distortion and you 
will then be able to either distort the object again (with 
new settings), or node edit the shape directly.  

Bounding Box 
This option is available if you have a selection of 
vectors or components (note that you cannot mix 
vectors and bitmaps in this mode). It creates a 
distortion envelope based on the closest bounding box 
that can be drawn around your selection. Thus the 
resulting envelope is always initially a rectangle, 
comprising four line spans and a node at each corner. 
Using the normal node editing tools, however, you can 
modify this envelope as much as you like and the 
shape within it will be distorted accordingly. 
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Along A Curve 
This option is only available if the last item in your selection is an open vector that Aspire can use to 
define a curve along which the other selected objects will be distorted. The distorted object can 
comprise one or more vectors or one or more components, but not both. 

Using this option, you will usually end up with your objects bent to match the curve in your original 
selection. The distortion curve itself is left unchanged by this operation. 

Between Curves 
This option will become available if the last two objects in the current selection are open vectors, 
between which the other objects can be distorted.  

 

The other objects in the selection can comprise one or more vectors or one or more components, 
but not vectors and components together. 

Therefore two examples of valid selections for this operation would be: 

• 3 vector shapes and 2 open curves  
• 3 components and 2 open curves 

But not: 

• 1 vector shape, 1 component and 2 open curves. 

The selected objects will be stretched and squeezed between the two curves that were last in the 
selection. Neither of the contributing distortion curves in the selection will be altered by the 
operation. 
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Move, Scale & Rotate Tools 
The icons to move, scale, rotate, mirror and make copies of different items are located under the 
Edit Objects section of the Drawing & Modeling Tabs. 

These are a very important set of tools as they can be used to manipulate vector drawings, bitmap 
pictures and 3D Components (using their associated 2D Grayscale Previews). If you have a 3D 
Component and need to specify a specific size, location, rotation angle or make multiple copies of it 
then these are the tools that will be used. 

Move 
 Selected vectors/bitmaps/component 
grayscale previews can be accurately moved 
and positioned using this option. 

Move Interactive 
The default mode is to enable selected objects to be 
moved interactively by clicking and dragging with the 
cursor. 

Holding down the Shift key when dragging objects 
around will constrain the movement to either the X or Y 
axes. 

Anchor 
The anchor position determines the point on your 
selected object’s bounding box that will be moved to 
the absolute position entered. 

Type of Move 

Absolute 
In this mode, the X & Y Position values will be 
used to position the object’s anchor point 
directly. 

Relative 
With this option selected, the values entered in 
the X & Y Position fields will incrementally offset 
the object from its current position, by the 
distances entered. The Anchor options are not 
relevant in this mode and so will be disabled. 

The keyboard shortcut M opens the Move form in interactive mode. 

Pressing the Escape key or clicking Close  will close the form. 
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Note: Pressing F9 at any time with an object selected will instantly move the selected object, 
centering it exactly in the middle of your material. 
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Set Size 
 Selected vectors/bitmaps/component 
grayscale previews can be accurately scaled 
to an exact size using this option. 

Size Interactive 
The default mode is to enable selected vectors to be 
scaled interactively by clicking twice with the cursor. 
The process is: 

• Select the vectors 
• Click a second time to activate the interactive 

options - handles on the selection box 
• Click and drag on the white handles 

The keyboard shortcut S opens the Scale form in 
interactive mode. 

Interactive Handles 
 Handle Operation Additional options 

 

White Corner 
boxes 

Scaling 
proportionally 

Hold Shift for scale 
from middle 

White Center 
box 

Move the selected 
objects 

Hold Shift for linear X 
or Y moves 

White Middle 
Side boxes 

Scaling non-
proportionally 

Hold Shift for 
symmetrical scale 

Black Corner 
boxes Rotating dynamically Hold Shift 15 degree 

increments 

 

Size Exact 
Selected objects can be scaled accurately relatively to a point on the bounding box of the selection 
using typed input. 

Options 

Link XY 
Checking this option will always scale the height and width in proportion. Leaving the Link 
option unchecked allows non-proportional scaling 
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Rotate 
Selected vectors/bitmaps/component grayscale previews can be rotated to a new 
orientation using this option.  

Rotate Interactive 
The default mode is to enable selected objects to 
be rotated interactively by clicking twice with the 
cursor. The process is,  

• Select the object 
• Click a 2nd time to activate the 

interactive options - handles on the 
selection box 

• Click and drag on the Black handles to 
rotate the selection 

Holding down the Shift key when dragging to rotate the object uses angular movements of 15 
degrees. 

Rotate Exact 
Selected objects can also be rotated using typed input to accurately position the selected objects. 

• Select the anchor point on the bounding box – any corner or middle of selection 
• Enter the new angle for the selection to be rotated to 
• Click the Apply button to accept the change 

A positive + angle results in a counterclockwise rotation 

A negative - angle results in a clockwise rotation 

The keyboard shortcut R opens the Rotate form in interactive mode. 
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Mirror 
Selected vectors/bitmaps/component grayscale previews can be mirrored to a new 
orientation using this option. 

Selected objects can also be mirrored about axes of symmetry relative to the bounding 
box of the selection, using the standard options on the mirror form shown below. 

• Select the object or objects to mirror. 
• Click on the required option button as shown above. 
• Select the Create a mirrored copy option to leave the selection and created a new set of 

objects. 
• Click the Close button to accept the changes. 

Shortcuts 
Shortcut Key Combination Operation 
H Mirror Horizontally 
Ctrl + H Create Mirror Copy Horizontally 
Shift + H Mirror Horizontally, around center of material 
Ctrl + Shift + H Create Mirror Copy Horizontally, around center of material 
V Mirror Vertically 
Ctrl + V Create Mirror Copy Vertically 
Shift + V Mirror Vertically, around center of material 
Ctrl + Shift + V Create Mirror Copy Vertically, around center of material 
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Copy Object Tools 

Block Copy 
 Multiple copies of vectors/bitmaps/component grayscale previews can quickly be 
created using the Copy Vectors in a Linear or Circular Array.  

Linear Array 

Selected Objects Size 
Reports the current size of the selection 
that you are intending to block copy. For 
information only. 

Rectangular Array 
This option creates rows and columns, with 
a specified spacing in X and Y. 

Spacing… 
There are two ways to specify the spacing 
between elements in array: 

Gap 
The X & Y fields will be used to specify the 
gap between elements. 

Offset 
The X & Y fields are used to define the 
offset of each element relative to the preceding one. 
 

 
The example above shows a sign blank copied to create a 3 x 3 array - 3 Rows x 3 

Columns with a Gap of 0.3" between each object. 
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Circular Array 

Rotation Center 
Is the absolute XY coordinate around which the objects will be rotated when copied and 
pasted. 
The default Rotation point is the middle of the material. 

Rotate Copies 
This option controls whether the copied objects are each rotated normal to the axis or 
rotation as shown in the diagrams below. 

  
Rotate Copies selected Rotate Copies not selected 

 

Angle 
Note: A Positive Step Angle pastes the copies in a clockwise direction. A Negative Step Angle pastes 
the copies in a counterclockwise direction 

Total Angle 
With this option selected the number of items is divided into the Total Angle to give the 
incremental angle between each object. 

Step Angle 
With this option selected this is angle is used to copy the selected vector(s) by this angle x 
the number of Items. 
 

Note: Using Edit ► Undo deletes all the pasted copies and leaves the original vector selected. 
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Copy Along Vectors 
 Selected vectors/bitmaps/component grayscale previews can be Copied Along Curves. 

Select the item to copy along the curve and holding the Shift key select the vector curve 
or curves to paste the item along. 

  
Selected Vectors Circles Copied along curves 

Copy Object 
Any shape vector or group of vectors can be copied along a curve or curves. 

The first vector or group of vectors selected is the object that gets copied multiple times along the 
curves. 

Copy Circles 
Enter the diameter of the required circles 

Distance between copies 
This is the distance along the selected curve between each pasted vector. 

Force even spacing ensures that objects are pasted at the end points on the curve(s). If this option is 
not selected the pasted objects will be placed at the specified distance and may not match the exact 
length of the curve. 

Number of copies 
Selecting a specific number of copies automatically divides the curve into the required equal lengths 
and pastes a vector at these positions. 

Align to curve 
With this option selected the pasted objects are automatically aligned 'normal' to the curve they are 
being copied onto. If this is not selected, the objects stay in the original orientation. 

Create on new layer 
This option creates the multiple copies on a new layer making it much easier to select the resulting 
vectors for machining purposes etc. 
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Nesting 
The Nesting tool will automatically fit vector shapes within the user defined area in the most 
efficient way it can calculate (based on the user defined parameters). By default the area the vectors 
will be fitted is the current Job Size but it is also possible to select a vector as the nesting area. This is 
a powerful way to optimize material usage and increase toolpath efficiency when laying out and 
cutting a number of shapes. The image below left show a set of letters which have been typed out 
using the normal Text layout tool, the image on the right shows the same set of letters after the Nest 
Vectors function has been used to optimize their layout. The Nest Vectors tool will be documented 
in detail in this section to show how the options within the menu control the layout.  

  
 

IMPORTANT NOTE: What kind of yield should I expect from the Nest Vectors command? 

While the Nest Vectors function within Aspire is designed to do as good a job as possible it is 
important to understand it will not always nest parts as well as an intelligent (and patient) human. 
The nesting in Aspire works incrementally and does not re-arrange parts it has already placed. 
Therefore it does not have the ability to adjust things as the parts are being fitted that a human 
nester might see could be more efficient.   

The Nest Vectors function excels when the parts are relatively small compared to the nesting area 
and there are a large number of parts to nest.  

If you have a relatively small number of shapes to nest or you plan to cut the same set of parts many 
times then it may be better to take the time to manually nest your vectors. When you use the Nest 
Vectors function and see some obvious places that you could do better this is a good indicator that 
manual placement may be better.  

IMPORTANT NOTE: Sheets 

The amount of material required to Nest the selected vectors may be larger than the specified work 
area (Job Setup). To cope with any “overflow” Aspire makes use of a new type of entity called 
Sheets. Sheets are used for any nested shapes that will not fit within the boundaries of the specified 
Job Size (or the selected vector). Additional Sheets will be created using the same parameters 
chosen to Nest the vectors. These are displayed to the right and above the current Job area as can 
be seen in the image shown below. The use of the Sheets will be explained in more detail in section 
below on choosing the Active Sheet within the Nest Vectors form.  
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The concept of Sheets is very specifically related to machining the finished parts and is not designed 
to replace layers. Sheets should NOT be used to organize vectors for modelling or to organize 
vectors which you intend to use for different machining operations, in those cases the Layers should 
be used to manage the vectors.  

The sole purpose of Sheets is to allow nested parts for production type machining to be laid across 
many units of the same material. Only vectors on the Default Sheet can be nested so Nest Vectors 
should be the last command carried out on the parts before machining. As such objects should not 
be nested more than once, if you do not like the nesting solution then you should use the Undo (Ctrl 
+ Z) command immediately and then make changes to the settings before trying the nesting again. 

How Aspire Nests Vectors 
Nesting shapes is a complex calculation which requires the user to make sure the vectors are in the 
correct state to get the results they are looking for, this is especially important when nesting 
overlapping vectors or designs that have sets of vectors that need to stay in position with each 
other. In certain situations it is necessary to group together particular vectors to get the correct 
result. For simple shapes within shapes such as an “O”, “B”, “P” etc. there is no need to group them 
before nesting. Aspire will keep these internal shapes in the correct position and orientation as the 
shapes are nested.  

If the 'outer' vectors of the items being nested are overlapping (and are supposed to be overlapping) 
then they should be grouped together. This will ensure that the software does not try and nest other 
items in incorrect places inside of these objects or break the components apart; the nesting for 
these groups will be done using the bounding box of all these grouped items. 

Below you can see an example showing the value of this. The first image shows 3 parts to be nested 
6 times each, they include overlapping vectors and single lines. The second image shows the parts 
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nested WITHOUT Grouping as you can see the parts are split apart and the single lines are deleted. 
The 3rd image shows the parts Grouped before nesting into 3 specific groups, these keep all the 
parts in the correct position and does not delete the individual lines.  

 

 

 

 

 

 

 

Original vector layers for grouped vectors will be remembered even if the vectors are nested. If 
nested and then ungrouped the objects within them will go back onto their original layers. This can 
be useful if you have arrangements of production parts which are on different layers that you need 
to nest. These might be parts which use layers for different machining operations (drilling, pockets 
etc.). To nest these you can do the following: 

1 Group the complex component represented by vectors on different layers. 

2 Nest the grouped objects to optimize placement. 
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3 Select all the vectors and Ungroup to get the data back on the original layers for machining. 

Once you click the icon you will see the form shown below. You can see there are a lot of options on 
this particular form, these will all have a bearing on how the parts are nested. Generally it is 
assumed that you are nesting parts for the purposes of machining so a number of the options are set 
in regard to the tooling you plan to use and parameters associated with cutting the parts out. It is 
therefore very important to use the correct values that correspond to the machining choices you 
plan to make and keep a note of these so you use the correct values when you come to actually 
create the toolpaths.  

 

Tool and Clearance Settings 
The settings in this section of the form will determine the spacing which will be left between 
each of the nested vectors and also control how close they are to the edge of your nesting 
area.  
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Tool Dia. (D)  
Enter the diameter of the tool that you will be using to Profile (cut-out) the vectors you are 
nesting. This is the minimum distance that will be left between shapes once they are nested.  

Clearance (C)  
The Clearance value will be combined with the specified Tool Diameter to create the final 
minimum spacing between the nested shapes. For example a Clearance of 0.05” combined 
with a Tool Diameter of 0.25” would create a minimum spacing gap of 0.3” (0.05 + 0.25 = 
0.3). 
It is important to note that if you want actual material to be left between the nested shapes 
once they are cut out that the Clearance needs to be larger than the diameter of the tool. In 
the example used above where the minimum gap is 0.3” (0.05 + 0.25) the area machined by 
a 0.25” diameter tool cutting these shapes out would overlap as shown in the image to the 
left below (the blue shows the area which would be removed by the tool), this would leave 
no material between some of the parts. If you wanted there to be material between the cut-
out passes then you would need to specify a Clearance value larger than the Tool Diameter. 
For instance a Clearance of 0.3” would make a total gap of 0.55”, this is shown in the image 
below right. This would leave a minimum of 0.05 inches of material that would be left once 
the tool had cut out the shapes. This would be very important if using tabs to hold your parts 
in place, or if you wanted to prevent the scrap from potentially jumping off the table. 

  
 

Border Gap 
The Border Gap value is applied to the edge of the area which is being used to nest the 
vectors into. It will be added to the Clearance value around the edge of this shape to create 
the minimum distance that parts will be nested in respect to the nesting boundary.  
Vectors can be nested either within the whole Job area or into another selected vector (see 
section below on First vector is nest boundary for more information on that option). The 
shapes will be nested as close to the edge as possible using the Clearance specified to 
determine the minimum distance from the edge. In many situations it is beneficial to have 
an extra gap from the edge of the material to ensure that the tool does not overlap into an 
area where there may be clamps (or other obstacles) and to ensure that some material is 
left for hold-down. The Border Gap can be used to define this extra distance. In many cases 
it would be defined as the tool diameter or an even larger value. Below left the image shows 
no Border Gap, below right you can see a Border Gap has been defined leaving a boundary 
area around the edge of the nesting area.  
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Part Nesting Options 
The options in this area of the form will all directly affect how many parts or how efficiently 
it is possible for the software to fit shapes into the defined nesting area. The use of these 
options may depend on the particular material and application you are going to be using 
your cut parts for. Think carefully about the effect they will have on your shapes to ensure it 
does not adversely affect the finished cut parts.  

Rotate Parts to find best fit 
Checking this option will allow the software to rotate the selected vectors in order to try and 
better fit them. The increments of rotation the software will use is based on the Rotation 
step angle which is defined in the form area shown below.  

 
 
In theory the smaller the specified angle the more options the software will have to fit the 
shapes together so the more efficient the nesting will be. This does depend on the shape of 
the vectors though. It should also be noted that the smaller the angle specified the longer 
the nesting will take to calculate. 
Un-checking this option will ensure the parts keep the same orientation that they had when 
selected. This could be important if you are working with shapes that need to be oriented in 
a specific direction, for instance in regard to the material grain. 

  
 
The image above and left shows the letters nested with 30 degree rotation and the image 
above right shows the same letters nested with NO rotation. As you can see by allowing the 
rotation the software can fit the letters into a smaller area. In this case it is not a huge 
difference but the more shapes there are and depending on the style of the shapes it could 
be a bigger margin.  
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Mirror parts to find best fit 
Checking this option will allow the nesting to mirror (flip) the vectors in order to try and 
more efficiently nest the selected shapes. This should only be checked if the direction the 
parts are cut in is not important. For instance if you are using pre-finished material you 
would always want the face of the part to the top of the material and so would not want to 
allow the software to mirror them. If the parts were being cut-out and then finished or 
depending on the material being cut this may not be an issue and so could be used to help 
fit more parts into the nesting area.  

Allow parts inside other parts 
Checking this option will allow the software to nest within the internal areas of shapes that 
have gaps in the middle. This would be a good way to optimize material if you were cutting 
out parts but would not be a good choice if the inside of the shapes was only going to be 
pocketed as it would not then be scrap material. Grouped objects will not allow shapes to be 
nested within them even if they appear to have space to fit the smaller items. They would 
need to be ungrouped to allow the software to use the internal regions. Standard typed text 
will allow nesting on inside areas as shown in the example below.  
In the two images below you can see a set of letters which are going to be cut out. The larger 
letters have sizable internal areas that will become wasted scrap, using the Allow parts 
inside other parts option means that Aspire will use these internal areas to fit any smaller 
parts into them. This can be seen in the right hand image which shows the letters after 
nesting, where the inside of the O’s and the B have been used to nest the smaller shapes. 

  
 

Sheet Options 

Nest From 
This area of the form is used to define which corner the nesting will start in. There are four 
options which can be selected from the options in the form shown in the image below: 

 
Each node corresponds to the respective corner of the Material or the selected boundary 
vector. The first nested parts will be placed in that corner and the shapes fitted according to 
the Nest Direction specified (see section below).  



 
76 Navigation Homepage 

 
 

Nest Direction 
The options in this area of the form are used to select how the parts will progress as they are 
positioned within the sheet. The best way to think of this (for the purposes of this section) is 
that they “pour” out of the selected corner filling the sheet in one axis then advancing along 
the other defined axis (X or Y) . 

Along X 
Checking this option means the nested vectors will fill the boundary area vertically then 
progress horizontally along the X axis, radiating from the corner selected in the Nest From 
section of the form. The image below shows the Along X nesting option with Nest from... set 
to the lower left corner.  

 

Along Y 
Checking this option means the nested vectors will fill the boundary area horizontally then 
progress vertically along the Y axis, radiating from the corner selected in the Nest From 
section of the form. The image below shows the Along Y nesting option with Nest from... set 
to the lower left corner. 

 

First vector is nest boundary 
Checking this option means the first vector selected as will be used as the boundary for the 
nesting area. This can be useful if you need to define a non-rectangular shape to nest 
vectors into, such as large off-cut from a previous job. It’s important to note that using this 
option will not respect the currently defined Job Area if the selected boundary vectors goes 
outside of it. If there are too many vectors to fit into the first selected vector then additional 
Sheets will be created using the same boundary shape for the parts being nested, the 
boundary vector will be positioned on the Default Sheet (zero) along with any items not 
selected for nesting.  
Not having the First vector is nest boundary option checked means all the selected vectors 
are nested into the whole of the defined Job Area (defined by the Job Setup form accessed 
from ‘Edit – Job Size and Position’ from the menu bar).  
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Note: If you need to represent a sheet with holes or other features which can’t be 
represented with a single selected vector as the new boundary it is possible to also 
use a Grouped vector for the first selected item then the shapes will be nested 
within the spaces in this. 

Individual Part Properties 
This function is very useful if you have a number of the same part to make and need to nest many 
parts at once. It allows multiple copies of the selected object/s to be nested without making the 
copies prior to the operation.  

If you want more than one incidence of a particular item then select it from the 2D view. In the box 
where it says Number of Copies enter however many copies you want and hit Apply the selected 
vectors will be marked with a green number indicating how many copies of that item will be made 
when they are nested. Different shapes or groups of shapes can be assigned different numbers of 
copies. To stop an item being copied multiple times just set the Number of Copies back to 1 and hit 
Apply.  

Active Sheet 
This option lets you choose which Sheet of vectors is currently active, either for editing or applying 
toolpaths onto.  

The Active Sheet can also be chosen when the Nest Vectors form is not open by using the drop down 
option from the base of the Drawing menu – this is shown in the image below left highlighted with a 
red box, the image below right shows the drop-down with the choice of currently available Sheets.  
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Offsetting 
 Selected vectors (open or closed) can be 
offset either inwards or outwards to create 
new vector shapes that might be useful for 

edge patterns or borders etc. To offset a vector shape, 
use the following steps: 

• Select the vectors to offset 
• Select the required direction – Outwards / Left 

or Inwards / Left 
• Enter the Distance 

• Click the Offset  button 

Options 
The offsetting options are slightly different in their 
behavior depending on whether the vector to be offset 
is open or closed. See below for more information. 

Create sharp offset corners 
Will retain any sharp corners in a design. 

  
Offset with Sharp Corners on 

 
Offset with Sharp Corners off 
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Offsetting Open Vectors 
When offsetting open shapes the options are either to the Right or Left side of the selection.The 
direction of open vector(s) is very important as this is used to decide which side of the selection is 
the the right and left. Selecting Node Edit mode (pressing N on the keyboard) will display a Green 
node at the start of the vector. Looking along the vector(s) from the green node indicates the 
direction and the image below shows offsets to the left and right of an open vector. 

 

Notes 
Square Offsetting a very acute (included) angled sharp corner will result in the corner point being 
positioned a long way from the original geometry, often off the material or cutting through other 
shapes in the design. To stop this happening Aspire checks that the distance for the new calculated 
offset point is less than 5 x the offset distance away from the original corner point. 

Note: Offsetting overlapping vectors can cause unpredictable results. It is generally better 
to Weld overlapping vectors before offsetting them. 
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Object Merge tools 
Selected vectors that overlap can be merged  together to create a new shape. There are 3 different 
merge operations, each providing a way of combining, subtracting or keeping the union of the 
selection. 

The 3 options below show the results of welding these 5 vector shapes. 

 

Weld Vectors 
Welds overlapping vectors together to create a new shape which follows the outermost 
edge of all the selected shapes. 

 

Subtract Vectors 
Merges overlapping vectors together to create a new shape which subtracts the 
subsequent selected vectors from the first one selected. 
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Union Vectors 
Merges overlapping vectors together to create a new shape which is a union (the 
overlapping regions only) of all the selected vectors. 

 

Note: To Undo a merge operation select the Edit Undo command Twice 
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Filleting, fitting & Trimming tools 

Create Fillets 
 Fillets radiuses can be added interactively at points where 2 straight vector lines meet. 

 Place the cursor over the point to add the fillet and if the cursor changes to show a Tick: 

 

Then click the left mouse to fillet the corner. 

  
 

Note: The Fillet tool only works with straight lines - not beziers or arcs. 

As well as conventional filleting of simple corners, this tool includes 2 special types of filleting for 
straight line vector corners. They will create an overcut shaped area in corners to allow clearance for 
another piece of material to be slotted into the part without being obstructed by material left by the 
radius of the tool. Below left you can see a blue piece of material fitted into a normally cut slot, this 
would fit no further in than the radius of the tool would allow. Below right you can see the same 
situation with a slot which has the “Dog-Bone” style corners applied to it which allows the part to fit 
full depth into the slot. 

  
 

This is a very useful tool for slot-together furniture designs, model aircraft, dinosaurs etc. Below you 
can see a part from a slot together dinosaur on the left is the standard part and on the right is the 
same part with the “T-Bone” style fillets added to these slots. This type of fillet needs to be used 
when the slot is close in size to the tool diameter. 
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Clicking this will open the Create Fillets form shown here: 

  

Fillet / Tool Radius 
This size of this value is used to create the fillet as described for each individual type of fillet 
below. To create any of these Fillets you need select the type required then move the mouse 
cursor so it is over a corner between two straight lines, if it is a legitimate place to create the 
fillet then a check mark will show and the user can click the mouse button to create it. It 
should be noted that this will not fillet arcs or beziers even if one of sides of the node is a 
line.  
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Fillet Type 

Normal fillet 
This creates a standard corner fillet based on the Radius defined, typically this would be 
used for design purposes rather than editing a slot for fitting purposes. The images below 
are used more as a way of comparing this type with the other two new options. Below left is 
the vector before filleting the two inside radii, on the right is the filleted version.  

  
 

 ‘Dog-Bone’ Fillet 
This creates a circular cut-out style of fillet, the circles will be placed so the upper right part 
of the circle touches the original sharp corner and are created with the Radius specified. This 
option should not be used if the slot width and the tool are similar in size. Below left is the 
vector showing the slot before filleting, on the right is the filleted version using the ‘Dog-
Bone’ option. 

  
 

 ‘T-Bone’ Fillet 
This creates a circular cut-out style of fillet, the circles will be created with the Radius 
specified. This option should be used if the slot width and the tool are similar in size so the 
slot can “grow” out to the side to ensure there is space for them to fit. Below left is the 
vector showing the slot before filleting, on the right is the filleted version using the ‘T-Bone’ 
option.  

  
 
The placement of the fillet is an interactive process; you can choose which side of the 
‘corner’ the T-bone filet is placed. 
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If you click on a ‘corner’ the fillet will be placed automatically on the longest side. By clicking 
to the side of the corner you want the fillet placed you can choose which side the fillet is 
placed on. 
 

 
 
In addition, fillet arcs can be removed by simply clicking on an existing fillet arc. This works 
even for vectors that have been imported with filleted corners. This feature allows the user 
to easily change the size of fillets by clicking once to remove the existing arc and then 
clicking the corner to insert the new fillet. 
In many cases, by allowing the user to control which side of the corner the ‘T-Bone’ fillet is 
placed on means that the fillet can be hidden when the pieces are assembled. 
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Fit curves to selected Vectors 
 This function allows the user to fit arc, Bezier curves or straight lines to selected vectors. 
The newly created vectors will be approximated based on a user defined tolerance. Using 
this function can aid with smoothness for some toolpath options and also help to simplify 

data for modelling purposes. The Curve Fitting function can be accessed from the Edit Vectors area 
of the Drawing menu as shown highlighted with a red box in the image below or by using the short-
cut-key combination “Ctrl + F”.  

Either of these methods will bring up the following form: 

 

Fitting Type... 

Circular Arcs  
Checking this option means the selected vectors will be approximated using arcs. Below left 
is the vector before fitting, below right the same vector fitted with arcs. 

  
 

Bezier Curves  
Checking this option means the selected vectors will be approximated using Bezier curves. 
Below left is the vector before fitting, below right the same vector fitted with Bezier spans. 
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Straight Lines  
Checking this option means the selected vectors will be approximated using straight lines. 
Below left is the vector before fitting, below right the same vector fitted with straight lines. 

  
 

Tolerance:  
The value which is set in the Tolerance area determines how closely the original vectors will 
be approximated. The newly created, Arcs, Beziers or Lines will be generated within a 
distance of the original vector which is plus or minus the specified Tolerance value. The 
smaller the value the closer to the original the new data will be but it will also mean more 
data points will be used. A larger Tolerance will not be as accurate to the original but will 
have less data points. The diagram below shows the curve fitted to two straight lines with 
the max possible distance between them defined by the Tolerance set.  
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Keep Sharp Corners  
Checking this option will make the Curve Fitting routine keep sharp corners which have a 
difference greater than the Max Angle value specified.  Any corners where the difference in 
angle is less than this value will be modified within the specified tolerance. The images 
shown below demonstrate how this works. The first image shows a set of straight lines 
before curve fitting with the angles shown between the spans. The second image shows this 
after curve fitting with the Keep sharp corners set with a value of 20 degrees. You can see 
the two lines which were under 20 degrees difference have had a curve fitted between then 
but the other corner has been retained as the angle is greater than 20 degrees.  

 

 

 Replace selected vectors 
Checking this option will delete the current vectors and replace them with the new “curve 
fitted” vectors. Un-checking it will keep the original vectors as is and in addition create new 
“curve fitted” vectors. The new vectors will always be created on the currently selected 
Layer. 
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Trim Vectors 
 The trimming tool allows the user to just click on sections of vectors they want to delete.  

The program finds the closest intersections either side of the clicked portion of the 
vector and removes the piece of the vector between the intersections. Optionally, when 

the form for this command is closed, the program can rejoin all the remaining trimmed pieces 
automatically. This has been the most requested enhancement for the design tools in the program.  

Without using this tool, to remove an overlapping section of a vector, the user would need to insert 
extra nodes into both vectors, manually delete the intermediate sections and then manually join the 
resulting pieces. These operations can be performed with a single click using this tool.  

When the tool is selected the cursor changes into a ‘closed’ scissor shape. When the cursor is moved 
over a vector suitable for trimming the scissors ‘open’ to show you can click and trim. 

 
 

When the trim tool is selected the following form is displayed. 

 

The only option on the form allows the user to select whether the program will automatically try to 
rejoin trimmed vectors when the form is closed. For most simple cases like that shown above with 
the overlapping rings, this option can be left checked. If you have an example where for instance 
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many trimmed lines meet at the same point, you may want to uncheck this option and rejoin the 
vectors manually. 
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Joining & Closing Tools 
The icons to join and close vectors are located under the Edit Vectors section of the Drawing Tab as 
shown highlighted with a red box in the image shown below: As with all the icons listed in this 
manual more expansive descriptions and examples can be found in the Help File under the Help 
drop down menu – Help Contents. 

Join Open Vectors 

 Open vectors are automatically identified and closed or joined to other vectors where the 
end points lie within the user definable tolerance. 

Join/Close vectors with a straight line 

 Join with a Line finds the closest end points on 2 selected, open vectors and joins with a 
straight line. Close with a Line closes a single open vector with a straight line between its two end 
points. 

Join/Close vectors with a smooth curve 

 Join with a Curve finds the closest end points on 2 selected, open vectors and joins them 
together with a smooth curve. 

Join Moving End Points 

 Join Moving End Points finds the closest end points on 2 selected, open vectors, calculates 
the mid point between them and moves the end points to this position. 
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Align Objects 
The icons to align Vectors, Bitmaps and Component Grayscale’s are located under the Align Objects 
section of the Drawing Tab as shown below:  

 

The first set of icons all work in relation to the material (job size) and the second row of icons all 
work with regard to the selected items – using the last selected item as the controlling object. 

Center in Material 

 This option moves the selected items to be positoned in the middle of the material. 
ShortCut key for this is F9. 

Center in Material X only 

 Align vectors centrally in the material only moving them along the X axis so the vertical 
position will not be changed. 

Center in Material Y only 

 Align vectors centrally in the material only moving them along the Y axis so the horizontal 
position will not be changed. 

Vectors, Bitmaps and Component Grayscale’s can be aligned relative to one another in the 2D View. 
The selection sequence to achieve this is: 

• Select the item/s you wish to align / move (use single or multiple selection options)  
• Hold the Shift key down  
• Select the final item – this is the object that the rest of the selected items will be aligned to  
• Click the required alignment option  

There are 7 alignment options: 

Align Center 

 Center selected vectors in the Middle of the last selected vector 



 
93 Navigation Homepage 

 
 

Align Left 

 Align the selected vectors to the Left edge of the last selected vector 

Align Right 

 Align the selected vectors to the Right edge of the last selected vector 

Align Top 

 Align the selected vectors to the Top edge of the last selected vector 

Align Bottom 

 Align the selected vectors to the Bottom edge of the last selected vector 

Align horizontal center 

 Align the selected vectors Horizontally centered to the last selected vector 

Align vertical center 

 Align the selected vectors Vertically centered to the last selected vector 
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Layer Management 
Vectors, Bitmaps and Component Grayscale’s can be assigned to different layers making managing 
complicated designs much easier. There are no specific rules for how to use the Layers for 
organization.  Individual users develop their own approaches as they find their preferred way of 
organizing their data. The main benefit of using Layers is the ability to display and un-display all the 
items on a particular layer. This means that as a design gets more complex it is possible to switch off 
items to make it simpler to work on the parts you are currently working on.  

One example of using Layers may be setting up vectors which will be used to model different shapes 
using the Modelling Tools so that each shape has its own layer and those not currently in use can be 
switched off.  

Another example might be a project that requires decorative v-carving plus pocket machining, 
drilling and finally profile cut out passes. Each set of vectors can be assigned to different layers 
which would be associated with the toolpaths that were being created. Each layer can then be 
assigned a specific color and can either be visible or invisible as required at each stage of operation.  

A further (and last) example would be to use the Layers to switch off the Grayscale Preview’s for the 
Components so that they are not displayed in the 2D View but so they remain displayed in the 3D 
View. Switching off the Layer with the Grayscale on it only affects the Grayscale not the actual 3D 
Component. This may be used once a Component is in the final size and position as the Grayscale 
may not be needed at that stage. 

Being able to quickly and easily turn layers on or off makes selecting and viewing elements in a 
project much easier.  

The Layer controls are positioned at the bottom of the Drawing Tab as shown in the image shown 
below: 

 

From this set of controls the user can do the following operations to Layers: Change the currently 
selected layer, create layers, delete layers, rename layers, change the layers color, switch the layers 
visibility on and off and finally lock and un-lock individual layers. In addition to these functions there 
is an icon to access the Layer Control Manager.  

The ‘Sheet’ dropdown is only used when nesting and is explained in detail in the nesting section of 
the manual. 
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Layer Control Manager 

The Layer Control Manager makes it very easy to work with complex designs giving quick access 
to all of the layer control options. This window can be left open while working and dragged around 
the interface and resized as required.  

 

Note: Imported images are automatically placed on a layer called Bitmap Layer. This allows 
images to quickly and easily be turned off in the 2D view when they are not required. The 
images can also be moved onto another layer if required.  

Layers (Layer List Control) 
The upper half of the Layer Control Manager contains the Layers List. This shows all of the layers in 
your project, the order they are being drawn, their names, visibility state and which one is currently 
active. 

The active layer is highlighted and is the layer onto which new vectors will be created or modified. 
The light bulb icon and associated checkbox indicates the current visibility of each layer. You can 
toggle all the layer’s visibilities using the checkbox in the title area of the Layers List. 
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Select All on a Layer 
Double-clicking on a layer in the Layers List will select all the objects on that layer. 

Layer Properties 
The lower half of the Layer Control Manager contains the options for each of the selected layer’s 
properties. 

Layer Ordering Arrows 
Adjacent to the Layer Properties label are two arrow buttons. These move the selected layer 
up or down in the Layers List. This can be important to set the drawing order of objects that 
might otherwise obscure one another (specifically Bitmaps and 2D Component Previews). 
Objects on the top layers in the list are always drawn before objects in the lower layers and 
will, therefore, be ‘underneath’ them in the 2D View. You can use the Layer Ordering Arrows 
to resolve the   

Name:  
A Layers name can be changed by selecting the Layer, then typing the new name into the Name: 

area of the form and hitting Apply .  

Visible 
Visible Layers can be switched off (made invisible) by un-checking the box next to the light bulb icon. 
This can help to simplify what is currently displayed making it easier to work with complex designs in 
the 2D view. 

Locked 
Layers on a vectors can be locked by checking the box next to the red pad-lock icon to stop them 
being selected, moved or deleted. 

Drawing Color 
The color of vectors on a specific layer can be changed to make it easier to differentiate between 
different regions of a design.  

Add New Layer 
New Layers can be added using the New Layer  button from the Layer Control Manager. Alterntively 

a new layer can be created using either the Move to Layer → New Layer or Move  

The dialog for adding the new layer is displayed with options to specify the name and color of the 
vectors on the new layer and an option to indicate if the new layer should be visible. 
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Layer Name 
It is always preferable to take the opportunity at this stage to give your new layer a 
meaningful name relating to its content or purpose. Later on this name will make it easier 
for you to manage your layers as your design becomes more complicated. 

Drawing Color 
All the vectors on this layer will be colored according to this setting. This can be a very useful 
way of distinguishing between the vectors that are on different layers, directly  in the 2D 
View. 

New Layer is Visible 
With this option checked, the new layer will automatically be visible as soon as it is created. 

New Layer is Active 
With this option checked, the new layer will automatically become the active layer and any 
subsequent vector creation or manipulation will occur on this new layer. 

Moving Layers 
Objects on any layer can be moved onto another layer using the Right Mouse menu or using the 
layer control manager. The quickest way to move objects from one layer to another is to use the 
Right mouse button. To do this, first select the objects you wish to move, then click the Right Mouse 
button and select Move to Layer and select the required option – the Right Mouse Click menu is 
shown in the image below: 
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Rulers, Guidelines and the Snap Grid 
To help with drawing, construction and layout, the 2D View has Rulers which are displayed along the 
top and down the left side of the window. In addition to the Rulers there is the option to use 
Guidelines to help with construction of vectors or positioning of other objects in the 2D View.   

Rulers  
The Rulers are permanently displayed in the 2D view to help with positioning, sizing and alignment. 
The graduated scale automatically uses the units set for the project and zooming in / out shows the 
sizes in 10ths. 

Inches - 1" > 0.1" > 0.01" > 0.001" > 0.0001"  

Metric - 1cm > 1mm > 0.1mm > 0.01mm > 0.001mm  

Guidelines  
Guide Lines are used to help layout designs and make it very easy to sketch shapes by clicking on the 
intersections of Guides.Guide Lines are easily be added to the 2D view by Clicking with the left 
mouse button on the appropriate ruler (left if you want a vertical guide and top if you want a 
horizontal guide) then holding the button down and dragging the mouse into the 2D window.  

 

While dragging a Guide into position it automatically Snaps to the units displayed on the ruler. This 
snapping behaviour can be over-ridden by holding down the shift key while dragging the guide. After 
positioning a Guide it can easily be moved to a new position by clicking the RIGHT mouse button on 
the guide to open the Guide Properties form as shown later in this section. If you hover the mouse 
over a Guideline then its current position is displayed next to the cursor 

Additional guide lines can be added relative to an existing guide line by interactively placing the 
cursor over an existing guide (the cursor changes to 2 horizontal arrows), Holding the Ctrl key and 
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dragging to the required position. The incremental distance between the guide lines is displayed 
next to the cursor. Releasing the Ctrl key changes to display the absolute distance from the material 
origin. 

Guides can also be added and other edits made by Right clicking on the Guideline which will bring up 
the Guide Properties form as shown below. Using this form you can do the following things: 

The exact position can be specified by entering a New Position 

Guide lines can be locked in position to stop them from being inadvertently moved. 

Additional Guide Lines can be added that are positioned using absolute or incremental coordinates. 

 

Guides can quickly be toggled visible / invisible by clicking in the Top Left Corner of the 2D view as 
shown in the image below. 
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Alternatively the visibility can be changed using the drop down menu options, select: View > Guide 
Lines = Guides Visible / Invisible. All Guide Lines can be Deleted by selecting from the Main menu, 
View > Guide Lines > Delete All Guide Lines. Individual Guide Lines can be deleted by clicking and 
dragging them off onto the rulers. 

Snap Grid 
A Snap Grid with definable grid spacing can be switched on to make drawing standard shapes very 
quick and easy. The cursor automatically changes to show when it's snapping to a Grid points. 

The Snap Grid can be switched On / Off from the Snap Settings form.  

Open the Snap Settings Form by, either pressing F4 or selecting from the top Drop Down menu - Edit 
> Snap Options 
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Different cursors are displayed to indicate the snapping situations and the following options can be 
switched on / off. 

Display Text at Cursor 
Displays the XY coordinates on the cursor making it easy to see the position for each point  

Snap to Guides 
When this option is checked drawing and positioning vectors will snap onto any horizontal or vertical 
guide lines visible in the 2D view.  

Geometry Snapping 
Used to control the position at which the cursor will snap when drawing and moving objects. When 
drawing the cursor will snap to items on vector geometry depending what options you have selected 
in the form under this section. 

• End points, Mid-points, Arc centers and centers of objects  
• Horizontally, Vertically and the specified Angle and Distance  
• Guide lines and the intersection of Guides 

  

 

 

Snap to 
Nodes, mid-points, centers  

Snap to Guides, matching horizontal / vertical points, plus 
angle and distance  
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Snap to Grid 
When checked this displays a gird of points set to the distance specified in the Grid Spacing. While 
active this points can be snapped to when drawing or editing vectors and other objects in the 2D 
View.  

Snap Direction and Distance 
When drawing lines the direction and distance can be displayed on the cursor to help construct 
shapes easily and quickly.  The check box options below this area in the form (Snap to Vertical and 
Horizontal, Snap Angle Increments and Snap Distances) can be chosen to decide which of functions 
related to this tool you want to keep activated.  

Note: Snapping can be overridden / temporarily disabled by holding the Shift key
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3D Design and Management 
Before creating toolpaths in Aspire, if the part has a 3D element to it then the user will need to 
create one or more 3D Components to represent this. For a more general description of how the 
modeling in Aspire works please refer to the “Introduction to Modeling” document and tutorials 
supplied with the software.  

Although the 3D View shows you the current composite model (which is built from all of the 
currently visible 3D Components),  the calculated Toolpaths and the Toolpath Preview, in this section 
of the Reference Manual only the Modeling functions will be dealt with. These include icons on the 
Modeling tab along with the functions in the Component Tree and Component Properties form. A 
general description of each icon/function will be provided but you should work through the video 
tutorials for practical examples of how to use these functions and also refer to the relevant Help 
section. The Toolpath and Toolpath Previewing will be dealt with in the Toolpath section of this 
manual.  
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Components 
Aspire has been designed to work in a way which enables the user to easily create even very 
complex projects. In any situation, the best approach to producing something complicated is to 
break it down into smaller pieces until a level of simplicity is reached that can be understood and 
managed. In Aspire this is achieved by letting the user work with pieces of the design which are 
combined to make the finished part. In the terminology of the software these pieces are called 
Components. Step by step, Components can be created and modified until you have all the elements 
you need. In the images below you can see an example of how these components might work. On 
the left you can see the separate component for a model of a bunch of grapes and on the right you 
can see these positioned to make the complete part.  

  
 

There is no limit to how simple or complex a Component can be (this is the user’s choice). In the 
example shown, you can see that a model of a whole bunch of grapes may be made up of smaller 
components but they could also be combined to exist as one single Component (the assembled 
bunch of grapes) that could then be used to lay-out a more complex part with multiple bunches of 
grapes. Each user will find a level of using components they are comfortable with which may be 
dependent on the particular job or level of proficiency with the modeling tools.   
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Creating and Editing Components 
In Aspire, the aim is to end up with a set of Components that when combined together will make the 
finished 3D part. One way to think of this is like building a 3D collage or assembly. As the design 
evolves, new parts may need to be created or existing ones changed. The parts of the collage are 
managed with the Component Tree which will be covered in more detail later.  

An existing Component can be copied, scaled and have other edits carried out on it as an object. The 
user can also change the way it relates to the other Components, for instance whether it sits on top 
or blends into an overlapping area of another Component. The shape, location and relation of these 
pieces determine the look of the final part. As the job progresses, the user will need to create brand 
new Components or edit existing ones by adding new shapes, combining them with others or 
sculpting them.  

There are 4 ways to create and edit Components: 

• Use a modeling tool to create shapes from 2D vectors. 
• Import a pre-created 3d model – either a model previously creatde in Aspire or from another 

source such as a clipart library or a different modeling package. 
• Create a “texture” Component from a bitmap image. 
• Use the Split Components Tool to break an existing Component into smaller pieces. 

All of these methods are covered in detail throughout the training material videos and tutorials. 

Permanent Edits 
If you select an existing component and then open a Component modeling tool (such as the Create 
Shape from Vectors tool), you can directly modify the shape of your selected component using the 
tool. Once the tool is closed, the selected Component will be permanently altered by the changes 
you made. 

Dynamic Properties 
As well as having its underlying 3D shape, each component also has a number of dynamic properties 
that can be freely modified without permanently changing it’s true shape. These include scaling of 
the Component’s height, the ability to tilt it, or to apply a graduated fade across it. 

These dynamic properties can always be reset or altered at any time during your modeling process, 
which makes them a particularly useful way of ‘tweaking ’your components as you combine them 
together to form your final composite model. 
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Combine Modes 
The Combine Mode is a very important concept when working with 3D shapes within Aspire. The 
options for combine mode are presented when creating new shapes and also when deciding how 
Components will interact in the Component List. Rather than cover this in every section where it is 
applicable, it is worth summarizing the options here so they can be understood in the sections 
where they apply.  

When you have more than one 3D shape, such as the 
Component pieces of the design or where you have an 
existing shape and are creating a new one,  then you need 
to have a way to tell the software how the second shape 
will interact with the first. This can be an abstract concept 
for users who are new to 3D but it is an important one to 
grasp as early as possible. In Aspire this is controlled by a 
choice called the Combine Mode.  

There are four options for this, Add, Subtract, Merge and 
Low. These options determine how the second/new shape 
is combined with the previous one, for instance whether it 
sits on top of the original shape or blends into it.  

As modeling is an artistic and creative process, there is no 
general rule to describe when to use each one. As a guide 
though you can assume that if the second shape’s area is 
completely within the originals one then you will probably 
be adding or subtracting and if the shapes only partly 
overlap that you will probably use Merge or, very 
occasionally, Low.  

The four options and their specific effects are described on 
the following pages. To illustrate the different effects a 
combination of an overlapping beveled square and a dome 
will be used. You can see in the image right how these are 
arranged in the 2D View and how they overlap. Then you 
can see each individual shape in the images below middle and right. These shapes will be used to 
demonstrate the different Combine Modes. In every case the Dome will be considered the primary 
shape and the square is the secondary shape which is being combined with the first. In addition to 
the dome/square example some images of ‘real world’ parts will also be included to help to 
understand how these can be used on actual projects.  
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Add 
When Add is selected, it takes the first shape and then just adds the height of the second shape 
directly on top of the first. Any areas which overlap will create a shape which is exactly the height of 
each shape at that point added together (see below) 

 
 

 

Typically the add option is mainly used when the shape being added sits completely within the 
original shape, this ensures that the uneven transition where the parts only partly overlap (as shown 
in the example) do not occur.  

The example above shows the Maple Leaf and border extrusion Components being Added to the 
dome Component in the sign example from the Introduction to Modeling document.  
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Subtract 
When Subtract is selected it takes the first shape and then removes the height of the second shape 
from the first. Any areas which overlap will be a combination of the original height/shape less the 
second shape. Areas where the shape goes into the background will become negative regions. You 
can see how this looks using the dome and square in the image below: 

 
 

 

Typically subtract, like the add option, is mainly used when the shape being removed sits completely 
within the original shape, this ensures that the uneven transition where the parts only partly overlap 
(as shown in the example) do not occur.  

The image shown above has some “creases” to help define the muscles of the lioness. The shapes to 
create these recesses were created by using the Subtract option with the Create Shape tool on the 
vectors representing those recessed areas.  
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Merge 
When the Merge option is selected any areas of the shapes which do not overlap remain the same. 
The areas that overlap will blend into each other so that the highest areas of each are left visible. 
This results in the look of one shape merging into the other and is in effect a Boolean union 
operation. You can see how this looks using the dome and square in the image below: 

 

 

 

Typically the merge option is used when the shape being combined partly overlaps the original 
shape. This enables a reasonable transition to be made between them.  

The image above shows 2 Herons, a rope border and banner Components. Each of these overlaps 
with the others and so they are set to Merge in this areas. Whatever is the higher of the two merged 
areas is what is prominent. In this case the rope is lower than everything and the Banner is higher 
than the Herons so the desired effect can be achieved. 
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Low 
The Low option is only available when combining Components (not in the modeling tools). When this 
mode is selected, any areas which do not overlap are left as they were in the original two shapes. 
Any areas which overlap will create a new shape which is the lowest points taken from each shape, 
this is in effect a Boolean intersection operation.  You can see how this looks using the dome and 
square in the image below: 

  
 

Typically, the Low option is very rarely used, the main application for it in Aspire is when you want to 
combine a recessed shape into a raised one. An example of this is shown in the image above.  

The example shown on the right above uses the Low option to combine the flat topped ‘button’ 
component on the left  with the curved top face component with the letter ‘A’ on the right. 
Combining both components with the merge low option gives the keyboard button with the curved 
top you see in the bottom row.  
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Combine Modes Summary 
Note: The examples shown above all use Components for their example. The Combine 
modes also apply to the Modeling Tools (Create Shape and 2 Rail Sweep) and control how 
the shape currently being modeled is combined with the existing shape in the component 
(if there is any). 

    

 

     

     
Add Subtract Merge Low Group 
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Modeling Tools 
The Modeling Tools section of the Modeling tab contains all the icons buttons which relate to 
commands for creating, editing and manipulating 3D Components. 

  

 
Create Shape 

 
Two-Rail Sweep 

 
Sculpting 

 
Create Component from Bitmap & Import a Component or 3D Model 

 
Clearing or splitting Components 

 
Create Vector Boundary From Components 

 
Baking Components 

 
Component Properties 

 
Smooth Components, Scale Model Height & Slice Model 

 
Export Model as STL File 
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Create Shape 
The Create Shape tool allows the user to create shapes based on one or more selected 
closed vectors. The vectors can be selected either before the icon is clicked or after the 
form is open. The user works through the form specifying the type and strength of the 

shape and modifying options to govern the height the shape. 
There is also an option to tilt the shape being created on a 
angle. Once the shapes parameters have been defined it can 
be previewed by hitting one of the combine mode buttons. 
Depending which of these is selected the defined shape will 
either be Added to, Subtracted from or Merged into the 
current Composite Model.  

This shape can be easily changed until the user hits the Make 
Component or Close button. Just keep altering the values 
and if necessary hitting the Combine Mode button of your 
choice. Once you are happy with the shape created then you 
have two choices, to Make Component or Close.  

Changing values with the slider on the form will immediately 
update the 3d view when you release the slider. If you make 
changes to the edit fields such as Angle or Base height, 
pressing the ‘space’ key after you have finished entering 
your value will apply the changes and update the 3d 
preview. 

If you select another vector while the form is open, the 
current shape values will be applied – if you did not want 
this shape, simply select Edit – Undo (Ctrl +Z) to undo the 
changes you made. 

Shape Profile 

Round 

Applies a round profile (dome) to the 
selected vector/s outline  

Angle 

 Applies an angular profile (pyramid) to the selected vector/s outline 

Flat 

Applies a flat profile to the selected vector/s outline 

Angle: 
Angle of the edge of the rounded or angled profile shape – the higher the angle the steeper 
the shape. Angular shapes can have a maximum angle of 89 degrees. The slider bar to the 
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right can also be used to change this as well as typing a specific angle into the form. After 

editing this value, click the Apply  button to apply your changes and update the 3d preview. 

Base Height: 
Height of a flat ‘base plane’ added below the profile you have chosen. After editing this 

value, click the Apply  button to apply your changes and update the 3d preview. 

Final Height 

No Limit 
Checking this option lets the combination of the size and shape of the vector and the 
specified values govern the final height of the shape. 

Limit to Height 
Checking this option limits the height of the shape by flattening it off at the value entered in 
the Height area of the form which becomes active once this option is selected.  

Scale to Exact Height 
Checking this option limits the height of the shape by scaling the shape up or down while 
retaining its general specified profile. It is scaled to the height entered in the Height area of 
the form which becomes available once this option is selected. 

 
 

Tilt 
When this option is checked the user can set a direction and angle to tilt the shape up at an 
angle in Z. The first part of this operation (once the option is checked) is to press the Set 
Anchor button – then click two points in the 2D view. The first click specifies the point which 
will remain at zero (the pivot point of the tilt). The second click specifies the point that will 
be tilted upwards by the specified angle (the point that will be raised up). The default angle 
(10 degrees) can be edited by clicking the arrow next to the value and using the slider or by 
typing in a specific value.  

Combine with current shape… 

Add 
Adds the currently defined shape to any existing shape in the component that you are 
editing 

Merge 
Merges the currently defined shape any existing shape in the component that you are 
editing. This means areas in the component that are lower than those in the current shape 
will be replaced. 
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Component  
This section includes some useful options to help you manage your components. See Component 
Management from within a modeling tool for more information.  

Close 
Closes the form and updates the Component Tree with the changes that you have made. If you 
wanted to remove the shape you just created then you can hit the undo icon or use the keyboard 
Shortcut to undo, CTRL+Z. 

A Note on Exact 3D Shape Calculation 
Occasionally when working with ‘high’ angles in the shape editor (usually greater than 80 degrees) 
with some irregular shapes excess banding can sometimes occur.  By holding down the ‘Ctrl’ 
key when calculating a shape (pressing Add, Subtract or Merge on the Create Shape form) you can 
force the program to use exact values for some parameters to give better results at the expense of 
longer calculation times. 
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Two-Rail Sweep 
The Two Rail Sweep uses a combination of open 
vectors to define an extruded shape in the 3D 
Component. The shape is based on two sides 

(rails) and up to 3 cross section vectors. The vectors for this 
operation can be selected before the icon is clicked or after 
the form is opened.  

Status For Selection 
This section indicates whether the selected vectors are valid 
for creating a 2 rail sweep. As soon as you have selected 3 
suitable vectors this section will display a green check mark. 
The rails need to either be both open or both closed and 
should not overlap. If you do not have enough vectors 
selected or all 3 are closed (so the 3rd vector  is not suitable 
as a cross section) then a red X will be displayed to indicate 
the selection is invalid.  

The order the vectors are selected for this operation is 
important. This selection order is shown in the image 
below. 

Vector (1) represents the first rail (side 1) of the shape, 
vector (2) is the second rail (side 2) , the user can then 
select up to 3 more vectors, shown in the image as 3, 4 and 
5. These represent the cross sections of the shape as it is 
extruded along the rails. The first cross section (3) will be 
placed at the start of the rails, the second (4) in the middle 
and then the last (5) at the end. The shape created will 
depend on these selected shapes and the options selected 
on the form which is detailed below. If only one cross 
section is chosen then that will be applied along the whole 
shape, if only 2 then they will represent the start and end 
cross sections of the shape. The image above right shows 
the resulting 3D shape from the vectors in the image (height scaled with width). 

 
 

1 

2 

4 5
  

3 
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When you have a valid selection in the 2D View, the vectors will be shown selected (pink dashed 
lines) and they will be marked at their start points with colored squares. Rail 1 will have a blue 
square, Rail 2 a red square and then each cross section a Blue square. On the cross sections this 
shows the end of the cross section which will “sit on” the first rail. The other end will go on the 
second rail. Between the rails grey lines will be drawn to show how the sections of the shape will 
flow along the rails. These should not overlap and should be similar to the image shown below: 

 

Reverse Rail Direction 
There are 2 check boxes immediately after the Status For Selection. These allow you to 
change the direction of the rails which will affect how the sections flow along the shape. If 
the preview sections (gray lines between the rails) are overlapping as shown in the image 
below, then it is normally an indicator that the first or second rail needs to be reversed by 
checking the appropriate box. If you do not reverse one of the rails then the shape when 
calculated will appear twisted.  

 
In the case shown above it would probably be the second rail (marked with the red square) 
that you would reverse so its start point is moved to the left end of the vector and lines up 
with the first rails start point (marked with the blue square).  

Connect Rail Nodes Option 
By default, Aspire sweeps the cross-section along the drive rails connecting points at the 
same proportional distance along each rail’s length. So, for example, the positions halfway 
or three-quarters of the way along each drive rail will be connected by the cross section in 
the resulting 3D shape. 



 

 
119 Navigation Homepage 

 
 

 
As the figure above shows, when the matching proportional positions along each rail do not 
match the salient features of the model it can produce undesirable results. In this example 
the corners of the frame design are at different proportional positions along each rail and so 
the two-rail sweep does not connect them. Instead the cross-section appears stretched 
around the corner, as it is used to connect other points that do match in their proportional 
distance along each rail. 
To resolve this, Aspire allows you to force the connection of pairs of points along the drive 
rails – provided there are the same number of points in each rail so that matching pairs can 
be found. The Connect Rail Nodes option is only enabled if the selected drive rail vectors 
have exactly the same number of nodes and spans in them. With this option selected, Aspire 
will not use proportional distance, but instead ‘snap’ the cross-section to each matching pair 
of nodes on each rail as it sweeps.  

 

Note: If the Connect Rail Nodes option is unavailable, use node editing mode to check that the 
drive rail vectors have precisely the same number of nodes and spans in them. You may need to 
insert or delete nodes to ensure that this is the case. 

Scale cross sections with width  
As the cross sections are extruded along the rails the user can either choose to retain the exact 
shape and height of the cross sections or for a more “natural” look the “Scale Cross Sections with 
width” option can be checked. This will alter the height of the cross section in proportion to the 
distance between the rails. This simply means that as the rails get further apart the shape gets 
higher and as they get closer together the shape gets lower. The shape below left shows the result if  
this option is Un-checked, the shape below right shows the result from the same vectors with this 
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option checked. Notice how with the option checked, the shape tapers down at the ends as the 
distance between the rails gets smaller. 

  
 

Cap Ends Of Swept Shape 
Checking either of the options under this function will create a rounded cap at the end of the sweep 
which rolls over from the ends of the rails. A good example of the type of shape this will create is 
shown in the form when you select either of them. These preview images are shown below. One or 
both of these options can be selected for any particular sweep. Some unusual results will occur 
unless the ends of the rails being capped are reasonably parallel. 

  

Sweep Between Spans  
This option only becomes active if all the selected cross section vectors have the same number of 
spans and nodes. When checked it will ensure that as the shape is extruded that it goes from a 
particular node/span in one cross section to the same node/span on the next cross section. In 
certain shapes this can give the user more control over the way the shape flows. 

 

Using the above vector selection, the shape below left will be created with Sweep Between Spans 
unchecked and the shape on the right is created with the option checked. Note that on the right 
hand picture,  the crease in the shape goes from the middle of the first cross section (where the 
middle node is) to the point in the middle cross section where its middle node is, then it flows back 
to the middle of the last cross section. On the first example then it just flows through the shape 
evenly with no additional control.  
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Blend Between Sections  
There are two choices under this section of the form; either to Blend Smoothly or Blend Linearly. 
This controls how the shape blends through the middle cross section if 3 cross sections have been 
selected to define the shape.  

 

Using the above vector selection then the shape below left shows it set to Blend Smoothly – notice 
how it goes evenly through the middle cross section. The image on the right shows it set to Blend 
Linearly, notice that there is a crease as the blend goes in a direct straight line from the first cross 
section to the middle one then straight onto the end one from there.  

  

Scale to Exact Height 
Checking this option scales the height of the calculated 2 rail sweep by scaling the shape up or down 
while retaining its general specified profile. The shape will be scaled to the height entered in the 
Height area of the form which becomes available once this option is selected. 

 

Fill Centre Vector 
If you are sweeping two closed vectors to form a border or boundary shape, you can have Aspire 
automatically find the height that the cross-section forms on the inner boundary and then fill the 
shape to this height. This tool is perfect for sweep decorative bases, plaques or motifs.  
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Component  
This section includes some useful options to help you manage your components. See Component 
Management from within a modeling tool for more information.  

Close 
Closes the form and updates the Component Tree with the changes that you have made. If you 
wanted to remove the shape you just created then you can hit the undo icon or use the keyboard 
Shortcut to undo, CTRL+Z. 

Note: If you change your selection of vectors after you have created a 2 rail sweep shape (while the 
form is still open) the software will prompt you by asking “Do you want to keep the current two rail 
sweep?”. Hit Yes to keep the shape you have created and continue making other 2 rail sweeps with 
different vector selections, hit No to delete the current shape. This is useful when making more 
complex 2 Rail Sweep shapes which require multiple sets of rails to achieve (such as a multiple sided 
border).  
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Component Management from within a modeling tool 
Several of Aspire’s modeling tool pages have an additional 
section added to them to allow you to manage new 
components from within the modeling tool. This streamlines 
your workflow as it means you do not have to keep exiting 
and re-enter a modeling tool when creating several 
components using the same modeling technique. 

The component section of your modeling tool page allows 
you to edit the name of the component that will result from your modeling operation, and also the 
combine mode it will have when it is added to the component tree.  

The process of adding the new component normally occurs automatically on closing the tool page. 
Alternatively, at any point when using the tool, you can press the Start New Component button. This 
will immediately create a component using the current results of your modeling operations and add 
it (with the name and combine mode indicated) to the component tree. In addition, it automatically 
creates a new blank component ready for you to continue the modeling process. 
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Sculpting 
Aspire’s sculpting tool is one of its most powerful 
features. It allows the user to perform truly 
dynamic interactive editing of your 3D 

Components. Once activated, the user chooses from a 
variety of tool options which determine how the model 
will be changed and then uses the mouse (or a pen tablet) 
to actually edit the 3D model. This is done in the 3D view 
and requires the user to click and move the mouse cursor 
in the area of the model they want to apply the tool. The 
best way to understand this tool is to actually try it and to 
watch the Tutorial Videos that are supplied with the 
software as it is very much a visual tool (which is what 
gives it its power). Below is the Sculpting form and a 
description of all the options within it. 

Tool 
One sculpting tool at a time can be selected by 
clicking the option from the form or using the 
ShortCut keys (numbers 1 – 6 displayed next to 
each option). The effect of each option is 
described below: 

Smooth 
As the user moves the mouse back and forward 
over the 3D model the area under the red cursor 
will be smoothed out to average the high and low 
areas of the model. 

Smudge 
As the user moves the mouse from one place to 
another on the 3D model the material under the red cursor will be dragged, similar to 
smudging a piece of clay with your thumb. In Aspire it means that going from a high to low 
will pull the higher material into the lower and vice-versa. 

Deposit 
As the user moves the mouse over the 3D model the area under the red cursor will have 
material added to it to increase its height.  

Remove 
As the user moves the mouse over the 3D model the area under the red cursor will have 
material removed from it to decrease its height. 
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Undo Brush 
As the user moves the mouse over any area of the 3D model that have already been 
sculpted then the area under the red cursor will be gradually returned to its original state. 
This can be used to undo some of the sculpting if make a mistake.  

Note: If you press the ‘shift’ key with this tool you can erase the section of the model 
under the cursor completely. 

Twiddle 
Normally when in the 3D View you can twiddle (rotate) the direction of the view by left 
clicking and moving the mouse. In the Sculpting mode the left click is what activates the 
sculpting so cannot be used for twiddling the view. Selecting this option allows the user to 
twiddle the view as normal before returning to one of the other sculpting tools. A Short-Cut 
to this while in the sculpting is holding the Alt key while left clicking and moving the mouse.  

Diameter 
This slider will allow the user to control the size of the sculpting cursor (red circle).  This value can 
also be changed while sculpting by rolling  the ‘wheel’ on a roller mouse, pressing control while 
rolling the wheel will change the diameter in smaller increments. 

Strength 
This slider controls the strength of the tool that is currently selected. The higher the strength the 
more effect the tool will have as the cursor is moved over the model. The strength can also be 
adjusted by rolling the mouse wheel while pressing the ‘shift’ key if you have a roller mouse.  

PreserveTransparency 
This option is checked by default when you first go into the Sculpting. Leaving it checked will mask 
the sculpting so it is only applied within the existing boundary of the compoenent. This stops the 
edges being blended into the background. It is called Preserve Transparency as the background is 
represented by a transparent (lighter colored) flat plane around the edge of the 3D component. Un-
checking this option allows the user to sculpt the part into the modeling plane if the shape needs to 
be changed to go outside of its original edge or if the edges need smoothing into the background.  
Pressing the ‘0’ key while sculpting is a shortcut to toggle this option. 

Mode 
The sculpting mode defines how the tool is applied to the model in terms of the heights of the shape 
under the sculpting cursor. The Raise option is good for filling in holes and the Lower option is good 
for eliminating spikes in a model. A good example of need for this may be if the user was working 
with 3D digitized data which had been imported from a scanner (e.g. as an STL model). 

Normal 
Selecting this option means that the sculpting operation will average the high and low points 
under the cursor dragging them up or down as appropriate. 

Raise 
Selecting this option will maintain the highest points under the cursor when smoothing or 
smudging only allowing material to be added (based on the currently selected tool).  
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Lower 
Selecting this option will maintain the lowest points under the cursor when smoothing or 
smudging only allowing material to be removed (based on the currently selected tool). 

Changes 
Sculpting is a very iterative process and frequently as the user progresses, they will want to either 
get rid of a recent change, or will want to “save” the changes they have made and continue 
sculpting. The options under Changes in the form allow the user to do this.  

Keep 
Clicking the Keep  button will internally “save” the sculpting changes made so far. This 

should be clicked if the user is happy with the sculpting so far and wants to keep it but also 
wants to continue to sculpt the model.  

Discard 
Clicking the Discard  button will discard all the changes made with the sculpting tools back 

to the stage that the Keep button was last clicked. If the Keep button has not been clicked 
within a particular sculpting session then all the changes will be discarded. In order to ensure 
that this is not accidentally selected a Warning will appear giving you the option to verify 
you want to discard your changes. This warning can be bypassed by holding down the Shift 
key while pressing Discard.  

OK 
Clicking OK  will accept all the changes made to the model within the sculpting session and 

exit the form updating the Component Tree with the newly sculpted model. 

Cancel 
Clicking Cancel  will exit the sculpting and discard ALL the changes you made within that 

sculpting session. The changes will be discarded even if you have previously hit Keep. If you 
wanted to keep most of your changes but discard just the ones you made since the last Keep 
then you should hit Discard first then OK. In order to ensure that this is not accidentally 
selected a Warning will appear giving you the option to verify you want to exit and discard 
ALL your changes. This warning can be bypassed by holding down the Shift key while 
pressing Cancel.  
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Create Component from Bitmap 

 This automatically creates a new component from a currently the selected Bitmap Image in 
the 2D View, the Component will have the same name as the original image. Once created, you can 
use the Component Properties to change its dynamic properties, or modify the shape directly using 
the modeling tools such as smoothing or sculpting. 

If no bitmap is selected in the 2D View, then a file dialog will open allowing you to select a bitmap 
from disk. This method of component creation bypasses the need to convert the image file into a 
bitmap and so is the best way to directly convert image files to components. See discussion of 16-bit 
images below. 

Import / Export 16 bit grayscale images as components 
Most bitmap images and image editors use 256 levels to encode each of the red, green and blue 
color channels for each pixel – this is called 8-bit encoding. For color photographs, this level of 
encoding is a good trade off of file size against quality, as it gives the impression of smooth color 
transitions. It is also an ideal format for Aspire to find nice vector boundaries (using the Trace tool) 
to use as the basis of 3D modeling, based on an image. 

However, for the specific case of directly converting image brightness to height (which occurs when 
you convert a bitmap to a component, or import a bitmap as a component) the limited number of 
discrete levels in a conventional bitmap image can reveal itself as concentric plateaus in the resulting 
3D model.  

  
8-bit conventional grayscale image converted to a 3D 

component 16-bit grayscale TIFF image converted to a 3D component 

 

Similarly, some laser machines are able to use an exported grayscale bitmap version of the 
composite model as the basis of their laser machining strategy. Once again, the conversion of the 
highly detailed 3D model into an 8-bit image can cause a noticeable loss of quality, when compared 
to the original. 

The greatly increased accuracy of a 16-bit image will avoid the problems of visible contour-like steps 
when converting to, or from, a 3D model. Aspire supports the importing and exporting of 3D 
components as 16-bit TIFF image files for this purpose.  
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Note: Converting an 8-bit image to a 16-bit image in an external package, such as Adobe 
Photoshop, will not improve the quality of your resulting 3D components – 16-bit images must 
have been created from data containing the additional height information from the outset to 
provide any benefit. Typically these images come from specialist or scientific applications only. 

Importing an image as a component 
To benefit from the potential for 16-bit images to create higher quality 3D components, they must 
be imported directly as components. To import a bitmap as a component, ensure that no bitmaps 
are currently selected (otherwise Aspire will assume that you want to covert the selected bitmap, 
rather than import a new one) then click on the Create a component from selected bitmap icon on 
the Modeling tab.  

Note: Don’t import a 16-bit image, and then convert it to a component. If 16-bit images are 
imported as bitmaps to use for modeling, then they will be automatically converted to 
conventional images during this process. The additional height data will be lost. Importing the 
bitmap directly to a component maintains the full quality of the image throughout. 

Exporting a 16-bit grayscale for laser machining 
Your final composite model can be exported from Aspire as a 16-bit grayscale, which will preserve a 
great deal more of the height detail of your model than a conventional grayscale image. If you 
require your model in the form of a grayscale, and your tool supports it, (this is typical of laser 
machines, for example), the 16-bit tiff output is recommended. Simply select the ‘16 Bit Tiff (*.tif)’ 
file type from the drop down list when exporting your model via Model → Export as Grayscale 
Bitmap. 
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Import a Component or 3D Model 
 This command opens the File Open 
dialog window, allowing existing Aspire 
files (CRV3D extension) and importable 

3D files to be selected and opened. If you select 
a 3rd party 3D model format, the Orientate 
Model form will open (see below) to allow you to 
manipulate the 3D model before it is converted 
into a Component. 

CRV3D 
3D data from files previously created and saved in Aspire will be opened and a new single 
Component Created (from all the visible 3D Components in the file when it was saved). 
The new Component will have the same name as the file.  

V3D 
3D data (not toolpaths) from files saved with Vectric’s Cut3D software program will be 
opened and a new Component created with the same name as the file.  

V3M 
V3M is a proprietary file format developed by Vectric for Vector Art 3D. Files in this format 
can be purchased from www.vectorart3d.com and when imported into Aspire will create a 
new Component with the same name as the file.  

STL 

This is a standard format for compex 3D models, based on a triangular mesh STL files can 
be exported from many 3D design software programs such as Rhino. These models can be 
completely 3 dimensional (ie. have a front, back etc.), this means that when this type of 
file is opened that it must first be sized and oriented before a Component can be created 
(Aspire only represents bas-relief so cannot work with a completely 3D object). This 
process is explained in the section immediately below this. Once the file becomes a 
Component it will have the same name as the original STL file.  

DXF 3D DXF files from AutoCAD and many other CAD orientated modeling packages 

3DS Format from 3D Studio Max and many other animation orientated modeling packages 

OBJ Format from Wavefront and many other animation orientated modeling packages 

Note: If you wish to read data from a 3D digitizer or scanning device then STL is the format that 
should be used to import the data into Aspire. Many software packages that work with a scanner 
offer an STL export option, if not then a third party software program may be required to convert 
the data to this format. 

http://www.vectorart3d.com/�
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Importing a 3D Model – (STL, DXF, 3DS, OBJ etc) 
When one of these formats are chosen for 3D file Import,  the imported model needs to be oriented 
and scaled before it can become a Component. A special import window is opened and a set of 
orientation/scaling tools enabled which are controlled 
using the form shown below. There is also a video tutorial 
that shows this process. 

Top Surface 
Choose one of the 6 options to determines the most 
suitable direction on the model that defines the top 
surface (upper Z) that you want to use when its converted 
into a Component 

Model Size 

Lock XYX ratio 
Un-checking this option allows the model to be 
distorted from its original shape, this means 
independent X, Y and Z sizes can be entered, 
leaving it checked fixes the ratio so it cannot be 
distorted and will automatically scale the other 
axis as you enter new values for X, Y or Z.  
X Enter the size you would like for the X axis 
dimension of the model. 
Y Enter the size you would like for the Y axis 
dimension of the model. 
Z Enter the size you would like for the Z axis 
dimension of the model. 

Apply 
Applies the values you have entered for the X, Y or 
Z dimensions and scales the others if you have the 
Lock XYZ ratio option selected. 

Many mesh files do not inherently have units that they 
were made in, so the software is not able to tell if the files 
are supposed to be inches or metric, they will just have a 
particular value. Therefore it is quite common to need to 
scale the part from inch to metric or vice versa. If you import your model and you wish to work in 
inches and the file seems very large or if you work in Metric and the file seems very small then you 
will probably need to use the Scale mm/inches option. The next two items on the form cover this 
need. 
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Units 
Choose the unit of measurement you are working in.  

Scale mm/inches 
Scales the X, Y and Z values up or down depending which Unit option is selected. If mm is 
selected then the software assumes you want to scale the values up so multiplies the 
current values by 25.4, if inches is selected it assumes you want to scale the values down 
and divided them by 25.4.  

Orientate Model 
If none of the 6 choices for Top Surface give you the exact 3D orientation you need when creating 
the Component then you can hold the Shift key down and rotate the model by moving the mouse 
(works in a similar way to twiddling the view).  

Zero Plane Position In Model 
This slider bar determines where the 3D model will be cut-off when converting to a Component. You 
can moved this up and down or use the Top, Middle or Bottom buttons to position the plane in the 
correct position. 

Note: Anything which is an undercut (goes underneath a part of the 3D model) will be discarded and 
a vertical wall will be created down to the plane from the sihouett edge of the model. 

Discard data below zero plane 
Leaving this checked will remove any data below the original Zero level within the imported 3D 
model. If the model is effectively a negative model such as a dished or recessed design with a flat 
plane then you should uncheck this option to make sure you retain the 3D data below the plane.  

OK 
Creates a 3D Component based on the settings in the form, the Component will have the same name 
as the imported file 

Cancel 
Cancels the Import function and returns to the software 
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Clearing or splitting Components 
The options to clear areas of a 3D Component, inside and outside of vectors, are very useful 
modeling tools. There are many occasions where the 2 Rail Sweep or the Create Shape options may 
not allow you to create or control the exact shape that you need. Often you may need to create the 
general underlying shape with those tools then use these options to “cookie cut” either to leave just 
the part of the shape you want or to make a hole in it. Many examples of this will be covered in the 
video tutorials supplied with the software. Below is an example of how this might be used to make a 
leaf shape: 

   
 

In the image above and left you can see the vectors selected for a 2 Rail Sweep to make a simple 
flowing shape. The result of this sweep is shown in the middle image. Our actual leaf edge vector can 
be seen in the left hand image as well. In order to get the part of the swept shape.  

Clear Component Inside Selected Vectors 

 Removes all of the model inside the currently selected vectors. 

Clear Component Outside Selected Vectors 

 Removes all of the model outside the area of the currently selected vectors. 

Split Component 
This tool allows you to split the selected component into two independent components. 
To use this tool, you must select the component you wish to split and a single vector to 
indicate the split boundary then click on the tool. 

You can use either an open or closed vector to define the split boundary. A closed vector can be 
envisaged as a ‘cookie cutter’. The resulting two components will be as if the cookie cutter vector 
was pushed through the selected component to split it.  

If an open vector is used to define the split boundary, Aspire will extrapolate from the ends of the 
selected vector to the edge of the modeling area to create the two resulting split components. 
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The names of the resulting components are automatically labeled with ‘A’ & ‘B’ in the component 
tree.  

If multiple components, or a component group, are selected for this tool, Aspire will prompt for you 
to bake the components before continuing. See Baking Components for more information. 

In the image above and left you can see the vectors selected for a 2 Rail Sweep to make a simple 
flowing shape. The result of this sweep is shown in the middle image. Our actual leaf edge vector can 
be seen in the left hand image as well. In order to get the part of the swept shape.  

Create Vector Boundary From Components 
Just before calculating toolpaths, or during the modeling process, it is frequently desirable 
to create a vector of the outermost boundary of one or more components.  

Select one or more components and click the create vector boundary from components button. 
Aspire will create one or more closed vector boundaries around the edge of the selected 
components. If more than one closed vector is required to create the boundary, these will be 
created as a group and may need to be ungrouped before they can be node edited. 

Baking Components 
In general, the really useful thing about components is that they can be manipulated 
entirely independently of each other to build up a sophisticated 3D model from much 
simpler design elements. However, at some point in the modeling process you will want to 

apply a modeling tool to several components as if they were a single entity. For example you may 
wish to smooth one shape into another using the sculpting tools. Or perhaps you would like to bend 
a group of components around a curve using the distortion tool? In Aspire, consolidating a selection 
of components into a single, new object is a process called ‘baking’. Once baked, selected 
components will behave exactly like a single component in all the modeling tools, but you will no 
longer be able to manipulate the contributing components independently. 

Aspire will prompt you when you have a group or component selection that requires baking before a 
particular modeling tool or operation can proceed. Alternatively, you can use the Bake command to 
perform this operation yourself. By manually baking-in existing fade, tilt or distortion, for example, 
you are then free to apply further dynamic properties ‘on top of’ the previously applied ones. In 
addition, consolidating multiple components towards the end of the design process allows your 
computer to recover system resources and may give it a welcome performance boost – particularly if 
you have been modeling using a large number of high resolution or complicated components. 
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Component Properties 
The component properties form allows you to 
adjust a number of dynamic properties for 
each selected component. Dynamic properties 

do not make permanent changes to your components and 
can be altered or reset at any time.  

Enter a value in the Shape Height edit box directly, or use 
the slider to adjust the height of your component selection 
interactively. In either case, the 3D view of the component 
will update automatically as you adjust the value. The 
range of available heights on the slider is determined by 
your current material thickness setting. If these values 
appear to be inappropriate you can still enter any value 
you like into the associated edit box, or you can close the 
tool and select ‘Edit->Job Size and Position’ from the main 
menu. In the Job Setup page you can then correct the 
current setting for the material thickness before 
continuing. 

To reset the component’s height to its original modeled 
height and its base height to zero (i.e. remove any dynamic 
height changes you have made using the Component 
Properties tool), click the Reset Heights button. To reset 
just the Base Height back to zero easily using the slider 
control, double click the central tick marker above the 
slider bar.  

Multiple Selections 
If you have more than one component selected while using 
the Component Properties tool, Aspire will apply the 
changes to all the selected components. Some properties 
where this would be inappropriate (such as the 
component’s name) are grayed-out when there is more 
than one component selected. These properties must be 
applied to components one at a time. 

Note: Slider controls with a default central position marker can be reset by double-clicking the 
marker. 

Combine with other components 
The Combine mode dictates how the Components are integrated with each other. This is done by 
the software starting at the top of the list and working downwards. The first Component’s combine 
mode determines only how it combines with the contents of the Component Tree. The second and 
subsequent Components are combined with the result of everything above them based on their 
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Combine Mode as detailed below. See the Combine Mode section at the start of the 3D Design 
section of this manual for more explanation and diagrams of these options.  

Add 
Adds the selected Component/s to the result of all the previous Components in the list 

Subtract 
Subtracts the selected Component/s from the result of all the previous Components in the 
list 

Merge 
Where they overlap, this Merges the selected Component/s into the result of all the 
previous Components in the list keeping the highest part of the overlapping area. This means 
the higher part of each shape will be what remains in this area.  

Low 
Where they overlap, this Merges the selected Component/s into the result of all the 
previous Components in the list keeping the lowest part of the overlapping area. This means 
the lower part of each shape will be what remains in this area. 

Shape Height: 
Use the slider or type in a specific percentage to scale the height of the selected Component(s) up or 
down based on its current height (100%).   

Base Height: 
Enter a specific value into this box to raise the Component up on a flat plane of the thickness you 
specify. This can be useful to help move a Component up so it sits proud of another component it is 
Merging with. If you are not sure of the value you need, then enter an amount and hit the space bar 
to apply this. If this is not correct type in another value and hit space again to apply to the 
Component in the 3D View – repeat until you get the value you need.  

Reset Heights 
 The Reset Heights  button will remove the dynamically applied Shape and Base height settings from 

the selected component. 

Fade 
When this option is checked the user can fade the Z depth of the Component. The first part of this 
operation (once the option is checked) is to select the Set Anchor button – then click two points in 
the 2D view. The first click specifies the point which will remain at full depth. The second click 
specifies the point that the Component will be faded down toward. The shape will fade down from 
this point to the second by the percentage selected. Change the strength of the fade by clicking the 
down arrow next to the percentage value and using the slider to move this up and down or type in a 
specific value for the amount you would like to reduce the depth. The fade will be applied linearly 
between the two selected points. This is a useful tool for giving the effect of a Component fading 
into the distance to help with overlapping areas of Components if you want to lower an area to give 
it the appearance of going behind another one.  
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Tilt 
When this option is checked the user can set a direction and angle to tilt the Component up at an 
angle in Z. The first part of this operation (once the option is checked) is to select the Set Anchor 
button – then click two points in the 2D view. The first click specifies the point which will not move 
(the pivot point of the tilt). The second click specifies the point that will be tilted upwards by the 
specified angle (the point that will be raised up). Change the tilt angle by clicking the down arrow 
next to the value and using the slider to move this up and down or type in a specific value for the 
angle. This is an extremely useful function for raising a part of one Component above another one 
when they overlap, without having to raise the whole Component up using the Base Z Position 
option, in some cases this allows the overlapping areas to sit proud without having to create a deep 
raised wall around the whole edge of the Component.  

The Bake button 
Sometimes you will wish to apply a component’s dynamic properties permanently (perhaps so that 

further dynamic changes can be applied ‘on top’ of previous ones). To do this, use the Bake  button. 

This performs the same action as baking in other areas of Aspire, see Baking Components for further 
information. 

Appearance 
Aspire gives you a lot of control over the appearance of the 3D shaded image. For visualization 
purposes such as customer approval proofs or marketing material each component can be given an 
individual color or material, an example of this is shown in the image below: 

 

There are four choices available for appearance. If you 
click on the down arrow to the right of the Appearance 
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options, this choice and the Components position in the list will determine the shaded image of the 
3D part. 

Same as Parent  
This will give the selected Component(s) the same appearance as the items above it in the 
Component List.  

Solid Color 
This option allows the user to choose a solid color for the appearance of that Component. 
Color can be selected by clicking on the colored box immediately below the Appearance 
choice as shown in the image below.   

  
Click on More Colors …  to choose any color you like. 

Use Material 
When this is selected the user can choose from the list of pre-defined material effects by 
clicking on the box immediately below the Appearance choice. These include many wood 
grains, metal effects, stone and plastic. 
 
Additional materials can be added to the library list by copying an image file (JPG, BMP or 
TIF) of the material or image into the relevant materials folder on your computer. 
To find the Materials folder on your computer, use the menu command File → Open 
Application Data Folder….Then open the folder Bitmap Textures. Either copy your new 
textures into one of the existing folders, or create a new folder and add them there. 

Note: You will need to restart Aspire for the new material images to become available. 

Color from Children 
This option is used for a Group of Components and will allow the software to use the 
individual colors and materials assigned to the groups constituent Components to display in 
the shaded image even though it is a Group. If this option is not selected the Group will be 
given its selected Color or Material.  
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Highlight Selected Component 
When choosing a material or color to use for a particular component, the red selection highlighting 
of the component in the 3D view can prevent you from seeing your chosen material accurately. 
Untick this checkbox to temporarily disable the red highlighting while you make you selections. This 
option will automatically be re-enabled on exiting the Component Properties page. 
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Smooth Components 
Often it is advantageous to apply a general 
smoothing effect over the whole of a component 
(rather than smooth a particular area with the 

Sculpting Tools). To use this tool, select the components 
you wish to smooth and then click the icon button on the 
Modeling tab. The following form will appear  and Aspire 
will take a few seconds to prepare the model for the 
smoothing operation. You will see a progress bar at the 
bottom of the screen while it is doing this.  

Smoothing 
This slider will allow the user to control the strength of the smoothing applied to the 
Component. By default no smoothing is applied, using the slider different levels of 
smoothing can be applied to the model. Find the strength which gives you the amount of 
smoothing you require. If the Max. setting has not smoothed the model enough then hit OK 
and hit the Smoothing icon again.  

Preserve Transparency 
This controls whether the smoothing is applied to the entire Component or if it is only 
applied to the actual 3D shapes – not the background. Checking this option will keep the 
smoothing only on the modeled areas and not smooth the edges into the background. Un-
checking this option will smooth all the edges of the modeled area into the background.  

Note: Smoothing should be performed with the 3d view visible, so that the effects of the slider can 
be seen in real time. 
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Scale Model Height 
You can scale the individual heights of your 3D Components using the Component 
Properties form. However, it is also very useful towards the end of you modeling process to 
be able to apply a global scaling to your final composite model. This allows you to 

accurately fit a design within the available material or to manage the depth of cuts required, without 
having to individually adjust each of the contributing Components. 

 

 

Scale Height 
This slider will allow the user to increase and decrease the height of the model as a percentage 
based on its original height (when the Scale tool was selected).  

Set Exact height… 
Clicking Set Exact Height…  button lets the user define a specific value (in the current working units) 

for the height of the model, rather than use the proportional slider. 

 

OK 
Exits the dialog keeping the changes made to the Model 
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Cancel 
Exits the dialog discarding the changes made to the Model 
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Slice Model 
The slicing feature allows the user to divide the Composite Model into Z-Slices each of 
which will become a Component. This is for customers who need to cut a part which 
exceeds the Z depth of their machine gantry, the cutting length of their tools or the 
thickness of the material they are using. Once the slices have been carved then they can 

be re-assembled to make the finished full depth part.  

When this function is executed each slice will become a Component in the Component Manager and 
can then be moved into position and have toolpaths calculated on it. An example of this is shown in 
the images below, on the left it shows a scallop shell component that is 3 inches thick, the image 
below right shows this divided into two separate components, each a 1.5 inch slice of the original.  

  
 

Note: Before using the Slice model command it is important to make sure that you hide any 
components that you do not wish to include in the operation. 

When the icon is clicked the Slice Model form will appear. This can be used to control the number 
and thickness of slices which will be created. At the top of the form it will display some reference 
information showing the thickness of the current Composite Model and also the currently defined 
Material Thickness (for machining).  
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Model Slicing 

Slice Thickness 
Checking this option will let you define a particular value for each slice. Right below this the 
Number of Slices will be displayed which is determined by the Composite Model thickness 
divided by the Slice Thickness. The model will be sliced from the bottom up and if the 
Composite Model thickness does not divide exactly by the Slice Thickness then the top slice 
may not be a whole number. To help indicate how the part is going to be divided the Top 
Slice Thickness is displayed in the form.  

Example: If the Composite Model is 4.75” thick and you define a Slice Thickness of 2” then 
the software will create 3 Component slices – the bottom and middle slice will both be 2” 
thick and the top slice will be 0.75” thick.  

Number of Slices 
Checking this option will divide the model into a specific number of slices. The slice thickness 
will be determined by the Composite Model thickness divided by the Number of Slices 
defined. This may be a good option to use if the specific slice thickness is not important (for 
instance if it does not relate to material thickness). 

Example: If the Composite Model is 3.96” thick and you define 3 Slices then the software 
will create 3 Component slices each 1.32” thick.  

Slice Model 
Clicking Slice Model  will apply the choices made in the form and create the Components which 

represent each slice of the Composite Model. 

Cancel 
Clicking Cancel  will close the Slice Model form without completing the operation.  
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Export Model as STL File 
The STL file format is an industry standard for representing 3D models as meshes made up of 
triangles. It is a very robust way of exporting a version of your 3D composite model to external 
applications or even Rapid Prototype (RP) machines.  

Limit Triangles By… 
In general, triangle meshes are not able to hold as much 
detail as Aspire’s 3D Components. As a result, you must 
choose which strategy Aspire will use to reduce the 
detail in your STL file. 

Maximum number of triangles 
Using this option the quality of the mesh is 
limited by how many triangles you specify here, 
the larger the number the better the detail and 
smoothness but the larger the memory size of 
the file will be.  

Approximate tolerance 
Using this option the quality of the mesh is 
defined by how closely you allow the software 
to approximate the model. The smaller the 
number the better the detail and smoothness of 
the model but the larger the memory size of the 
file will be.   

Back face of triangulation 
The Composite model does not have a defined back 
face, because it is generally unnecessary for 
conventional 3-axis CNC machining. When converting 
your composite model to a 3D mesh, however, it can be useful to form a closed mesh by creating a 
back face automatically. 

Leave Open (No Back Face) 
This creates a mesh with an open “back”. This creates a shell with the 3D shape on its face 
and an open back side.   

Close with inverted front 
This creates a mesh with a copy of the front of the model on the back. This is used when a 
solid 2 sided model is needed for output. An example of this might be a 2 sided fish.  

Triangulate 
When the options for the mesh have been selected then clicking Triangulate  will actually calculate 

the mesh and display the result in the 3D View. If this does not look correct (such as not being 
detailed enough) then the options can be changed and this button clicked again to re-calculate the 
mesh. 



 

 
145 Navigation Homepage 

 
 

Num Tri Created 
Once a mesh has been created, this field reports how many triangles it comprises. The more 
triangles are used, the larger the file size and the more difficulty external applications may 
have in manipulating them. 

Maximum Error 
This field indicates the worst deviation of a mesh triangle from the original 3D model.  

Draw shaded triangulation 
The triangle mesh can be viewed in wireframe or shaded modes using this option. 

Save Triangulation… 
Once the mesh looks correct then clicking this button enables it to be saved onto your 
computer as an STL format file. 
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Component Manager 
The Modeling tab 
All of the tools relating to the creation, editing and management of your 3D components can be 
found on the Modeling tools page, which is normally available as a tab at the bottom left of your 
screen next to the Drawing tab. 

Adjusting the space available for Component Tree 
The Modeling tools tab is divided into two sections. The top section 
lists all the components and component groups currently in the 
model – this is referred to as the Component Tree. The lower section 
hosts the tools that relate to 3D components (including the relevant 
tools that are also accessible from the Drawing tab). You can adjust 
the space available for the Component Tree by clicking and dragging 
the divider that separates the two sections, up or down. 

Note: Aspire 2.5 customers will see that from Aspire 3.0, the Modeling tab (with its integrated 
Component Tree and Component Properties tool) draws together all the functionality that was 
previously divided amongst the modeling section of the Drawing tab, and the Component List & 
Model Tree tabs of the Component Manager. 

Understanding the component tree and the composite model 
The model that you see in the 3D View is the result of progressively combining all of the visible 
components from the top of the Component Tree, to the bottom. The resulting model is known as 
the Composite Model. The order in which components are combined can have a significant impact 
on the final shape of the composite model and so you will often need to move components relative 
to one another within the Component Tree in order to achieve the end result you are intending. 

To help you understand how the components are being combined, each component in the tree has 
an icon indicating how it is currently being combined with the components above. 

     
Add Subtract Merge Low Group 

 

Grouped components are also indicated by their own icon and the presence of a plus or minus 
control to the left of the visibility checkbox. These controls allow you expand or collapse the group 
to show or hide the group contents, respectively.  
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Visibility Checkbox  

  

Show/Hide Group’s Contents  

  

 Currently Selected 
Component 

Combine Mode Icon  

  
 

Component Visibility 
The checkbox next to each component in the component tree indicates its visibility. Components 
which are hidden (their visibility checkbox is un-ticked) do not contribute the composite model. 

When a component is hidden in the component tree, its associated 2D preview is also automatically 
hidden. However, please note that the reverse is not necessarily true. It is often possible to hide a 
component’s 2D preview without affecting the component itself – see The relationship between 
components and their 2D previews , for more information. 

Changing a Component’s Position within the Composite Model 
To alter a component’s position in the Composite Model, click and drag a component up or down in 
the tree. An insert marker will indicate where you are preparing to move the component to. Release 
the mouse when the marker is in the position you wish to move the component to. 

The relationship between components and their 2D previews 
Components are represented in the 2D View using grayscale component previews. The component’s 
2D preview allows it to be manipulated using many of the same tools that are available for vectors. 
These tools are duplicated in the tool list on the Modeling tab, for ease of access. 

2D component previews are a great way of interacting with the components you have created, 
however it is important to understand that the component’s position in the component tree (and 
therefore the nature of contribution to the composite model) is not related to the drawing order of 
its 2D Preview image in the 2D View. Because the 2D previews can overlap, and thus obscure one 
another, it is often convenient to adjust the order in which they are drawn in the 2D View using the 
Move to front or Move to back commands. Similarly, the 2D Previews of components can also be 
placed on layers, along with bitmaps and vectors, and the visibility or order of these layers can be 
altered. These commands affect the previews only, not the associated component, and are entirely 
independent of the component tree structure. 

Component Preview Drawing Order 
Component previews can often obscure one another in the 2D View. If the previews are all on the 
same layer, then you can simply change their relative drawing order using the Move to Front or 
Move to Back commands. If, however, previews are on different layers then their overall relative 
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drawing order will be determined primarily by the layer’s position in the layer list. Objects on a layer 
higher up in the list, will always be drawn before any object on a layer further down the list and will 
thus end up ‘underneath’ them. If your component’s preview is underneath another preview that is 
on a different layer, use the layer manager dialog to move your component preview’s layer below 
the other. Now the important component preview will be drawn last and thus over the top of 
everything else (see Error! Reference source not found. for more information on this).  
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Manipulating Components 
The Component Tree lists all the components and component groups in your current model. It can 
be found on the Modeling tab in its own, resizable, section. Some modeling tool pages hide this 
section when they are active so you may need to close the tool before you can see it. 

If you have created a lot of components, you may also want to stretch the space available for the 
Component Tree to save scrolling up and down the list. To do this, move your mouse pointer over 
the divider between the Component Tree and the modeling tool icons below it. The mouse cursor 
will change to a double-headed arrow, indicating that you can move the position of the divider up or 
down. Click and drag the divider to the position you would like and then release the mouse button. 

Selecting a component 
Once created, 3D Components can be manipulated using any of the three main areas of Aspire’s 
interface.  

 

Components can be selected in 3 ways (indicated above, starting clockwise from the left): 

• By left-clicking on the component’s name in the Component Tree 
• By double left-clicking directly on the component in the 3D view 
• By left-clicking on the associated grayscale component preview image in the 2D view 
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In all cases, the new selection will subsequently be reflected in all three locations. So, for example, 
selecting a component in the Component Tree will simultaneously cause the associated 2D 
component preview to become selected in the 2D View, and the same component to become 
highlighted in red in the 3D View. 

There are, however, some minor differences between the three methods of selection. Also, 
depending on the circumstances, there may be some advantages to selecting your components 
using one method rather than another. These are detailed below. 

Component Selection in the Component Tree 
The component tree works in a similar way to the Window’s file explorer. To select a component, 
simply click on it. To select multiple components, hold down the ctrl key while clicking on each 
component you wish to add to the selection.  While in this mode, clicking on a component that is 
already selected will cause it to be removed from the selection.  

Pressing the shift key allows you to select a range of components. Click on the first component in the 
range to select it, then holding the shift key and pressing the last component you want selected will 
select all the components between the first and last selection. 

Double-clicking a component in the Component Tree will automatically open the Component 
Properties tool – see the Component Properties section for more information on how to use this tool 
to modify the selected components. 

Right-clicking an unselected component in the Component Tree will select it, and open its pop-up 
menu of related commands. Any commands you select will apply to this selected component only. 

Right-clicking a component that is already selected, and is also one of several selected components, 
will open a similar pop-up menu of commands. Any commands you select from this menu will apply 
to all of the currently selected components. 

Component Selection in the 2D View 
The 2D component previews behave exactly the same way as vectors or bitmaps. They can be 
selected by a single, left-click. Several component previews can also be ‘shift selected’ (see above). 
Clicking on selected component previews again activates their interactive transform handles. These 
can be used to move, rotate or stretch the 2D component preview and its associated 3D component. 

Component Selection in the 3D View 
Because the left mouse button is used for twiddling the 3D view itself, a single left-click cannot be 
used for component selection directly. However, Aspire’s 3D view supports most of the standard 
selection concepts described above, using double-clicks instead. Therefore, to select a component in 
the 3D view it must be double-clicked with the left mouse button. To select multiple components in 
the 3D view, hold down the shift key and double-click each of the components you wish to add to 
the selection. To access the pop-up menu of commands associated with a component, double right-
click it in the 3D View. 

Because components may overlap or merge through one another when forming the composite 
model, you may find that some components become difficult (or are even impossible) to select 
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directly from the 3D view. In these cases you will need to select them from the component tree, or 
via their 2D previews in the 2D view. For the same reason, please note that it may not always be 
possible to see the selected component highlighted in the 3D view if it is hidden by overlapping 
components. 

You can also double right-click the selected component (highlighted in red) in the 3D view. The 
options offered include showing/hiding components, or setting their combine mode within the 
composite model. 
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Automatic Component Creation 
Most of the modeling tools available under the component tree will act upon the current selected 
components. In most cases this means that you can simply select the component you wish to edit 
and click on the modeling tool you wish to use. If you select a modeling tool when no existing 
component is selected, Aspire will automatically create a new, blank component for you to begin 
working with. On closing the modeling tool, the newly created component will automatically be 
added to your model.  

Component Management from within a modeling tool 
Several of Aspire’s modeling tool pages have a standard 
section to allow you to manage new components from within 
the modeling tool. This streamlines your workflow as it 
means you do not have to exiti and re-enter a modeling tool 
when creating several components using the same modeling 
technique. 

The component section of your modeling tool page allows 
you to edit the name of the component that will result from your modeling operation, and also the 
combine mode it will have when it is added to the component tree.  

The process of adding the new component normally occurs automatically on closing the tool page. 
Alternatively, at any point when using the tool, you can press the Start New Component button. This 
will immediately create a component using the current results of your modeling operations and add 
it (with the name and combine mode indicated) to the component tree. In addition, it automatically 
creates a new blank component ready for you to continue the modeling process.  
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Toolpaths 
The entire purpose (in almost all applications) of Aspire is to allow the user to generate toolpaths 
which can be run on a CNC machine to machine the finished part in the material of choice. This 
requires at a minimum some vectors to describe the area a toolpath will be limited to or perhaps a 
combination of both vectors and a 3D Model.  The general process for creating toolpath is as follows: 

Prepare vectors for machining 
• Optionally organize the vectors you will be using for machining onto appropriate layers 
• Create outline vectors around any 3D data using the ‘Create vector boundary from selected 

components’ icon. 

Check your 3D data 
• Make sure you have the right combination of 3D Components displayed. Everything you see 

in the 3D View – the result of all your visible Components will be machined. 
• Check the depth of your combined 3D model to make sure it fits into the material you plan 

to use, edit this using the Scale Model Height function if necessary. 

Set up your Material 
• Check your overall material size (Job Setup) to ensure it matches or exceeds the size of the 

piece you plan to actually cut.  
• Use the Material setup form from the Toolpaths Tab to set the reference Z datum for the 

part relevant to your CNC machine and to position your 3D part within the material.  

Create your Toolpaths 
• Work through the toolpath strategy icons you wish to use to machine the job to calculate all 

the required toolpaths. 

Preview the Toolpaths 
• Either after you create each toolpath or at the end of calculating them all, the user has the 

option to preview the toolpaths to see what they will actually look like in the 3D. This is a 
very important step to verify position, detail and the look of the overall finished part. 

Note: The Preview is a very accurate representation of your final toolpath. If the Preview 
does not look correct then you should always go back and alter the problematic toolpath. 
Issues present in the Preview will almost certainly be reproduced on your CNC machine. 

Save the Toolpaths for your CNC machine 
• After choosing the appropriate Postprocessor from the list, the toolpaths can be saved in a 

format which is ready for your CNC to cut. Depending on the toolpaths calculated and the 
options  the Postprocessor/CNC you are using supports, you may be able to save a single file 
or it may need multiple files to be saved – one for each tool type.  
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All the stages will be covered in the supplied Tutorial videos that cover Machining. It should be 
noted Stages 1 and 2 are done through icons already covered from the Drawing and Modeling Tabs. 
Stages 3 to 6 use icons from the Toolpath Tab (on the right hand side of the screen). These will be 
covered in the next section.  
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The Toolpath List 
The Toolpath List is located at the top of the Toolpath Tab (toggle tab visibility using Short Cut key 
F12). Below you can see an image of this: 

 

This area displays in a list the name of each calculated toolpath with a check-box to turn the visibility 
of the toolpath in the 3D View on and off. The icon next to the check-box shows the type of tool 
selected for that particular toolpath.  

Double clicking the name of any of the toolpaths will open up the toolpath strategy window for that 
toolpath and allow edits to be made to it.  

The up and down arrow icons to the right of the window   allow the user to move a 
toolpath up and down in the list. This will affect the order the Toolpaths are previewed in and if 
multiple toolpaths are saved as a single file then this will be the order that the machine cuts them in. 

You can adjust the space available for the Toolpath list by clicking and dragging the divider that 
separates the Toolpath List from the Toolpath Operations section, up or down. 

Show 2D Previews 
Toggles the visibility of the Toolpaths 2D Previews in the 2D View on and off 

Solid 
Displays the 2D Previews in a solid color so the area cut by the toolpath can be easily seen. 

Floating Toolpath List 

Clicking the Toggle Display of Toolpath Manager Dialog icon  in the bottom Right corner of the 
Toolpath List opens the floating Toolpath Control window (as shown below). This provides a 
resizable Toolpath List window that can be dragged around the interface to a more convenient 
position if required.  
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The names of the Toolpaths can be changed in this dialog without having to re-calculate the 
toolpath. 

 

 

Notes 
Notes can be attached to an individual toolpath and output into the toolpath file using the 
[TOOLPATH_NOTES] variable in the post-processor configuration file. 
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Toolpath Operations 
The Toolpath Operations icons are immediately below the Toolpath List on the Toolpath Tab. These 
icons are shown in the image below and a description of each icon and function associated with it is 
below that.  

 

 
Basic Toolpaths 

 
VCarving & 2.5D Toolpaths 

 
3D Toolpaths 

 
Toolpath Editing Tools 

 
The Tool Database 

 
Toolpath Templates 

 
Toolpath Tiling 

 
Previewing Toolpaths 

 
Estimated Machining Times 

 
Saving Toolpaths 

 
Switch to Drawing Tab 
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Basic Toolpaths  
The basic toolpaths section of the Toolpath Operations icons can be found on the Toolpaths tab, 
underneath the Toolpath list. It includes the Material setup command, which will often need to be 
used before any toolpaths are created. This section also includes Profiling, Pocketing and Drilling 
strategies. The final icon in this section is the Quick Engrave strategy, which is specialist strategy for 
some engraving machines. 

 
Material Setup 

 
Profile Toolpath 

 
Pocketing Toolpath 

 
Drilling Toolpath 

 
Quick Engraving Toolpath 
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Material Setup 
 This command opens the Material 
Setup form that is used to specify the 
Material Thickness, Z Zero origin, 

Model Position, Rapid clearance gap and Home 
position. 

Material 

Z Zero 
Select relative to the Material Surface or 
relative to the Machine Table / Bed. This 
is a very important setting because the 
Tooling used on the CNC machine must 
be setup in the same way, ensuring the 
toolpaths cut to the correct depth. 

Thickness 
Enter the thickness of the material 
being machined. 

Model Position in Material 
The position of the 3D Model within the 
material is determined in this section of the 
form. If the model is higher than the thickness 
of the material an error will be displayed with 
this message and the user must either set a 
Material Thickness (see above) the same or 
larger than the model thickness or use the Scale 
Model height icon from the modeling tools to 
scale the 3D model to be lower than the material that is going to be used.  

If the model is thinner than the material then the slider can be used to interactively move the model 
up and down within the material. The Gap above and below fields will update to reflect the model 
being moved. The model is shown in light brown and the excess material thickness above and below 
is shown in a darker brown color.  

Gap Above Model 
Checking this option and typing in a value here will add a specific amount of material above 
the highest point of the model.  

Gap Below Model 
Checking this option and typing in a value will leave a specific amount of material below the 
lowest point in the model.  
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Rapid Z Gaps above Material 

Clearance (Z1) 
This is the height above the job at which it is safe for the cutter to move at rapid or 
maximum federate. The software will raise the bottom of the cutter to this height when it 
traverses the material. 

Plunge (Z2) 
For all toolpaths, as well as specifying a rapid clearance gap for rapid positioning moves 
above the workpiece, the user can also specify a much smaller gap that the tool will rapid 
down to during plunge moves. 
By default the plunge gap is set to the same value as the Clearance gap which means that 
there will be no rapid plunges. If you set the plunge gap to a smaller value than the 
Clearance gap, the tool will plunge at rapid federate to the specified distance above the 
material surface before changing to the specified plunge rate. For jobs where a large value 
for Clearance gap has to be specified to avoid clamps etc, this feature  can save a 
considerable amount of machining time if there are a lot of plunge moves in the job. Setting 
a value of 0.0 for the plunge gap will also disable this feature. 

Note: Some engraving machines are not able to take advantage of this feature. 

Home / Start Position 
This is the absolute position that the tool will start moving from and where the tool can be 
programmed to return to at the end of cutting the job. 
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Profile Toolpath 
Profile Machining is used to cut around 
or along a vector. Options provide the 
flexibility for cutting shapes out with 

optional Tabs / bridges plus an Allowance 
over/undercut to ensure perfect edge quality. 

Profile toolpaths can be outside, inside or on the 
selected vectors, automatically compensating for 
the tool diameter and angle for the chosen cut 
depth.  

When working with open vectors the profile 
toolpaths can be to the Left, to the Right or On 
the selected vectors. 

Clicking this icon opens the 2D Profile Toolpath 
form which is shown at the right; the functions in 
this form are described on the following pages. 

If you have vectors which are nested (like the 
letter ‘O’), the program will automatically 
determine the nesting and cut the correct side 
of the inner and outer vectors. In addition, the 
program will always cut the inner vectors before 
the outer vectors to ensure the part remains 
attached to the original material as long as 
possible. 

Cutting Depths 

Start Depth (D) 
Specifies the depth at which the Profile 
toolpath is calculated. When cutting 
directly into the surface of a job the Start 
Depth will usually be 0. If machining into 
the bottom of an existing pocket or 
stepped region, the depth of the pocket / 
step must be entered. 

Cut Depth (C) 
The depth of the profile toolpath relative to the Start Depth. 

Tool 
Clicking the Select button opens the Tool Database from which the required tool can be selected. 
See the section on the Tool Database for more information on this. Clicking the Edit button opens 
the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without 



 

 
162 Navigation Homepage 

 
 

changing the master information in the database. Hovering the mouse cursor over the tool name will 
display a tool tip indicating where in the tool database the tool was selected from. 

Machine Vectors… 
There are 3 options to choose from to determine how the tool is positioned relative to the selected 
vectors/s. 

Outside 

 

Calculates a profile toolpath around the Outside of the selected vectors, 
with options for the cut direction to be either, 
Climb (CW) cutting direction  or Conventional (CCW) cutting direction 

Inside 

 

Calculates a profile toolpath around the Inside of the selected vectors, 
with options for the cut direction to be either; 
Climb (CCW) cutting direction or Conventional (CW) cutting direction 

On 

 

Calculates a profile toolpath around the On the selected vectors, with 
options for the cut direction to be either, 
Climb (CW) cutting direction or Conventional (CCW) cutting direction 

 

Direction 
Can be set to either Conventional or Climb machining where the cutting direction depends upon the 
strategy selected - see above for details. Using Climb or Conventional cutting will largely be dictated 
by the material is being machined and the tooling. 

Allowance offset 
An Allowance can be specified to either Overcut (negative number will cut smaller) or Undercut 
(positive numbers will cut larger) the selected shape. If the Allowance = 0 then the toolpaths will 
machine to the exact size. 

Use vector start point 
Use Start Point can be selected to force the toolpath to plunge and start cutting at the first point on 
the shape. This is very useful if you need to ensure the cuter doesn't plunge onto a critical part of the 
job. For example, setting the Start Point to be on a corner will often be the best position to plunge 
and cut from as this will not leave a witness / dwell mark on the machined surface. 

The Start Points are displayed as Green boxes on all vectors when this option is selected. Start Point 
on a vector can be moved using the Node Editing Tools. Select Node Editing cursor or press N. Place 
the cursor over the node to be used as the Start Point. Click Right mouse button and select Make 
Start Point (or press P) Remember, you can also insert a new point anywhere on a vector using the 
Right mouse menu or pressing the letter P – this will insert a new point and make it the start point.  

Note: Selecting Use Start Point may result in less efficient toolpaths (increased cutting times) 
because it may take the machine longer to move between each shape being cut. If this option is not 
selected the software will try to calculate the shortest toolpath, minimizing the distance between 
link up moves. But the downside is that the cutter may plunge/mark important surfaces on the 
machined edge. 



 

 
163 Navigation Homepage 

 
 

Tabs, Leads. Ramps, Order and Corners 
For details of these options see the Profile Options section. 

Safe Z 
The height above the job at which it is safe to move the cutter at rapid / max feedrate. This 
dimension can be changed by opening the Material Setup form. 

Home Position  
Position from and to that the tool will travel before and after machining. This dimension can be 
changed by opening the Material Setup form. 

Project toolpath onto 3D Model 
This option is only available if a 3D model has been defined. If this option is checked, after the 
toolpath has been calculated, it will be projected (or ‘dropped’) down in Z onto the surface of the 3D 
model. The depth of the original toolpath below the surface of the material will be used as the 
projected depth below the surface of the model. 

Vector Selection 
This area of the toolpath page allows you to automatically select vectors to machine using the 
vector’s properties or position. It is also the method by which you can create Toolpath Templates to 
re-use your toolpath settings on similar projects in the future. For more information, see the 
sections Vector Selector and Advanced Toolpath Templates. 

Name 
The name of the Profile toolpath can be entered or the default name can be used. 
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Profile Options 
The Profiling options section of the toolpath form contains five additional pages, each of which 
allows a particular set of Profile machining options to be specified. The precise number of option 
pages will depend on which Toolpath strategy you are currently using. The full range of option pages 
are: 

• Tabs 
• Leads 
• Ramps 
• Order 
• Corners 

These help control ways to ensure the parts are held in place and machined as easily as possible 
while ensuring the highest quality edge finish. 

Each set of option can be accessed by the tabs at the top of the Profile options section. 

  
 

In general, each option is enabled by a checkbox at the top of its page. You must check this box 
before the option’s parameters will become available for editing. 
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Tabs (Bridges) 
Tabs are added to open and closed vector shapes 
to hold parts in place when cutting them out of 
material.  

Add tabs to toolpath 
Checking the Add tabs option will activate tab 
creation for this toolpath. The Length and 
Thickness specify the size of each tab. Checking 
the Create 3D Tabs option will create 3D Tabs, the 
difference between this and 2D Tabs is described 
below.  

Create 3D Tabs 
When this option is selected the tab will be triangular in section. This is shape is created as 
the cutter ramps up to the specified Tab Thickness then down the other side. The 3D Tabs 
will often allow the machine to run quicker and smoother because it does not have to stop 
to move in Z at the start and end of each tab. 

  
3D Tabs option selected 3D Tabs option not selected 

 
If this option is unchecked, the 2D tabs will be used. The cutter stops at the start point for 
each tab, lifts vertically by the specified Thickness runs across the ramp, stops and plunges 
down the other side. 

 
This image shows how the Length and Thickness values are used when creating 3D and 2D tabs. 
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Edit Tabs 
Clicking on the Edit Tabs…  button automatically opens the 2D window and the Toolpath Tabs form 

is displayed. 

Add Tabs 

Constant Number 
Calculates the length of each selected 
vector and places 'X' number of equally 
spaced Tabs around the shape  

Constant Distance between tabs 
This option places a tab at the specified 
distance around the selected shape.  
If placing Tabs at the Distance around the 
shape results in fewer than the Min number, 
the minimum number of Tabs are 
automatically equally placed on the shape.  
If the number of tabs calculated using the 
Distance around the shape is greater than 
the specified Max number, the Max number 
are placed at equal distance around the 
shape.  

First tab at machining start point 
If checked, a Tab will be placed at the start point 
(Green node) of a vector when the option First Tab 
at Machining Start Point is selected.  

Dynamically positioning tabs in the 2D View 
Interactive Tab positioning is very easy. Simply place 
the cursor at the point where the Tab is required 
and click the Left mouse. To Move a Tab, Click and Drag with the Left mouse button on a Tab to 
move. 

To Delete a Tab, place the cursor over an existing tab and click the left mouse button. 

Note: The best place to put Tabs on a part is on the flat areas so they can easily be removed and 
tidied up.  

The quickest method for adding Tabs to multiple shapes is to use the automatic option to add 'X' 
number. The position of these can then very easily be modified by clicking and dragging to move 
tabs to the 'best positions' and also delete unwanted tabs. 
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Leads 
Lead in / out moves can be added to profile toolpaths to help preventing marking the edges of 
components with dwell marks that are typically created when a cutter is plunged vertically on the 
edge of the job. 

 

Straight Line Lead 
This option creates a linear lead onto the cutterpath using the Angle and Lead length distance 
specified. 

 

The toolpath will lead onto the selected edge at the 
specified Angle. 

Checking the Do lead out option results in an exit 
lead being added at the end of the toolpath off the 
machined edge. 

The Overcut Distance forces the cutter to machine 
past the start point and is often used to help produce 
a better edge quality on parts. 

Circular Lead 
This option creates an arc lead onto the toolpath using the Radius and Lead length distance 
specified. 

 

The toolpath will curve onto the selected edge, 
tangent to the direction of the vector at the point it 
reaches the actual geometry edge. 

Checking the Do lead out option results in an exit 
lead being added at the end of the toolpath off the 
machined edge. 

The Overcut Distance forces the cutter to machine 
past the start point and is often used to help produce 
a better edge quality on parts.  
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Ramping 
Ramp moves are used to prevent the cutter from plunging vertically into the material. The cutter 
gradually cuts at an angle dropping into the material significantly reducing cutter wear, heat build-up 
and also the load on the router spindle and Z axis of the machine. If multiple passes are required due 
to the Pass Depth being less than the Cut Depth, the ramp moves are applied at the start of each 
level. All ramp moves are performed at the plunge rate selected for the current tool. 

Smooth 
This option creates a smooth ramp into the 
material using either the specified Distance 
or Angle.  
When a Lead In distance has been specified, 
the option Ramp on Lead In disables the 
distance and angle options and automatically 
limits the ramp moves to only be on the lead 
in portion of the toolpath. 
 

Zig Zag 
This option ramps into the material by Zig-Zag backwards and forwards using either the 
specified Distance or Angle.& Distance.  
The Distance option ramps into the material, zigging for the specified distance in one 
direction then zagging back over the same distance.  
The Angle option is typically used for cutters that cannot plunge vertically but have an entry 
angle specified by the manufacturer. 

Spiral 
Checking this creates a continual spiral ramp, these are only available when the toolpath 
does not include lead in moves.  
This option ramps into the material over the complete circumference of the profile pass. The 
angle is automatically calculated to ramp from the start point to full depth over the 
perimeter distance around the job.  
The rate at which the cutter ramps into the material is determined by the Pass Depth 
specified for the cutter. For example, Spiral Profiling 0.5” deep with a cutter that has a Pass 
depth of 0.5 or greater will spiral down in 1 pass. Editing the Pass depth to be 0.25” results in 
the 2 spiral passes around the profile. 
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Order 
The order tab allows you to specify the approaches the program will use to determine the best order 
to cut your vectors. You can specify multiple options, in which case the program will calculate the 
result of using each option and select the one which results in the shortest machining time. 

Vector Selection Order 
This option will machine the vector sin the order in which 
you selected them. If you have vectors inside each other 
(like in the letter ‘O’ ), the inner vector will always be 
machined before the outer one regardless of the 
selection order. 

Left to Right 
This option will join up parts on the left of the material 
first and move across to the right. 

Bottom to Top 
This option will join up parts on the bottom of the material first and move up to the top. 

Grid 
This option will join use a grid based approach with the size of the grid based on the size of 
the parts. The algorithm will try to join up parts within a particular section of the grid before 
moving on. 

Shortest Path 
This option use a ’shortest path’ algorithm to try and determine the shortest possible path. 
However, for large numbers of parts this requires an unfeasible amount of computing power 
so an approximation algorithm is used. Although very good, this algorithm cannot guarantee 
to produce the very shortest path, but in tests at Vectric, the results have been very good 
indeed.  This option still takes a substantial amount of time on slow computers of for very 
large numbers of parts. 
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Corners 
Choosing this tab and checking the option Sharp 
external corners (see below) forces the cutter to 
machine around the shapes and retain any square 
corners.  

Sharp External Corners 
This option makes adding beveled edges to a 2D 
shape very quick and easy, this can be a good way 
to turn simple 2D cut out lettering into a high 
quality signage products that look more interesting 
or provide a different option for customers.  

This is an example of the type of effect that can be created by using this option: 

 

Standard Profile toolpaths without the Sharp Corners switched on roll around the sharp corners. This 
Still give a point on a straight sided tool but will give a radiused edge when using a V-bit.  

 

When Sharp External Corners is selected the following change is made to the toolpath (see image 
below) so it makes sharp external corners as shown in the image of the letter ‘M’ at the top of the 
page.  
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Sharp Internal Corners 
 When Sharp Internal Corners is selected the tool will raise up into internal corners to sharpen them 
with its point. The difference between checking this and leaving it unchecked is shown in the two 
images below. 

  
Sharp Internal Corners not selected Sharp internal corners selected 

Allowance for Cut out tool 
Sharp internal corners are often used when creating beveled letters. In this case, the letters usually 
have straight ‘returns’ which are machined with a straight sided end mill. The cut out pass for the 
end mill needs to be offset from the vector to allow for the bevel created by the tool. This field 
displays the value you will need to enter into the ‘Allowance Offset’ field when you create your cut 
out profile toolpath for the end mill. You can select the value with the mouse and used Ctr+C to copy 
it to the clipboard and then copy it into the ‘Allowance Offset’ field when you create the cut out 
toolpath. 

 

 



 

 
172 Navigation Homepage 

 
 

Additional notes on Profile Machining –  

Machining Open Vectors 
The direction of open vector(s) is very important when using Profile strategies as this is used to 
determine which side of the selection is the right and left for machining. Selecting Node Edit mode 
(pressing N on the keyboard) will display a Green node at the start of the vector. Looking along the 
vector(s) from the green node indicates the direction and the image below shows offsets to the left 
and right of an open vector.  

The Cut Direction - Conventional or Climb controls which end of the open vector the toolpath will 
start. Changing the cut direction will reverse the direction of cut. 

• Conventional starts cutting at the Start point 
• Climb cutting starts cutting at the end point  

 A graphic is shown below to demonstrate this.  

 

Profile machining to the Left of the vector using Climb cutting 
(vector is pink dotted line – other line with arrows shows the 
toolpath). 

 

Profile machining to the Left of the vector using Conventional 
cutting (vector is pink dotted line – other line with arrows 
shows the toolpath).  

Talk to your material and tooling suppliers for details about what is most appropriate for your 
specific type of work.  

• Tabs can be added to open profile toolpaths 
• Sharp External Corner options do not apply because identifying the outside / inside of an 

open shape in ambiguous. 
• Leads cannot be added to open profile toolpaths. 
• Ramps can be added to open profile toolpath. 
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Pocketing Toolpath 

 This option opens the Pocket Toolpath form 
for machining 2D pockets. These toolpaths 
automatically compensate for the tool geometry – 
both diameter and angle. 

Cutting Depths 

Start Depth (D) 
Specifies the depth at which the pocket 
toolpath is calculated. When cutting directly 
into the surface of a job the Start Depth will 
usually be 0. If machining into the bottom of 
an existing pocket or stepped region, the 
depth of the pocket / step must be entered. 

Cut Depth (C) 
The depth of the toolpath relative to the 
Start Depth. 

Tool 
Clicking the Select button opens the Tool Database 
from which the required tool can be selected. See 
the section on the Tool Database for more 
information on this. Clicking the Edit button opens 
the Edit Tool form which allows the cutting 
parameters for the selected tool to be modified, 
without changing the master information in the 
database. 

Use Larger Area Clearance Tool 
If this option is selected two tools are used to clear 
the pocket. A large tool to do the bulk of the area 
clearance and a smaller tool (the first tool selected) 
to remove the remaining material and do a final 
profile pass. 
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Clear Pocket 
There are two choices of the type of “fill pattern” that will be used to clear away the area to be 
machined with the Pocket Toolpath, Offset and Raster. 

  
Clear Pocket – Offset Strategy Clear Pocket – Raster Strategy 

Offset 
Calculates an offset area clearance fill pattern to machine inside the selected 
vector(s). 

 
 Options for Cut Direction to be either: 

• Climb (CCW) cutting direction 
• Conventional (CW) cutting direction 

Raster 
Calculates a Raster based area clearance fill pattern to machine inside the selected 
vector(s). 

 
Cut Direction for the final pass to be either: 

• Climb (CCW) cutting direction  
• Conventional (CW) cutting direction 

Raster Angle 
Between 0 and 90 degrees, where 0 degrees is parallel to the X axis and 90 degrees parallel 
to the Y axis.  

Profile Pass 
Used to clean up the inside edge after machining the pocket. This can be done either before 
the rastering (First) or after the rastering (Last). If ‘No Profile Pass’ is selected, you will need 
to calculate a profile pass manually to machine the pocket to size. 

Pocket Allowance 
This option is used to leave material on the inside of the pocket for the Profile Pass to clean-
up. This is often very useful for ensuring the cutter does not mark the edge surface of the 
pocket when roughing out.  
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Note: When stepover for a pocket fill is greater than 50% of the cutter/tip diameter are used the 
software automatically adds 'Tail' moves the corner regions on toolpaths to ensure material is not 
left on the job. You can see these in the diagram of a star being pocket machined below: 

  
Offset larger than 50% Tails to clean out corners 

Ramp Plunge Moves 
The cutter can be ramped over a distance into the pocket instead of plunging vertically. This 
approach reduces heat build-up that damages the cutter and also reduces the load on the spindle 
and z axis bearings. 

Use Vector Selection Order 
If this option is checked, pockets will be machined in the order you selected them. If the option is 
not checked the program will optimize the order to reduce machining time. 

Safe Z 
The height above the job at which it is safe to move the cutter at rapid / max federate. This 
dimension can be changed by opening the Material Setup form. 

Home Position 
Position from and to that the tool will travel before and after machining. This dimension can be 
changed by opening the Material Setup form. 

Safe Z 
The height above the job at which it is safe to move the cutter at rapid / max feedrate. This 
dimension can be changed by opening the Material Setup form. 

Home Position 
Position from and to that the tool will travel before and after machining. This dimension can be 
changed by opening the Material Setup form. 

Project toolpath onto 3D Model  
This option is only available if a 3D model has been defined. If this option is checked, after the 
toolpath has been calculated, it will be projected (or ‘dropped’) down in Z onto the surface of the 3D 
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model. The depth of the original toolpath below the surface of the material will be used as the 
projected depth below the surface of the model. 

projected depth below the surface of the model. 

Vector Selection 
This area of the toolpath page allows you to automatically select vectors to machine using the 
vector’s properties or position. It is also the method by which you can create Toolpath Templates to 
re-use your toolpath settings on similar projects in the future. For more information, see the 
sections Vector Selector and Advanced Toolpath Templates. 

 

Name  
The name of the toolpath can be entered or the default name can be used. 
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Drilling Toolpath 
 Drilling allows the centers of selected 
closed vectors to be drilled to a specified 
depth. The Tool database includes an 

option to specify the Drill diameter and cutting 
parameters. 

Cutting Depths 

Start Depth (D) 
This specifies the depth at which the toolpath 
is calculated from. When cutting directly into 
the surface of a job the Start Depth will often 
be 0. If machining into the bottom of an 
existing pocket or 3D region, the depth needs 
be entered.  

Cut Depth (C) 
The depth of the toolpath relative to the Start 
Depth. 

Tool 
Clicking the Select button opens the Tool Database 
from which the required tool can be selected. See the 
section on the Tool Database for more information 
on this. Clicking the Edit button opens the Edit Tool 
form which allows the cutting parameters for the 
selected tool to be modified, without changing the master information in the database. 

Peck Drilling 
When the option for Peck Drilling is selected, the drill will cut to the Pass Depth set in the Tool 
database for the selected Drill. Then retract to the Retract Gap above the surface and then continue 
drilling to an additional Pass Depth. This cycle is repeated until the hole is drilled to the required 
depth. The retract moves are used to remove any build-up of material from the hole to help with 
overheating and breakage. If the Pass Depth is greater than the required Cut Depth, the hole will be 
drilled in a single cycle. However, if a Cut Depth of 1" with a Pass Depth of 0.25" is used the hole will 
be drilled in 4 cycles. 

Use Vector Selection Order 
If this option is checked, pockets will be machined in the order you selected them. If the option is 
not checked the program will optimize the order to reduce machining time. 

Safe Z 
The height above the job at which it is safe to move the cutter at rapid / max feedrate. This 
dimension can be changed by opening the Material Setup form. 
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Home Position 
Position from and to that the tool will travel before and after machining. This dimension can be 
changed by opening the Material Setup form. 

Project toolpath onto 3D Model 
 This option is only available if a 3D model has been defined. If this option is checked, after the 
toolpath has been calculated, it will be projected (or ‘dropped’) down in Z onto the surface of the 3D 
model. The depth of the original toolpath below the surface of the material will be used as the 
projected depth below the surface of the model. 

Vector Selection 
This area of the toolpath page allows you to automatically select vectors to machine using the 
vector’s properties or position. It is also the method by which you can create Toolpath Templates to 
re-use your toolpath settings on similar projects in the future. For more information, see the 
sections Vector Selector and Advanced Toolpath Templates. 

Name 
The name of the toolpath can be entered or the default name can be used. 
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Quick Engraving Toolpath 
 This form is used specifically for calculating 
engraving and marking toolpaths. 

Tool 
Clicking the Select button opens the Tool Database 
from which the required tool can be selected. See the 
section on the Tool Database for more information on 
this. Clicking the Edit button opens the Edit Tool form 
which allows the cutting parameters for the selected 
tool to be modified, without changing the master 
information in the database. 

Depth / Pressure 
When using Conventional Engraving and End Mill 
cutters the Depth to engrave / mark is specified and 
this z depth dimension is output in the toolpath file 
sent to the CNC machine. The 3D Preview of these 
toolpaths shows the specified depth of engraving.  

When using a Diamond Drag marking Tool the 
Pressure setting is used to pre-load the spring to 
ensure the tip of the diamond stays in contact with 
the material surface, especially when marking uneven 
surfaces. The 3D Preview of the depth these toolpaths 
will mark using the Angle of the diamond and the 
Width of the Line. 

For example; When using a 90 degree Diamond Drag 
Tool with a 0.010" Line Width specified. The depth 
shown in the 3D preview will be 0.005" (with 90 
degrees the depth = half the line width).  
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The ratio of Depth to Line Width will change when using diamond drag tools with different tip 
angles. When the option to use a Nose Cone is selected (see below) the actual depth specified on 
the form is used when previewing the toolpath in the 3D view. 

Strategy 
When using the Quick Engraving Form the Stepover for the cutter is specified on the form and is NOT 
automatically set from the tool database. 

The selected text or vectors can be Outlined or Filled. 

Outline  
The tip of the cutter runs on the selected lines engraving / marking the material surface 

 

Example of outline engraving 

Fill 
A pattern is used to engrave / mark inside the selected text or vectors. There are 3 fill pattern 
options. 
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Fill engraving with Offset pattern 

 

Fill engraving with 45 degree Hatch pattern 

 

Fill engraving with Cross Hatch pattern 

Cross Hatch Fill pattern engraves 2 sets of lines, with the second set at 90 degrees to the angle 
specified. 

Use Nose Cone   
A nose cone is often used when engraving or marking material that is not flat. The nose cone is 
spring loaded forcing it to slide on the surface of the material. The engraving cutter is set to extend / 
protrude out of the bottom of the nose cone by the depth of engraving / marking required. This is 
typically set at around 0.010" to 0.020". 

When the option to use a Nose Cone is selected the actual depth specified on this region of form is 
used when previewing the toolpath in the 3D view. 

Number of Passes - This option runs the cutter multiple times divides over the toolpath pattern. 

Output Options  
Select the appropriate postprocessor and Save the Toolpath ready to send to the CNC machine. 

If your machine can be driven using a Windows Printer driver (Roland and Gravograph / New Hermes 
machines use this technique) it maybe be possible to select the installed printer driver and output 
toolpaths directly from the software instead of saving an intermediate file. 
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Checking the option “Output direct to machine” enables the Device option which is used to setup 
the appropriate windows printer driver. 
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VCarve 
Toolpath 

Fluting 
Toolpath 

Texturing 
Toolpath 

Prism 
Carving 
Toolpath 
Inlay 
Toolpaths 

VCarving & 2.5D Toolpaths 
The VCarving & 2.5D toolpaths section of the Toolpath Operations icons can be found on the 
Toolpaths tab, underneath the Toolpath list. These strategies all make use of the tool’s geometry to 
form a number of intricate 3D shapes very efficiently. Because the range of 3D shapes that can be 
formed are determined by the tool’s own shape, you cannot use these strategies to cut any arbitrary 
3D shape. Therefore, to distinguish them from true 3D strategies they are often referred to as 2.5D 
strategies. 

 
VCarve Toolpath 

 
Fluting Toolpath 

 
Texturing Toolpath 

 
Prism Carving Toolpath 

 
Inlay Toolpaths 
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VCarve Toolpath 
 This icon opens the V-Carving Toolpath 
form which is used to specify the type 
of carving required, tooling details, 

cutting parameters and name for the toolpath. 

Cutting Depths 
Start Depth (D) specifies the depth at which the 
vcarving toolpath is calculated, allowing VCarving / 
Engraving to be machined inside a pocket region. 
When cutting directly into the surface of a job the 
Start Depth will usually be 0.0. If the vcarving / 
engraving is going to be machined into the bottom 
of a pocket or stepped region, the depth of the 
pocket / step must be entered. For example, to 
carve or engrave into the bottom of a 0.5” deep 
pocket, the Start Depth = 0.5”  

Flat Depth (F) 
Checking this option limits the depth that the 
tool(s) will machine to, and is used for Flat 
Bottomed Carving and Engraving. 

When No Flat Depth specified the toolpath will be 
calculated to carve or engrave to full depth as 
shown below. Multiple z level passes will be 
automatically calculated where the tool needs to 
cut deeper than its Pass Depth specified in the 
Tool Database. 
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No Flat Depth  

Single tool machines the 
complete job.  

Multiple z level passes 
calculated using the Pass 
Depth specified for the 
selected tool.  

Clicking the option for Flat Depth and entering the required depth will result in flat pocket areas 
being machined where the width between vectors would result in the tool cutting deeper than the 
specified Flat Depth. 

 

 

 

Flat Depth 

Complete toolpath is 
calculated using a single V-
Bit or Engraving tool.  

 

Flat Depth Using 2 Tools 

End Mill to create the flat 
pocket regions followed by 
V-Bit or Engraving tool to 
cut the detail and corner 
regions  

V Tool 
Clicking the Select button opens the Tool Database from which the required VCarving or Engraving 
Tool can be selected. See the section on the Tool Database for more information on this. 

Clicking the Edit button opens the Edit Tool form which allows the cutting parameters for the 
selected tool to be modified, without changing the master information in the database. Note that 
Ball nosed tools can also be used to vcarve designs. 

Use Flat Area Clearance Tool   
Check this option if you wish to use an End Mill, Ball Nose or Engraving cutter to machine the large 
open regions of a design. Note that this option is only available when Flat Depth is selected. If no 
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tool is selected here but Flat Depth is specified then the selected VCarving tool will be used to clear 
the flat areas as well as for the VCarving. 

Clicking the Select button opens the Tool Database from which the required End Mill or Engraving 
Tool can be selected. 

Clicking the Edit button opens the Edit Tool form which allows the cutting parameters for the 
selected tool to be modified, without changing the master information in the database.  

Flat Area Clearance  
This section of the form allows you to choose the strategy which will be used to clear the flat 
bottomed area with the Flat Area clearance tool. These options are the same as those found on the 
pocketing form. 

Ramp Plunge Moves  
If this option is selected ramps are added to the plunge moves for the pocketing toolpath. 

Use Vector Selection Order 
If this option is checked, the vectors will be machined in the order you selected them. If the option is 
not checked the program will optimize the order to reduce machining time. 

 Safe Z 
The height above the job at which it is safe to move the cutter at rapid / max feedrate. This 
dimension can be changed by opening the Material Setup form. 

Home Position 
Position from and to that the tool will travel before and after machining. This dimension can be 
changed by opening the Material Setup form. 

Project toolpath onto 3D Model 
This option is only available if a 3D model has been defined. If this option is checked, after the 
toolpath has been calculated, it will be projected (or ‘dropped’) down in Z onto the surface of the 3D 
model. The depth of the original toolpath below the surface of the material will be used as the 
projected depth below the surface of the model. 

Vector Selection 
This area of the toolpath page allows you to automatically select vectors to machine using the 
vector’s properties or position. It is also the method by which you can create Toolpath Templates to 
re-use your toolpath settings on similar projects in the future. For more information, see the 
sections Vector Selector and Advanced Toolpath Templates. 

Name 
The name of the toolpath can be entered or the default name can be used. Note that two toolpaths 
will be calculated if an Area Clearance Tool is used and the toolpath for the End Mill will have the 
word Pocket appended to the specified name. 
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Fluting Toolpath 
Fluting Toolpaths machine along vectors while varying the depth of the tool, creating 
extremely efficient machined decorative patterns. 

This toolpath is similar to the option to Profile “On” a selected vector.  The difference is 
the toolpath at the end of each vector can be ramped to taper the cut. This can be used for cutting 
standard woodworking “Flutes” or can be used for artistic engraving and marking effects with other 
types of artwork. It can also be used to create some interesting effects when projected onto a 3D 
model. In this section the options on the form will be covered along with some examples of the use 
for different applications. 

When the Fluting Toolpath form is open, the selected vectors will have their start points indicated in 
the 2D View by solid square green nodes, this is important as it will determine which end the ramps 
are added depending on what options are chosen on the form. An image of this is shown below 
where all the start points are to the left end of the selected vectors. 

If you need to move the start points, go into node editing mode (press ‘N’ on the keyboard or select 
the node editing icon in the ‘Edit Vectors’ section on the left tab).   

  

• Select the vector you want to change the start point  
• Move the cursor over the end you want to be the new start point 
• Press ‘P’ on the keyboard or Right Click and select ‘Make Start Point’ from the pop-up menu. 
• Exit node edit mode (press ‘N’ again) 
• Reselect all the vectors you want to flute 

The fields on the form are as follows. 

Cutting Depths 

Start Depth (D)  
This specifies the depth at which the Fluting toolpath is calculated. When cutting directly 
into the surface of a job the Start Depth will usually be 0. If machining into the bottom of an 
existing pocket or stepped region, the depth of the pocket/step that you are starting from 
must be entered.  

Flute Depth 
This is the depth of the Fluting toolpath relative to the Start Depth; the total depth will be 
the combination of the Start and Flute Depth. 
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Tool 
Clicking the Select button opens the Tool Database from which the required tool can be selected. 
See the section on the Tool Database for more information on this. Clicking the Edit button opens 
the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without 
changing the master information in the database. 

Flute Type 

Ramp over complete length 
Checking this option means the tool will 
ramp over the whole length of the toolpath. 
At the start of the selected vectors/s it will 
be at the Start Depth and at the end of the 
selected vectors/s it will have cut down to 
the Fluting Depth. 

Ramp at Start 
Checking this option means the tool will 
ramp down only at the start of the vectors to 
the Fluting Depth. The distance of this ramp 
can be specified using the Ramp Length or 
Ramp % options. 

Ramp at Start and End 
Checking this option means the tool will 
ramp down at the start of the vectors then 
will ramp up again at the end of the vectors. 
The distance of these ramps can be specified 
using the Ramp Length or Ramp % options.  

Ramp Length 
Checking this option means that the length 
of the ramp can be set to an exact distance 
entered into the box. The ramp distance is 
measured from the start and the end of the 
vector/s depending what Flute Type you 
have selected. If the distance entered is 
greater than the possible length of the ramp 
then the maximum length will be used, this 
would be the same as choosing Ramp over 
complete length. 
When you choose Ramp at Start it is possible 
to specify a ramp length which is up to the 
length of the vector/s. When Ramp at Start and End is checked, the maximum length 
possible would be half way along the vector/s as after that it would start to ramp up again. 
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Ramp % 
Checking this option means that the length of the ramp can be specified as a percentage of 
the maximum possible ramp length (controlled by the length of the selected vector/s and 
chosen Flute Type). When you use this with Ramp at Start selected then 100% would be the 
whole length of the selected vector/s, the ramp length would be a percentage of this 
distance for each one. When you use this with Ramp at Start and End then 100% would be 
the half length of any of the selected vector/s. The ramp length would be a percentage of 
this “half” length. In this situation using a 50% value would give you a Ramp from the start 
which was ¼ of the vector length and a ramp from the end which was also ¼ of the vector 
length.  

Ramp Type 

Linear 
Selecting the Linear type will create a ramp which is a diagonal line (following the vector) 
from the Start Depth to the Flute Depth. Below you can see a Linear Ramp Type shown from 
the side. This ramp is set to only ramp from the start and to go 50% of the flute length.  

 

Smooth 
Selecting the Smooth type will create a curved ramp (following the vector) from the Start 
Depth to the Flute Depth; this will smoothly transition from the ramp into the full depth of 
cut. You can see an example of this shown in the image below. 

 

Note: In the two images shown above illustrate how multiple passes may be used to get to 
full depth. Multiple passes are generated when the Flute Depth exceeds the Pass Depth 
specified for the selected tool. In these cases the tool will make multiple passes no deeper 
than the Pass Depth of the tool. As you can see from the images the ramps are graduated 
based on how many passes are needed. This ensures that the final pass will always be 
cutting material along its full length to give a nice even finish on the part.  

Use Vector Selection Order 
If this option is checked, the vectors will be machined in the order you selected them. If the option is 
not checked the program will optimize the order to reduce machining time. 

Safe Z 
The Safe Z value defines the distance above the job at which it is safe to move the cutter at 
rapid/max feedrate. This dimension can be changed by opening the Material Setup form. 
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Home Position 
This is the position that the tool will travel to before and after machining. This dimension can be 
changed by opening the Material Setup form. 

Project toolpath onto 3D Model 
This option is only available if a 3D model has been defined. If this option is checked then after the 
toolpath has been calculated, it will be projected (or ‘dropped’) down in Z onto the surface of the 3D 
model. The depth of the original toolpath below the surface of the material will be used as the 
projected depth below the surface of the model. This can be used for some particularly interesting 
effects with the Fluting Toolpath – see below in the Applications section for more information on 
this. 

Vector Selection 
This area of the toolpath page allows you to automatically select vectors to machine using the 
vector’s properties or position. It is also the method by which you can create Toolpath Templates to 
re-use your toolpath settings on similar projects in the future. For more information, see the 
sections Vector Selector and Advanced Toolpath Templates. 

Name 
A name for the Fluting toolpath can be entered or the default name can be used. 

Applications for Fluting Toolpaths 

Standard Straight Flutes  
One of the most common applications for Fluting is straight decorative details using a large radius 
Ball nose tool for columns and posts, such as the one shown in the image below.  

 

Another good application for straight flutes is the markings on a draining board (for Solid Surface 
fabricators) or on a cutting block (for carving meat) such as the one shown below, sloping down to 
allow liquid to be directed.  
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Decorative Artistic Designs 
The fluting can be used to produce some interesting effects with artistic and decorative applications. 
The abstract leaf pattern below left was cut with a V-Bit into a flat surface using single vector lines. 
The leaf veins on the right were engraved into the 3D model using the Project toolpath onto 3D 
model option. 
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Texturing Toolpath 
The 3D Texture Machining functionality 
uses a specialized toolpath algorithm 
and the shape of the tool to generate a 

textured finish on the part. It should be noted this 
is a different technique than creating a 3D texture 
using the 3D model. 

Textures can be calculated inside any selected 
vector boundaries or if nothing is selected the 
complete job size. 

Large Ball nosed cutter and V-Bits typically give the 
best results when using this strategy. 

The texturing options are based on calculating 
random patterns and the variables required may at 
first appear a little complicated. The best way to 
see what effect each variable has on the texture is 
to simply change the numbers, calculate and 
preview the results. It's important to note that the 
toolpath algorithm uses a random combination of 
the variables specified on the texturing form to 
calculate the toolpath. 

Tool 
Clicking the Select button opens the Tool Database 
from which the required tool can be selected. 
Clicking the Edit button opens the Edit Tool form 
which allows the cutting parameters for the 
selected tool to be modified, without changing the 
master information in the database. 

Use selected vectors as pattern 
By default this option is unchecked and the texture 
form will generate a random texture pattern using 
any selected vectors as a clipping area. If this 
option is checked, the currently selected vectors 
will be used as the pattern for the texture and the only options available will be ‘max. Cut Depth’ 
and ‘min. Depth’ to control the depth of the cuts along the selected vectors.  

Texture Settings 

Max. Cut Depth 
The maximum depth any of the carved scallops will be machined to and is specified in the job units.  



 

 
193 Navigation Homepage 

 
 

Min. Depth 
Using the slider this is specified as a percentage (%) of the Max. Cut Depth and controls the 
minimum depth any of the scallops will be machined to.  

For example, with a Max Cut Depth = 0.200" and a Min Cut Depth of 0.050", the depth of 
the carved scallops will range randomly between 0.200" and 0.050". 

Max. Cut Length 
Specifies the maximum length for any of the carved grooves and is specified in the job units. 

  

Min Length 
Using the Slider this is specified as a percentage of the Max Cut Length and controls the 
minimum length any of the carved grooves.  

For example, with a Max Cut Length = 3" and a Min Length of 0.150", the length of the 
randomly carved scallops will range randomly between 3" and 1.5" long. 

 Max. Overlap % 
The percentage (%) of the Max Cut Length that each scallop is allowed to overlap the adjacent 
scallop running along the cutting direction. Where, 1% will result in almost zero overlap of adjacent 
scallops 50% will result in some of the scallops being machined half way over the adjacent scallop.  

Variation 
Using the slider this is specified as a percentage of the Max Overlap. Overlap variation of 
100% = the Max Overlap and random pattern Overlap variation of 1% = No Overlap and an 
almost constant pattern. 

For example, with a Max Cut Length = 1", Max Overlap = 25% and Overlap Variation = 50%, 
the random overlap pattern calculated will range between 0.25" and 0.125". 

Stepover  
The distance between each parallel set of lines of carved scallops. 

Variation 
Using the slider this is the percentage used to randomly change the stepover between each 
scallop. If a variation of 0% is specified the scallops will all be parallel to each other. And a 
variation of 50% will result in some scallops overlapping half way over others. 
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Angle 
The direction the texture is machined across the surface, an angle of zero is parallel to the X axis, 
examples of setting the angle to 45 and 90 degrees can be see below.  

  
45 Degrees 90 Degrees 

Boundary Vector Offset 
If you enter a value in this field, the texturing will be offset from the boundary by the specified 
amount. If you are texturing in a recess, you should enter a value here up to the radius of the tool to 
avoid the walls of the recess being damaged by the tool. 

Safe Z 
The height above the job at which it is safe to move the cutter at rapid / max federate. This 
dimension can be changed by opening the Material Setup form. 

Home Position 
Position from and to that the tool will travel before and after machining. This dimension can be 
changed by opening the Material Setup form. 

Project toolpath onto 3D Model 
This option is only available if a 3D model has been defined. If this option is checked, after the 
toolpath has been calculated, it will be projected (or ‘dropped’) down in Z onto the surface of the 3D 
model. The depth of the original toolpath below the surface of the material will be used as the 
projected depth below the surface of the model. 

Vector Selection 
This area of the toolpath page allows you to automatically select vectors to machine using the 
vector’s properties or position. It is also the method by which you can create Toolpath Templates to 
re-use your toolpath settings on similar projects in the future. For more information, see the 
sections Vector Selector and Advanced Toolpath Templates. 

Name 
The name of the toolpath can be entered or the default name can be used. 
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Note: As Texturing Toolpaths are calculated using a Random combination of the parameters and 
variables listed on the form the toolpath will change very slightly every time a toolpath is calculated. 
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Prism Carving Toolpath 
Prism carving gives a raised ‘bevel’ effect to shapes and letters similar to a ‘hand carved’ 
look. 

Prism Carving uses an angled tool to create a raised prism shape on the top of the 
selected vectors. The tool will profile at a given depth creating a nice sharp finished shape such as 
the lettering shown in the image below. This is often paired with a Profile or Pocket toolpath to 
carve the vertical edge around the shapes or clear out the material between them. This type of 
toolpath is often though not exclusively used on lettering. 

 

Cutting Depths 

Start Depth (D) 
Start Depth (D) specifies the depth at which 
the Prism Carving toolpath is calculated 
from. When cutting directly into the surface 
of a job the Start Depth will often be Z0. If 
machining into the bottom of an existing 
pocket or stepped region, the depth of the 
pocket/step that you are starting from must 
be entered here.  

Prism Depth 
This sets the depth of the Prism Carving 
toolpath relative to the Start Depth, the 
total depth of the base of the prism shape 
(within the material) will be the 
combination of the Start and Flute Depth. 
This depth is particularly important to set 
correctly as if it is too shallow then the 
prism shape may be truncated so it will have 
a flat top (shown in the image below right). 
The minimum depth needed to avoid this is 
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determined by the widest point on the vector/s selected (W) and the angle of the tool (A). 
This can be calculated automatically by using the Set Depth for Full Prism function (see 
below for more details). 

  
 

Set Depth for Full Prism 
For this button to work you both need to select the vectors you plan to toolpath and also 
have selected the tool you are going to use, then when you click it the Prism Depth will be 
set to the minimum required to ensure a full point on the prism for the current 
selection/tool. 

Tool 
Clicking the Select button opens the Tool Database from which the required tool can be selected. 
See the section on the Tool Database for more information on this. Clicking the Edit button opens 
the Edit Tool form which allows the cutting parameters for the selected tool to be modified, without 
changing the master information in the database. 

Note: Prism Carving requires accurate tool sizing and quality, it is essential that the parameters of 
your tooling are measured entered precisely. 

Prism Carving is predominantly cut using a V-shaped cutter, having sharp tooling which is accurately 
sized is very important to getting good results. You should measure your cutters to make sure the 
size and angle of the v-bit are as per the manufacturers specifications as a variation of even 1 or 2 
degrees on the angle can make a big difference to the quality and precision of Prism carved shapes.  

Direction 
Can be set to either Conventional or Climb machining, the choice for this will largely be dictated by 
the material being machined and type of tool being used. See the section on Profile Toolpaths in the 
Reference Manual for more information on the differences between these.   

Use Vector Selection Order 
If this option is checked, the vectors will be machined in the order you selected them. If the option is 
not checked the program will optimize the order to reduce machining time. 

Safe Z 
The Safe Z value defined the distance above the job at which it is safe to move the cutter at 
rapid/max feedrate. This dimension can be changed by opening the Material Setup form. 

Home Position 
This is the position that the tool will travel to before and after machining. This dimension can be 
changed by opening the Material Setup form. 
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Vector Selection 
This area of the toolpath page allows you to automatically select vectors to machine using the 
vector’s properties or position. It is also the method by which you can create Toolpath Templates to 
re-use your toolpath settings on similar projects in the future. For more information, see the 
sections Vector Selector and Advanced Toolpath Templates. 

Name 
A name for the Prism Carving toolpath can be entered or the default name can be used. 
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Inlay Toolpaths 
The Inlay toolpath functionality can be 
used to calculate either profile or 
pocketing toolpaths with automatic 

compensation for the tool radius, this allows the 
cut-out parts to fit into the corresponding cavities. 
This is a great feature for creating decorative 
woodwork and is also particularly useful for sign 
makers for creating inlayed letters and graphics.  

How Inlays work 
When using a CNC machine to cut out shapes then 
the tool will always leave a radius on any internal 
corner. When cutting holes or pockets the tool 
conversely leaves a radius on the external corners. If 
no changes are made to accommodate this then 
there would be no way to fit one part into the other. 
This is shown highlighted on the letter “T” shown in 
the image below. On the left you can see the 
internal corners with a radius on the part being cut 
out (highlighted with red ovals). On the right you 
can see the radiused external corners on the hole 
(highlighted with green ovals). As you can envisage 
trying to slot the “T” into the hole would not work as it is the proverbial square peg in a round hole! 

  
 

It is not possible to avoid the added radius as it is formed by the tool size and shape. The Inlay 
function though, will create toolpaths which take the tool radius into account and compensate for it 
by rounding off the sharp corners so the resulting parts will fit together. This can be seen in the 
images shown below where the same letter has been cut using the Inlay toolpaths, you can see all 
corners (internal and external) now have the same radius so they will slot together. 
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When creating an Inlay toolpath the radius is automatically compensated for, so it is very important 
to make sure you specify the same tool for both parts of any inlay (male and female). If you do not 
do this the Inlay will not fit together. If creating a Pocket then the main Tool (the finish tool) not the 
larger (clearance) tool should be the same as the one as used for creating the Male Inlay. 

Note: You must use the same tool for both parts of an inlay for the resulting parts to fit together 
correctly.  

Male Inlay (Insert) 

Straight 
This option is for cutting out straight sided parts to act as the inserted piece of the inlay. It 
uses a variation on the Profile toolpath which will automatically round the external corners 
of the part to allow for the radius of the tool being used. All the standard Profile options are 
available in this form except there is no option to Profile Inside or On as this does not apply 
to this inlay type as it has to cut outside of the vector. The other standard option not 
available is the ability to add sharp Corners as again this would not apply to this application. 
The image below shows how the external corners are rounded based on the tool radius 
being used. 
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Stepped 
This option is for cutting out stepped sided parts to act as the inserted piece of the inlay. 
This style of inlay is typically used for what are referred to as “Push Through” letters and 
shapes. These are parts which are inserted from the back and use the step as a shelf to 
invisibly mount them to the back of a sign. As with the Straight Inlay option it uses a 
variation on the Profile toolpath with the addition of the ability to specify a Step Depth and 
Step Width. These are defined in the area of the form highlighted in the image below:  

 
As the diagram shows in the form, the Step Depth is the vertical height of the step from the 
Start Depth down, the Step Width is how far from the edge of the original vector the part 
will be cut out (creating the step). 

 
 
The image shown above shows a Stepped Male Inlay created in 1 inch thick material with a 
0.75” Step Depth and a 0.3” Step Width.  
All the other standard Profile options are available for Stepped Inlays except there is no 
option to Profile Inside or On as this does not apply to this inlay type and this option does 
not allow the use of either the Corner or Lead functions as these are also inapplicable to this 
type of toolpath.  
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Note: It is very important when working with Stepped Inlays that you allow enough space 
in between the shapes you are cutting out for the Step Width to be added. If the parts are 
too close then they will not be cut-out and the steps will not be properly formed. 

Female Inlay (Pocket / Hole) 

Pocket  
This option is selected for cutting out a Pocket to act as the cavity for the corresponding 
Male shape to inlay into.  It uses the same options as the standard Pocket style toolpath 
including the new option where you can use a larger and smaller tool to clear the pocket 
(smaller tool size should match that used for the Male Inlay). In order to make it work as an 
inlay pocket any internal corners will be rounded based on the tool radius to allow the male 
parts to fit into them (shown in the image below).  

 
As has been previously discussed it is common to leave an allowance on one or both sides of 
the inlay, typically when working with letters the allowance would be left on the Pocket so 
the size and shape of the lettering itself is not affected any more than necessary.  

Hole 
This option is for cutting out a Hole to act as the cavity for the corresponding Male shape to 
inlay through.  The standard Profile options are available for Female Hole Inlays except there 
is no option to Profile Outside or On as this does not apply to this toolpath type and this 
option does not allow the use of the Corner options as these are also inapplicable to this 
type of toolpath. In order to make it work as an inlay, any internal corners will be rounded 
based on the tool radius to allow the male parts to fit into them (shown in the image below). 
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Setting Inlay Allowances 
Although the radius of the tool is compensated for when using the inlay tool, this in itself will almost 
always not be enough to ensure the two parts will fit together correctly. The parts will be exactly the 
same size and so would not fit together without a lot of force which would damage the part or 
without some kind of post-CNC hand work. Cutting the parts exactly the same size also does not 
allow for any kind of finish to be applied to either side. 

To enable the parts to fit extra material either needs to be cut from the Male side, the Female side 
or in some applications both. This additional distance is added using the option in the toolpath form 
to add an Allowance. On the toolpaths which are based on a Profile then this is done with the 
Allowance Offset (Shown in the image below left – highlighted in red). For Pocket style toolpaths use 
the Pocket Allowance, (shown in the image below right highlighted in red). When a value is entered 
it will overcut the selected shape by this distance, this will reduce the size for male parts and 
increase the hole/pocket for female parts. 
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The size of the Allowance required will depend on the type of material (how much it may expand or 
contract between being cut and inlayed), the accuracy of your tooling, the accuracy of your machine 
and finally any finish you are planning to add to the finished parts (such as paint or varnish which will 
have a thickness). In most situations where no finish is being applied before the parts are inlayed 
then an allowance of 0.01” (0.25mm)  or 0.02” (0.5mm) will be sufficient. If you are not sure what 
value to use then you should experiment with this on a test part to get the correct sizes for your 
particular setup and application. 

In the majority of cases the Allowance is applied to the Female side of the inlay as it is typical to not 
want to alter the actual vector shapes (the Male side) any more than is required for the tool radius. 
This means the Hole or Pocket will be cut over-sized to provide the additional allowance for the 
parts to fit. 
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Rough 
Machining 
Toolpath 

 Finish 
Machining 
Toolpath (3D) 

3D Toolpaths 
The 3D toolpaths section of the Toolpath Operations icons can be found on the Toolpaths tab, 
underneath the Toolpath list. These strategies are capable of cutting any shape that can be 
represented by the composite model. For this reason they are the most flexible machining strategies 
in Aspire, but for a high quality finish they will often require relatively long machining times. 

Note: When deciding how to cut your design it is always worth verifying that a particular 3D effect 
that you are trying to achieve (3D engraved text, for example) cannot be matched closely enough 
using a 2.5D strategy (see VCarving & 2.5D Toolpaths) as these will generally be a lot faster to 
calculate and machine. 

 
Rough Machining Toolpath (3D) 

 
Finish Machining Toolpath (3D) 
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Rough Machining Toolpath (3D) 
 Rough Machining is used when carving 3D parts to clear away excess material when the 
part is too deep for the finishing tool to cut in a single pass. It requires a vector to be 
selected in the 2D view which it will use as 

a boundary to the toolpath. If no vector is selected 
the boundary of the work area will be used. 

Clicking on this icon opens the toolpath form shown 
to the right; the functions available within this are 
described below.  

Tool 
Clicking the Select button opens the Tool Database 
from which the required tool can be selected. See 
the section on the Tool Database for more 
information on this. Clicking the Edit button opens 
the Edit Tool form which allows the cutting 
parameters for the selected tool to be modified, 
without changing the master information in the 
database. 

Machining Allowance  
The machining allowance is a virtual skin which is 
added to the 3D model when the Roughing Toolpath 
is calculated. This ensures that the toolpath leaves 
some extra material on the roughed part. This is 
beneficial for two main reasons, the first is that when 
roughing it tends to be done with relatively large tool 
and aggressive cuts and so is more prone (depending 
on the material) to chip, this “skin” helps to prevent 
the chipping affect the finished surface. The second 
reason is that most tools cut better when they are 
constantly removing material. Therefore leaving an 
allowance of material on ensures that there is always at least some material for the finishing 
toolpath to remove. 

Z Level Strategy 
Z Level Roughing essentially uses a series of 2D Pocket toolpaths which take into account the 3D 
model and “hog-out” the material around it within the specified boundary. There are two settings 
that must be chosen to define this type of toolpath. The first box lets you choose the main direction 
of the cuts in the toolpath; either Raster X which fills each pocket with a raster pattern mainly 
parallel to the X axis or Raster Y which fills each pocket with a raster pattern mainly parallel to the Y 
axis.  
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The second setting is the choice of Profile, this controls whether each level has a profile cut around 
its boundary or not and if so whether it cuts before the raster or after it. First does the profile before 
the Raster on each level, Last does the profile cut after the raster on each level and None eliminates 
the Profile cut leaving only the raster pattern. These choices depend a lot on the material and 
tooling being used. For example, more brittle material may need the profile first option to stop the 
raster chipping the edges.  

3D Raster Strategy 
The 3D Raster strategy is a 3D cut which passes over the whole model. This will leave a more even 
amount of material for the finish cut to remove but depending on the depth and style of the part it 
may take significantly longer to run. In shallower parts where the roughing is only taking one or two 
passes then this may be a better choice of roughing strategy. For deeper parts then typically the Z 
Level rouging is a more efficient choice. There is only one option with this strategy to define the 
main cutting direction. Raster X uses a raster pattern mainly parallel to the X axis or Raster Y uses a 
raster pattern mainly parallel to the Y axis. 

Boundary Vector Offset 
When a vector is used to specify the area to be machined, the center of the tool is limited to that 
selected vector boundary. If you are machining a raised object, this often means that the tool won’t 
fully machine the edge of the object. This field is used to specify an offset to the selected machining 
boundary to avoid the need to create another vector that is offset by the radius of the tool. 

Safe Z 
The height above the job at which it is safe to move the cutter at rapid / max federate. This 
dimension can be changed by opening the Material Setup form. 

Home Position 
Position from and to that the tool will travel before and after machining. This dimension can be 
changed by opening the Material Setup form. 

Vector Selection 
This area of the toolpath page allows you to automatically select vectors to machine using the 
vector’s properties or position. It is also the method by which you can create Toolpath Templates to 
re-use your toolpath settings on similar projects in the future. For more information, see the 
sections Vector Selector and Advanced Toolpath Templates. 

Name 
The name of the toolpath can be entered or the default name can be used. 
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Finish Machining Toolpath (3D) 
 Finish Machining is used to machine the 
final pass on the finished 3D part. This 
requires a selected vector in order to 

limit the boundary area of the toolpath that is 
projected onto the 3D surface. If no vector is 
selected the boundary of the workpiece will be 
used. 

Clicking on this icon opens the toolpath form 
shown to the right; the functions available within 
this are described below.  

Tool 
Clicking the Select button opens the Tool Database 
from which the required tool can be selected. See 
the section on the Tool Database for more 
information on this. Clicking the Edit button opens 
the Edit Tool form which allows the cutting 
parameters for the selected tool to be modified, 
without changing the master information in the 
database. 

For most 3D Finishing cuts a Ball Nosed end mill is 
used with a reasonably small stepover (8 – 15% of 
the tool diameter is typical). Variations on this tool 
type such as a tapered Ball Nosed cutter will also 
work and may offer more strength with smaller 
tool sizes. The size of tool will depend on the size 
of the part and the detail within the 3D part. Use the preview function to check the finish quality and 
detail, if they are not to a high enough standard then the job may require smaller tooling or a 
smaller stepover. 3D cutting is always a trade off between time and quality and an optimum balance 
of tool size, finish quality and time to cut. The choices made will always depend on an individual’s 
personal preferences or the specifications of the job. 

Area Machining Strategy 
There are two choices of the type of “fill pattern” that will be used to machine the area with the 
toolpath, Offset and Raster. 

Offset 
Calculates an offset pattern projected onto the 3D surface and machined inside 
the selected vector(s). The cutting direction can be set to either Climb (CCW) or  
Conventional (CW) . 
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Using Climb or Conventional cutting will largely be dictated by the material is being 
machined. Talk to your material and tooling suppliers for details about what is most 
appropriate for your specific type of work. 

 
Example of an Offset pattern 

Raster 
Calculates a raster pattern projected onto the 3D surface and machined inside the 
selected vector(s), with control over Raster Angle - Between 0 and 90 degrees.  

0 degrees is parallel to the X axis 
90 degrees is parallel to the Y axis.  

 
Example of a 3D Raster toolpath at 0 degrees 

Safe Z 
The height above the job at which it is safe to move the cutter at rapid / max federate. This 
dimension can be changed by opening the Material Setup form. 

Vector Selection 
This area of the toolpath page allows you to automatically select vectors to machine using the 
vector’s properties or position. It is also the method by which you can create Toolpath Templates to 
re-use your toolpath settings on similar projects in the future. For more information, see the 
sections Vector Selector and Advanced Toolpath Templates 

Home Position 
Position from and to that the tool will travel before and after machining. This dimension can be 
changed by opening the Material Setup form. 

Name 
The name of the toolpath can be entered or the default name can be used. 
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Vector Selector 
This tool allows you to easily select vectors which 
meet a set of criteria, such as open, closed, 
circular and also matching constraints based on 
layers. The dialog can be accessed from the Edit 
→Vector Selector menu item, or from the 

Selector…  button on each toolpath form. When 

the command is executed the dialog shown on the 
left is displayed. 

The dialog is used to configure a set of ‘filters’ 
that determine which vectors will be selected. As 
a filter is enabled by clicking on its check box, or 
selecting a ‘radio button’ option, the current 
selection will be updated with all the objects in 
the file which match the current filter options. 

Generally you will start at the top of the dialog 
and work downwards, specifying more and more 
explicit filters to determine the required selection 
exactly. 

The simplest option is just to use the form to 
Select Closed Vectors in the job or Select Open 
vectors (you can specify both, in which case all 
vectors will be selected as long as they are on a 
visible layer). 

The most common way to use the Vector Selector 
is to select all the vectors on a given layer as 
shown in the screenshot of the dialog below. 

In this example, the dialog has been used to select 
All Closed Vectors on the layer with the name 
Pocket. 

Selection 
The Selection: section at the top of the dialog is continuously updated to show the results of the 
current filter and the 2D view is also updated to show what is currently selected. The Objects: entry 
shows the total number of objects selected, if these objects include Text or Groups, this number may 
be less than the total of Closed and Open vectors displayed on the following line. For instance, a 
block of text is one object but will usually consist of many closed vectors. If a group contains both 
open and closed vectors, it will be selected as matching both Open and Closed filters. 
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Geometry Filters 
The Geometry Filters section is used to specify constraints on the type of vectors to select. You can 
choose to select open vectors and/or closed vectors. Instead of selecting All Closed Vectors, the 
dialog can be used to select Only Circles and can even be used to specify an exact diameter and 
tolerance for the circles to be selected. This can be very useful for selecting vectors for drilling 
toolpaths, particularly if the vectors have not already been sorted into layers. 

Layer Filter 
The Layer Filter section allows you to pick one or more visible layers on which to select vectors 
which match the geometry filter. Alternatively, the All visible layers option disables the filtering by 
layer and selects all vectors which match the geometry filter regardless of the layer they are on, as 
long as that layer is visible.  

The Associate with toolpath option will be explained in the next section. 

Advanced Toolpath Templates 
By associating a template with the result of a Vector Selector filter, we can make a template 
automatically select the vectors it is intended to machine. A simple case would be to create a 
template which consisted of a Pocketing toolpath set up to machine all closed vectors on a layer 
called Pocket. After loading this template into a new job and choosing Toolpaths → Recalculate All 
Toolpaths the toolpath would be recalculated, automatically selecting all closed vectors on the layer 
called Pocket.  

The advanced templates are created by selecting the vectors for a toolpath using the Selector…  

button on the toolpath form. When a toolpath form is first opened, the Vector Selection: section on 
the form will show that vectors are being selected manually as shown below... 

 

Pressing the Selector...  button will display the Vector Selector form as shown previously. After 

making your geometry selection and before you close the form, select the Associate with toolpath 
option on the form as shown below.  
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After the Vector Selector form closes, the Toolpath form will indicate that Vector Selection is now 
‘Automatic’ as shown below... 

 

IMPORTANT:  Calculate the toolpath to apply the changes you have made.  

When you re-calculate or edit a toolpath that has the Vector Selection mode set to automatic, the 
vectors which match the filter when the toolpath is re-calculated or edited will be selected. To 
cancel the Automatic vector selection mode, you can just select  the vectors to machine normally 

with the mouse, or use the Selector...  button to bring up the Vector Selector dialog again (the 

settings are remembered) and uncheck the Associate with toolpath option. 

If toolpaths with the Vector Selection mode set to Automatic are saved as templates, these setting 
are saved with the template. When the template is re-
opened and the toolpaths recalculated, they will 
automatically select all vectors which match the filters 
specified with the Vector Selector for that toolpath. 

If you load a toolpath template which has toolpaths 
associated with layers which don’t exist in the current file, 
the Missing Layers for Template dialog will be displayed. It 
lists all the missing layers and offers you the choice of having 
them created automatically, deleting toolpaths associated 
with missing layers or just loading the toolpaths as is.  

Choosing to allow the dialog to automatically create the 
missing layers allows a toolpath template to be used to create ‘standard’ layers for machining 
operations and load the toolpaths ready to be calculated. All you then need to do is move vectors to 
the appropriate layers and recalculate all the toolpaths. 
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Choosing the Delete all toolpaths associated with missing layers option allows you to create a single 
template with many toolpaths and have the ones which aren’t appropriate to the current job 
automatically deleted. 
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Toolpath Editing Tools 
Edit Toolpath 

This option is used to modify an existing toolpath.  

 

• Click to select a toolpath in the list then click the edit option to open the form.  
• The vectors associated with each toolpath are automatically remembered, so editing a 

toolpath will automatically select the vectors in the 2D window.  
• Make the required changes to the toolpath parameters  
• Click the Calculate button to update the toolpath  

A toolpath can also be edited by double-clicking on its name in the toolpath list. 

Copy Toolpath 
 The Copy Toolpath option creates a copy of the selected toolpath and adds a suffix to the 
name of the new toolpath. For example,  

Cut out - 1/4 " End Mill will create a copy with the name Cut out - 1/4" End Mill (1) 

Copying 3D toolpaths from PhotoVCarve will also create a duplicate grayscale thumbnail image in 
the 2D window, which can then be used to move or position the toolpath. 

Delete Toolpath 
 This option is used to delete calculated toolpaths from the display list. Simply select the 
toolpath to be deleted and click the Delete Toolpath option.  

Important - Ensure the correct toolpath is selected as there is no option to confirm before deleting 
and this cannot be undone. 

Recalculate All Toolpaths 
This command forces a recalculation of all the toolpaths in the Toolpath list. It is useful when the 
artwork used by the toolpaths has been modified, or the material block settings have changed. 
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The Tool Database 
The Tool Database is used to make cutter management and selection very quick and easy, 
and reduces the possibility of programming jobs with incorrect cut depths and speeds 

and feeds. The Tool Database is accessed from the Select...   every time you create a new 

toolpath and allows pre-defined tools and settings (speeds, feeds, stepover etc.) to be selected from 
a list. 

New tools can be added, copied from existing tools, deleted and organized. All of the cutting 
parameters are stored in the database. 

Opening the tool database 
To access the Tool Database you can click on the Database icon on the Toolpaths tab. 

 

Alternatively, select Toolpaths ► Tool Database from the main menu bar. 

A window similar to that shown below will appear displaying a list of the tools that are currently 
defined on the left and the parameters for the currently selected tool from the list over on the right.  
Below this image is a list of all the actions that can be executed from this dialog: 
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Tool List 
The Tool List is located on the left-hand side of the Tool Database. Click on items in the list to see or 
edit their properties using the Tool Info section of the database window. The Toolpath list is 
arranged hierarchically to allow you to organize your 
tools according to common properties or use. 

You can click and hold down the left mouse button to 
drag items up or down in the list. If you drag them 
into a tool group, they will be placed inside the 
group. 

Tooltip of group hierarchy 
When a tool is selected within a toolpath strategy 
page, the tool name does not always provide enough 
information for you to know whether the tool’s 
settings are appropriate. This will become 
particularly significant if you import a toolpath 
template (see Toolpath Templates) with a tool that 
has been pre-defined (perhaps by a 3rd party) when 
the template was created. It is always possible to 
click Edit and see the full set of the tool’s properties 
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& settings. However, if you hover your mouse over the tool’s name, a tooltip will pop-up telling you 
what the location of this tool was in the tool group hierarchy when it was added to the toolpath 
strategy or template. This can be extremely useful for quickly distinguishing between tools in your 
database that have similar names, but have been grouped according to their properties. 

Adding a New Tool 
Selecting New…  creates an empty tool in the list that can have any user definable name. 

Copying a New Tool 
Copy adds a duplicate of the selected tool to the list and prefixes the original name with (1). Edit the 
Name and properties for the new tool and click the Apply button to save the changes to the list.  

Deleting a Tool 
Deletes the selected tool from the database.  

Note: Take care when deleting tools as this operation cannot be undone. 

Creating a new tool group 
Click on the add New Group  button then give your new group a name and press Apply  to add it to 

the database. Click and drag tools from the database over the top of the newly created group icon in 
the tool database tree to add them to the group. Alternatively, select the group and then click the 

New…  button to create a new tool directly within the selected group. 

Importing and Exporting tools 
Individual tools or complete tool group hierarchies can now be saved to disk using the Export…  

button. Similarly, you can now import previously saved tools, groups or even entire tool databases 

using the Import…  button. 

Note: Aspire 3 will import database files from Aspire 2, so you can easily add any previously defined 
tools to your new database. Please note, however, that you will not be able to open Aspire 3 
database files in earlier versions of Aspire. 

Tool Info 
When a tool or group is selected in the Tool List, its properties are displayed in the Tool Info section 
on the right-hand side of the Tool Database. 

Here you can modify any of the properties of the currently selected Tool or Group. Click the Apply  

button to save the changes to the Tool List. 

Note: If you modify the Tool database, your changes will only be saved if you click OK . If you exit the 

Tool Database window using the Cancel  button, any changes you have made since opening the 

Database will be discarded. 

Name 
Use this field to enter a suitable name to describe your cutters. 
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Tool Type 
9 types of cutters can be specified in the database. 

   

V-Bit Engraving Radiused Engraving 

 

Note: When specifying the geometry for a tool, the angle specified is different for V-Bit and 
Engraving Tools.  

• V-Bit Tools are defined using an Included Angle (A) 

• Engraving Tools are defined using the Half Angle (A) and the Flat Diameter (F) 

 

   

Ball Nose  End Mill  Radiused End Mill 

 

   

Form Cutters Diamond Drag  Drills 
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Notes 
The tool notes section simply allows you to save any additional text descriptions, special instructions 
or relevant information you may require, within your tool definition.  

Geometry 

Diameter 
The diameter of the tool in either inches or mm. The tool image will indicate where this 
dimension is taken from. 
 

Cutting Parameters 

Pass Depth 
The maximum depth of cut the tool can cut. The Pass Depth controls the number of z level 
passes that are calculated for a toolpath. For example, creating a pocket 1" (25.4 mm) deep 
using a tool that has a Pass Depth of 0.25" (6.35 mm) will result in the toolpath making 4 
passes. 

Stepover 
The distance the cutter moves over when doing area clearance cutting. For example, when 
raster machining the cutter will machine along the X axis, stepover in the Y direction and 
return parallel to the first line of cut. The greater the stepover the faster the job will be 
machined, but this must be balanced with the material being cut and the tooling being used, 
to ensure that the tool does not break.  
When stepovers greater than 50% of the cutter / tip diameter are used the software 
automatically adds 'Tail' moves in the corner regions of toolpaths to ensure material is not 
left on the job for offset based strategies. 
When using V-Bit Tools, the Stepover fields automatically change to use the following 
options.  

Final Pass Stepover 
The distance the cutter moves over when finish machining and is usually set to be a 
relatively small distance to produce a smooth surface finish on the job.  

Clearance Pass Stepover 
Only used when a V-Bit tool is being used to rough machine at multiple Z levels down to a 
specified flat depth. This stepover can be much larger than the Final Pass Stepover because 
the tool is only rough machining material away. Increasing the Clearance Pass Stepover will 
reduce the machining time, but you must be careful to ensure it is not too great for the 
material being cut. 

Feeds and Speed 

Spindle Speed 
Speed of tool rotation, specified in revolutions per minute 
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Feedrate 
The surface cutting rate at which the cutter is moved in the material. The units can be 
specified in distance per second or minute. 

Plunge Rate 
The cutting rate at which the cutter is moved vertically into the material or during ramping 
moves. The units can be specified in distance per second or per minute. 

Note: The Feedrate and Plunge rate you should use will vary depending upon the material 
being machined and the tooling being used.  

Tool Number 
This is the number of the tool needed to machine the job. When using a CNC machine with an 
Automatic Tool Changer (ATC), it is critical that the correct tool required to cut the job is located in 
the corresponding carousel location. 



 

 
221 Navigation Homepage 

 
 

Using Form Cutters 
Form Cutters can be added to the Tool Database so that industry standard Ogee and Round-over 
type cutters, plus user definable custom shapes can be used for edge profiling and decorative 
carving. Examples of these types of cutters and the kind of cuts they can be used for are shown in 
the images below: 

  
 

Roundover Ogee Profile Cutting Strategy with Form cutter 
 

Adding your own custom form cutters 
Adding a Form cutter to the Tool Database is straightforward and the procedure is,  

• Before opening the tool database, draw to exact scale the Right side of the cutter geometry 
in the 2D Window  

• Use the Node Editing tools to create the arcs and curves etc.  

 

Only draw the Right-hand side of the cutter geometry to the correct size and scale as shown in the 
image above.  

The shape can be a combination of Lines, Arcs and Bezier spans 

• With the vector Selected open the Tool Database (using the command icon on Toolpaths tab 
for from the main menu, Toolpaths ► Tool Database 

• In the Tool Database window, click New…   
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• Select Form Tool 

 

 

The selected geometry will be imported and a profile displayed in the window.  

5. Give the Cutter a meaningful name and enter the cutting parameters – speeds and feeds etc.  

6. Click the Apply button to save the new cutter into the database list so it can be used at any 
time.  

Note: Cutter geometry can be imported as dxf, eps files and used to create Form Tools in the 
database. 
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Toolpath Templates 
Toolpath templates allow you to improve the efficiency of your production processes by 
saving the complete toolpath settings for common operations. These settings can then be 
re-used at any time on different design geometry. Frequently used strategies and tooling 

can thus be applied to similar jobs, quickly and easily. 

Simple Toolpath Templates 
Using the Toolpaths → Templates → Save Selected Toolpath as Template menu command (or 
the associated icon), all the settings for the currently selected toolpath can be saved as a template. 
When you reload this file (using Toolpaths → Templates → Load Template...) you will have an 
empty toolpath which can be edited by double clicking on its name in the toolpath list or selecting 
the Edit Toolpath icon in the Toolpaths tab. Once the toolpath form is open, the vectors to be 
machined can be selected and the toolpath calculated using all the saved settings.  

The Toolpaths → Templates → Save All Visible Toolpaths as Template menu command (or the 
associated icon) allows a group of toolpaths to be saved as a single template. As an example, the 
toolpaths may have all the settings used for Profiling and Pocketing operations for a particular type 
of job and material combination. These toolpaths settings can then be recalled simply by opening 
the template and selecting the appropriate vectors for each toolpath. 

If toolpaths with the Vector Selection mode set to Automatic are saved as templates, these setting 
are saved with the template. When the template is re-
opened and the toolpaths recalculated, they will 
automatically select all vectors which match the filters 
specified with the Vector Selector for that toolpath. 

If you load a toolpath template which has toolpaths 
associated with layers which don’t exist in the current file, 
the Missing Layers for Template dialog will be displayed. It 
lists all the missing layers and offers you the choice of having 
them created automatically, deleting toolpaths associated 
with missing layers or just loading the toolpaths as is.  

Choosing to allow the dialog to automatically create the 
missing layers allows a toolpath template to be used to create ‘standard’ layers for machining 
operations and load the toolpaths ready to be calculated. All you then need to do is move vectors to 
the appropriate layers and recalculate all the toolpaths. 

Choosing the Delete all toolpaths associated with missing layers option allows you to create a single 
template with many toolpaths and have the ones which aren’t appropriate to the current job 
automatically deleted. 
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Toolpath Tiling 
Using the Toolpath Tiling options it is possible to machine objects and designs that are 
many times larger than the available area of your CNC machine bed. This process is also 

invaluable if the maximum sizes 
of your material pieces are 
limited. In both case, a much 
larger project can still be 
achieved by breaking the 
toolpath down into manageable 
tiles or strips, each of which can 
fit within the machineable area 
of your CNC machine, or on the 
available material blocks. Once 
cut, the tiles can then be re-
assembled to form the finished 
piece. 

The process of tiling begins by 
creating toolpaths based on the 
final object entirely as normal – 
at this stage you do not need to 
take any account of the available 
machining bed size. Once you 
have calculated required 
toolpaths, click on the toolpath 
tiling button in the toolpaths 
pane to open up the toolpath 
tiling form. 

The Toolpath Tiling Manager 
The toolpath tiling form will 
‘split’ the full-size toolpaths into 
a number of discrete, but precisely aligned, toolpath tiles as soon as you click the Update Tiles 
button. While the Tile Toolpaths mode is enabled (using the checkbox on this form) any toolpaths 
that you save will automatically be divided into tiles. 

The top section of the tiling form allows you to set the type of tiling you require (see below for more 
information) and the appropriate settings for each tiling strategy.  

The lower section of the tiling form allows you to select and activate each of the tiles. The currently 
active tile can be previewed in either the 2D or 3D View.  
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Tiling Options 
There are three layout strategies for tiled toolpaths, the most appropriate one will depend on your 
machines capabilities and the available material. 

Individual Tiles 
The first tiling option is for individual tiles. This splits the current job in both X and Y, to form a series 
of entirely separate toolpaths. This is generally the preferred option if you have independent pieces 
of material to machine, or if you have a moving-bed type CNC machine that will not allow you to 
‘overhang’ material outside of the machineable area. 

With this option selected, you are asked to specify the width and height of each tile, and the 
required overlap (which will be applied in each direction). Tiles are created from the bottom left of 
your model. The overlap for independent tiles is particularly important for 2.5D toolpaths that utilize 
the shape of your tool bit (such as V-bit carving). 2.5D toolpaths will need to ‘overrun’ the edges of 
your tile in order to complete their cuts using the side of the bit. For this reason, the overlap 
distance for Independent Tiles will typically need to be at least equal to the radius of your tool bit. 

Feed-through in X or Feed-through in Y 
Instead of cutting a series of individual pieces of material and assembling them later, it can also be 
convenient to cut a single strip of material using a series of set-ups – moving the material through 
the machineable area between cuts. Aspire specifically supports this technique using the Feed-
through in X/Y options. In these cases you will only need to define either the Tile Width or Height 
(which corresponds to your intended feed-through distance), as the other dimension is assumed to 
correspond to the shorter side length of your material and will match the equivalent current job 
dimension. Similarly, the overlap distance is only applied in the direction of the draw-through. 
Because you will typically be cutting the same piece of material with each toolpath tile, the overlap 
distance for Feed-through is not as critical as for Individual tiles and is typically used to allow for a 
margin of error in your set-up accuracy. 

Once you have set your tiling option, click the Update Tiles button to see your settings reflected in 
the Tile Previews in either the 2D or 3D Views. 

Tile Previews 
The 2D View indicates how the model area is split into tiles. The yellow lines indicate the tile sizes, 
but the light red areas also indicate the overlap region for each tile. You should pay particular 
attention to the fact that this overlap can take the toolpath outside of the tile boundary – this is 
necessary to ensure that 2.5D toolpaths, in particular, form the correct shapes at the tile edges. 
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An independent toolpath tile preview in the 
2D View. The light red areas indicate the 
current overlap settings for this tile. 

This image shows the same toolpath tile’s 3D 
preview, positioned relative to the machining 
origin. You should note that the tool will machine 
negative, as well as positive, relative to its origin in 
this case. You must allow for this necessary effect 
when setting up your material and origin for 
machining. 

 

When you come to machine these tiles you should take care to allow for the overlap distance when 
setting your machining origin on your material. Internal tile toolpaths can machine negative, as well 
as positive, relative their origin. 

The currently active tile can be set directly from the 2D View by double-clicking on the background 
of one of the indicated tile regions. 

Simulating Tiled toolpaths 
You can also view and simulate individual toolpath tiles in the 3D View. To view the toolpath tiles, 
simple ensure that the toolpaths are visible (checked in the Toolpath List) and then select the tile 
you wish to see either from the Tile Toolpaths from, or the 2D View (see above). 

Since tiles are created so that they will all be cut within the same machineable area (i.e. they are all 
located in a similar position relative to the machining origin), this can make them difficult to visualize 
using Preview Toolpaths. Simulating each toolpath tile in its absolute position will result in the 
toolpaths being cut in the same region of your preview block and they will overcut the same area. 
The Tile Toolpaths form has an option Draw toolpaths in original position for visualization to allow 
you to simulate the tiles as if they were arranged in their final pattern. With this option enabled, you 
can visualize how your final piece will look by previewing all your toolpath tiles together, but you 
should note that it will not reflect the true offset of each toolpath 
from your machining origin. 

Saving toolpath tiles 
Provided you have created toolpath tiles using the Tile Toolpaths 
form, an additional option, Output Tiled Toolpaths, will be available in 
the toolpath saving form. 

 



 

 
227 Navigation Homepage 

 
 

 

It will be checked or unchecked to match the current state of the Tile Toolpaths check box in the Tile 
Toolpaths form.  

Note: If the Output Tile Toolpaths option is grayed-out this means that no tiles have been created. 
You will need to close the Save Toolpaths form and use the Tile Toolpaths form to create the 
toolpath tiles before continuing. 
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Previewing Toolpaths 
Calculated toolpaths can be previewed to see 
exactly what they will produce when cut into 
the material. The 3D preview mode also 

allows the job to be viewed in different material types 
with the option to paint the machined regions with a Fill 
Color. 

Material & Rendering Settings 
The pull-down list offers a range of material types to 
shade the 3D model. The first entry in the list is ‘Use 
Solid Color’ and if this is selected the color for the 
material can be selected from the color picker form. 

See Adding Custom Materials below for adding your 
own materials. 

Machined Area Color... 

Material Color 
With this setting, the areas of your preview will 
simply be colored using the material defined 
above. Effectively this switches off independent 
material settings for your machined areas. 

Global Fill Color 
Paints all the machined regions with the selected color. Selecting the associated pull-down 

list opens the default color selection form. Click on one of the preset colors, or click More  

Colors…  to create a completely custom color. 

Toolpath Color 
If this option is selected, each toolpath can have a different color assigned. If the ‘No Fill’ 
option is selected from the color picker form, the current toolpath will be shown in the 
material color. 

Animate preview 
Option to show the material being removed by the cutter as the preview is drawn.  

Draw tool 
Option to show a wireframe animation of the tool (to scale) cutting the job. 
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Toolpath Preview Tools 

Preview Toolpath 
Animates the selected toolpath cutting into the material 

Preview Control Simulation 
The preview controls provide full video-like playback control of your toolpath. You can use this mode 
to analyze the tool moves in detail, step-by-step. To begin using Preview Control, click on the Run 
button. 

The Preview Control buttons are summarized below: 

      

Run Pause Single Step Run to Retract Stop 

Begins Preview 
Control 
simulation 

Temporarily halts 
the tool in its 
current position 
and enables the 
Stop button so 
you can exit 
Preview Control 
mode 

Moves the 
toolpath on by 
one tool move. 

Runs the toolpath 
to the next 
retract move, 
then pauses the 
tool. 

Exits Preview 
Control mode. 

 

Note: To cancel the process of previewing a toolpath using Preview Control, first click the Pause 
and then the Stop buttons.  

Preview All Toolpaths 
Animates all calculated toolpaths cutting into the material  

Preview Visible Toolpaths 
This command allows you to identify a subset of toolpaths to be simulated, quickly and easily: 

• Isolate the toolpaths you wish to preview by un-ticking the visibility checkboxes of the other 
toolpaths in the Toolpath List.  

• Verify that the 3D View is only displaying the toolpath previews of the toolpaths you are 
interested in.  

• Click Preview Visible Toolpaths  to begin the simulation.  

Delete Waste Material 
If a profile toolpath is calculated the excess material around the edges of the job can be 
automatically removed to show the finished job.  
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Reset Preview 
Resets the material back to a solid block  

Save Preview Image 
Saves an image of the 3D window as a BMP, JPG or GIF file  

Note: Saving the image without the Colour Shaded Background is often useful when the 
image will be used on its own in a brochure or on a web site etc.  
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Adding Custom Materials   
Additional materials can be added to the library list by simply copying a image file (JPG, BMP or TIF) 
of the material or image you wish to render the job with into the Textures folder within the  
‘Application Data Folder’. You can open the Application Data Folder from within the program using 
the File → Open Application Data Folder menu command. The location of this folder is different 
on different operating systems, but as an example for Aspire V3 on Windows 7 it is located by 
default at 

C:\ProgramData\Vectric\Aspire\V3.0\BitmapTextures 

By default this folder contains a number of other folders e.g. 

C:\ProgramData\Vectric\Aspire\V3.0\BitmapTextures\1_Wood 

A custom folder that includes shading materials can be added by simply creating a folder in the 
Bitmap Textures folder as shown below.  

C:\ProgramData\Vectric\Aspire\V3.0\BitmapTextures\5_My_Shading_Textures 

You can then just copy the images you want to use as textures into this folder. 

Note: Aspire must be restarted when new materials are added.  

Shading textures can be obtained from sources such as the internet, clipart libraries or simply create 
your own from a digital or scanned photographs. For good quality results the image needs to be 
approximately 1000 pixels x 1000 pixels. The texture image is simply scaled proportionally in X & Y to 
fit the longest side of the job. 

Multi-Colored Toolpath Preview 
When previewing the effects of each toolpath it is possible to assign different colors to each one. 
This can be used to simulate the effects of differently painted areas both as a way to verify what is 
being cut by the toolpaths and also to provide an image than can be emailed or printed for customer 
approval. An example of the new shading in use is shown in the image below of the Howling Wolf 
Sign, with the new preview on the left and the actual finished sign on the right.  
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The different colors can be set from the Preview Toolpath form – this appears automatically when a 
toolpath is calculated or can be accessed anytime by clicking the icon under the Toolpath 
Operations area of the Toolpath menu, shown below, highlighted by a red box.  

 

When this icon is clicked (or immediately after a toolpath is calculated) then the Preview form will 
be shown. The options for defining the fill color are contained in the Machined Area Color area of 
the form highlighted with a red box in the image below.  
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Solid Material Color  
Before the individual toolpath color fill is covered it is worth pointing out another feature within the 
preview form. There is the option at the very top of the Material List to select a Solid Color for the 
surface of the part. Once this is selected the color choice can be made from the drop-down Solid 
Material Color area. This allows material with a different solid color surface and core to be easily 
represented. The Use Solid Color option is shown in the image below:  

 

Machined Area Color 

Use Material Color 
Checking this option will use the same color/material for the fill as you have selected for the 
material itself as shown in the image below.  
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Use Global Fill Color  
Checking this will use the same single fill color for all toolpaths as shown in the image below.  

 

Use Toolpath Color 
Checking this will let you select different colors for each toolpath in your list as shown in the 
image shown below.  

 
To set the color individually, first select the toolpath from the Toolpath List and then click on 
the drop down arrow next to the color block to show the form shown below: 

 
Choose the color you want for the fill of that toolpath and it will be applied to the areas that 
the toolpath has carved when they are previewed. Once you assign an individual color a 
small square of that color will be displayed next to the name in the toolpath list. This can be 
seen in the image shown below just to the left of each tool icon.  
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If you click the option at the top of this form where is says “No Fill” then this will leave that 
toolpath in the selected Preview Material Color.  

 

Set All 
Clicking the Set All button will set all the toolpaths in your Toolpath List to the currently 
selected color. ONLY click this if you want to change all toolpaths to have the same color as 
you cannot undo this operation. 

Using the Multi Colored Toolpath Preview option with 3D toolpaths 
When assigning an individual color it will be applied to the whole toolpath. If you are cutting a part 
in Aspire with a number of 3D shapes in it you would only be able to assign different colors to them 
if they were cut with individual toolpaths. In most cases with 3D parts it would probably be better to 
create a multi-colored image for a customer by shading the components and saving an image of the 
3D model than trying to assign different colors to the toolpath preview. This will also allow the use 
of not just solid colors but the materials for the different parts.  

It is worth repeating with regard to the 3D toolpaths that there is the ability to select the No Fill 
option from the color choice to keep the toolpathed area in the same finish as the material surface.  
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Estimated Machining Times 
This option estimates the machining times for all calculated toolpaths based on the feed 
rates specified for each tool. The estimates for individual toolpaths plus the overall 
machining time are calculated using the user defined Rapid Rate moves and Scale Factor. 

Times 
The estimated machining times are displayed in Hours : Minutes : Seconds 

Rapid Rate The maximum feedrate at which the machine runs 
for rapid moves, typically specified using G0 or G00 move 

Scale Factor  The nature of different styles of toolpaths 
means that they may be simple 2D cuts or require 
simultaneous 3-axis moves, the more complex the toolpath 
then the more chance the CNC machine may not actually 
achieve the programmed feed rates. This can be compensated 
for by multiplying the times by the Scale Factor. 

The inaccuracies generally come from the acceleration / 
deceleration of the machine. If the program tells a machine to 
move at 200 inches / min along a 200 inch straight line the 
machine will probably take pretty close to a minute.  

If instead of a straight line we ask the machine to cut say a 
gear wheel with a total circumference of 200 inches, the 
machine is likely to take considerably longer. This is because 
the machine will have to slow down to go around the tight 
curves of gear tooth profiles and will probably never reach its 
programmed speed before having to slow down again for the next change in direction.  

The scale factor in the program lets you approximate this slowdown for your machine, but it will vary 
depending on the type of work you are doing. Many people will use one scale factor for simple 2d 
work and another for 3d or VCarving. The best way to calculate it is just to take a note of estimated 
and actual machining times of a period of time.  

If a job actually takes 6 minutes to cut and the estimate was 3 minutes, the scale factor would be set 
to 2 (actual time / estimated time = 6/3). 

For machines where the controller provides an estimated machining time, these should be more 
accurate as the controller can determine where the machine is accelerating / decelerating and take 
account of this.  
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Note: The information displayed on the form for each toolpath can be selected, copied and 
pasted into another document. 
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Saving Toolpaths 
This option allows toolpaths to be saved in the appropriate file format needed to drive the 
CNC machine. Toolpaths can be saved as individual files for each tool used or as single file 
containing multiple toolpaths for CNC machines that have automatic tool changers. 

Individual Toolpaths CNC machines that require the tooling to be changed manually will typically 
need a separate toolpath for each cutter used. The procedure for saving this type of toolpath from 
Aspire is to; 

1. Select the toolpath to save from the Toolpath List  

2. Click on the Save option and the Save Toolpaths form is displayed as shown below: 

 

3. Select the correct Postprocessor for the CNC machine from the pull-down list  

4. Click the Save Toolpath(s) button  

5. Enter a suitable Name and click the Save button 
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Note: When multiple toolpaths are created using the same tool geometry and tool number, they can 
be saved into a single file by selecting the option to - Output all visible toolpaths to one file. 

Automatic Tool Changing Support 
CNC Machines that have Automatic Tool Changing (ATC) capabilities can work with a single file that 
contains multiple toolpaths, each having a different tool number.  

The postprocessor must be configured to support ATC commands for your CNC machine. Contact 
your software or machine supplier for more details.  

The procedure for saving these toolpaths is,  

1. Use the Up & Down arrows to order the toolpath list in the cutting sequence required.  

2. Tick each toolpath to ensure it is drawn / visible in the 3D window as shown in the image 
shown below:  

 

3. Click on the Save option and the Save Toolpaths form is displayed. 

4. Select the option to – Output all visible toolpaths to one file 
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The names of the toolpaths that will be written into the file are displayed along with the tool 
number in square brackets [1]. If a calculated toolpath is not required, simply tick to undraw it.  

5. Click the Save Toolpath(s) button  

6. Enter a suitable Name and click the Save button 

Error Messages 
The postprocessor automatically checks to ensure,  

1. It has been configured for saving files that include ATC commands  

2. A different tool number has been defined for each different cutter being used. 

An error message will be displayed to indicate the problem if either of these items is not correct.  
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Switch to Drawing Tab 
 Closes the Toolpath Tab (right hand screen form) and opens the Drawing Tab (left hand 
drawing form) 
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Toolpath Summary Area 
When a toolpath is selected from the Toolpath list with no other function being used in the Toolpath 
Tab then a summary of the toolpaths settings is shown in the body of the Toolpath Tab below the 
icons as shown in the image below. This is a useful way to recall settings for a toolpath without 
opening it.  
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Rotary Machining and Wrapping 
Aspire can ‘wrap’ flat toolpaths around a cylinder to provide output to CNC machines which are 
configured with a rotary axis / indexer.  The image below shows a flat toolpath wrapped around part 
of a cylinder.   

It is important to note that wrapping works in conjunction with specially configured post-processors 
which take the XYZ ‘flat’ toolpaths and wrap them around a rotary axis, replacing either the X or Y 
moves with angular moves.  

The toolpaths can be visualized wrapped within the program as shown below ... 

 

Aspire can also visualize a wrapped model within the program by drawing the shaded composite 
model wrapped. 

The image below on the left shows the cross section of a table leg modeled flat. The image on the 
right shows the model drawn with toolpath wrapping switched on. 
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Aspire also has the ability to draw the toolpath simulation wrapped. Although this is very useful for 
getting a feel for how the finished product will look, it is important to realize that the wrapped 
simulation may not be a 100% accurate representation of how the finished product will look. An 
example of potential difference would be if you drilled holes in your rotary job. In the actual work 
piece these will obviously just be round holes, in the wrapped simulation these may appear as 
distorted ovals due to the ‘stretching’ process which takes place when we wrap the flat simulation 
model for display. 

The images below show the result of simulating a fluting toolpath within Aspire. The image on the 
left shows the usual ‘flat’ simulation, the image on the right shows the result of switching wrapped 
toolpath drawing on. 

  

All the wrapped toolpath and model drawing is controlled using the ‘Toolpath Drawing’ options on 
the Toolpaths menu. To switch on wrapped toolpath and model drawing the Toolpaths → Toolpath 
Drawing → Wrap Y Values (around X axis) command is used as shown in the image below.  

 

Note:  If your rotary axis is aligned along your Y axis you would choose the Wrap X Values 
(around Y axis) menu item. All the examples in this document will assume that the rotary 
axis is aligned along X. 
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It is important to realize that there are a huge number of possible combinations of machine 
controller and axis orientations for rotary axis / indexers. This means it is impractical for Vectric to 
supply a pre-configured post-processor for every possible combination as standard. We include 
some wrapping post-processors in the default post-processor list as standard. We also ship a copy of 
those post-processors in the Application Data Folder which can be accessed from the File →Open 
Application Data Folder menu command. Under this folder (shown as 
C:\ProgramData\VectricAspire\V3.0 in the example shown below, this will be different on different 
operating systems) copies of the wrapped post-processors are stored in a sub-folder called 05-
Wrapped .,  

C:\ProgramData\Vectric\Aspire\V3.0\PostP\05-Wrapped  

Examining these posts may be helpful if you need to configure a post of your own. If Vectric have not 
supplied as standard a post for your machine configuration please refer to the “Post Processor 
Editing Guide” accessible from the Help menu of the program for information on how to configure a 
post-processor and also look at the standard rotary posts Vectric supply. You should also look at the 
Vectric forum (www.vectric.com/forum) to see if anyone else has already configured a post for your 
configuration or one similar. If, after looking at these resources you are still unsure of what needs to 
be done for your machine, please feel free to contact support@vectric.com for help. However, 
please note that we cannot guarantee to write a custom rotary post-processor for every individual 
requirement. 
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Creating a file for rotary / wrapped machining 
To simplify working with rotary / wrapped machining, Aspire is supplied with a number of ‘gadgets’ 
to automate many of the common processes used in creating a job for rotary machining. 

The first step for any rotary machining job is to run the ‘Wrapped Job Setup’ gadget before you open 
a new file using the  Gadgets → Wrapped Job Setup menu item as shown below. 

 

The “Wrapped Job Setup” dialog shown below will be displayed 
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The form is divided into two main sections which we will discuss separately. The top part of the form 
allows you to enter details about the cylinder you will be machining on  and your machine 
configuration. The bottom section of the form offers options on how the 2D view will be laid out. 

 

Cylinder Dimensions -  Here you specify the size of the finished cylinder you will be working on. 
From these dimensions the gadget will calculate the circumference of the cylinder surface which 
along with the length of the cylinder will control the width and height of the 2D job. The diameter 
will also be used to set the thickness of the job in the program to the radius of your cylinder. 

 

 

Cylinder Orientation Along - This section is used to tell the program how you have your rotary axis 
aligned on your machine. The images show the two supported options. If the centerline of your 
rotary axis is aligned along the X Axis of your machine pick the first option, otherwise the second. 
The gadget will remember your choice the next time it is run, so you should only have to make this 
choice once. 

 

XY Drawing Origin - Here you can specify where the XY zero origin will be placed on your job. These 
options correspond to the same fields on the normal ‘Job Setup’ form within the program. Most 
people would use the default Bottom Left Corner, but for some jobs you may prefer to have the XY 
origin in the Center. 
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Z Origin On - This section determines whether the Z Origin is set to the surface of the material or the 
base (center of cylinder). These settings can be over-ridden when the toolpath is actually saved, but 
we would strongly recommend the ‘Cylinder Axis’ is selected for rotary machining.  The reasons for 
this are detailed in the note below. 

Note: Z Origin for Rotary Toolpaths 

When you output a toolpath via a wrapping post-processor the 
form shown at the left will be displayed (this is for a post processor 
which wraps Y values around a cylinder aligned along the X axis) ...  

You have the choice of specifying if the tool is being zeroed on the 
center of the cylinder or the surface. When you are rounding a 
blank, you cannot set the Z on the surface of the cylinder, as the 
surface it is referring to is the surface of the finished blank. We 
would strongly recommend for consistency and accuracy that you 
always choose ‘Center of Cylinder’ when outputting wrapped 
toolpaths as this should always remain constant irrespective of 
irregularities in the diameter of the piece you are machining or 
errors in getting your blank centered in your chuck.  

A useful tip for doing this is to accurately measure the distance 
between the centre of your chuck and a convenient point such as the top of the chuck or part of 
your rotary axis mounting bracket. Write down this z-offset somewhere, and zero future tools at this 
point and enter your z-offset to get the position of the rotary axis center 

Another reason for choosing ‘Center of Cylinder’ is that some controls will be able to work out the 
correct rotation speed for the rotary axis based on the distance from the centre of rotation. If the Z 
value is relative to the surface, the control would need to know the diameter or radius of the 
cylinder at Z zero. 

The bottom section of the form offers two choices for how the job will be set out. 

 

As well as working with a simple unwrap of a cylinder into a flat sheet; this gadget can create a 
layout for wrapping a 'spiral' around the cylinder. This can be extremely useful if you have a design 
which wraps multiple times around your cylinder, as you can lay out the design as a continuous strip 
which will be wrapped in a spiral fashion when the toolpaths are created. To use this feature you 
must ensure that all of the design AND toolpaths remains within the area bounded by the vector 
created on the "Spiral Wrapped Area" layer. 
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NOTE: If you use the ‘Spiral Wrap’ option, the wrapped model and wrapped simulation will not 
display correctly. The wrapped toolpaths will however. 

If you choose the ‘Spiral Wrap’ option, enter the number of times you want your design to wrap 
around the cylinder. The screenshot below shows a simple 3 turn wrap in the 2D view and the 
wrapped toolpath. 

 

Vector Layout 
As well as creating a job at a suitable size for wrapping toolpaths, if this gadget is run from Aspire it 
will create a number of vectors which can be very useful when creating your wrapped job. 

The vectors are created on their own individual layers and by default 
these layers are switched off to avoid cluttering up your work area. To 
switch on the layers, display the ‘Layer Control’ dialog (Ctrl + L is the 
shortcut to show / hide this). To show / hide the layer simply click on 
the check box next to the layer name.  

2Rail Sweep Rails - This layer contains two straight line vectors which 
can be used to sweep a profile along if you are creating a shaped 
column. 

Bounding Box - If you have chosen the ‘Simple Cylindrical Wrap’ 
option, this layer contains a rectangular vector covering the entire job 
area. This vector is useful if you are going to machine the complete 
surface of the cylinder. 

Spiral Wrapped Area - If you selected the ‘Spiral Wrap’ option, this 
layer (which is visible by default) holds the vector bounding the area 
your design should be placed in to wrap correctly. This vector should 
also be used as a machining boundary if you are machining the 

complete surface of the cylinder. 
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In addition to the vectors created on layers, if you selected the ‘Spiral Wrap’ option, the gadget will 
create a series of horizontal and vertical guidelines to assist you in laying out your project. 
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Creating a Simple Wrapped Toolpath – Step by Step  
 

1) Ensure you have a “wrapping” post processor for your controller and axis configuration installed 
in the PostP folder (see above).  

2) Start a new job using the “Wrapped Job Setup” gadget – This must be run without a file open. 
When you start the program, before opening a file, click Gadgets →  Wrapping →  Wrapped Job 
Setup from the main menu bar.  

 

3) The “Wrapped Job Setup”  dialog shown below will appear…  
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This dialog lets you specify the size and orientation of the cylinder you are machining on and also the 
axis the rotary axis is aligned with on your machine. After filling in the values and pressing OK the 
form will close and a new job will be created within the program. The size of the job will match the 
size of a sheet of paper wrapped around the surface of a cylinder of the size you specified. The 
thickness of the material will be set to the radius of your cylinder.  

 

4) You can now create toolpaths within the job as normal. For this example I have created a piece of 
text machined with a pocketing toolpath 0.1” deep.  
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In the 3D view you will see the “normal” 2d toolpath …  

5) We can now see what this toolpath will look like when it is wrapped  for output on a rotary axis. 
Using the main menu bar, select  

Toolpath → Toolpath Drawing → Wrap Y/X Values (Around X/Y Axis)  

 

Note that for clarity we have un-checked ‘View → Color Shaded View’ . Depending on your 
machine setup, you should choose either ‘Wrap Y Values (around X axis)’ or ‘Wrap X Values (around 
Y axis)’ and this choice should match the choice you made for cylinder orientation in the ‘Wrapped 
Job Setup’ gadget in step 2.  

 

6) In the 3D view you should now see your ‘flat’ toolpath wrapped around the axis of your choice. To 
help with visualization, check the menu option ‘View – Draw Material Block’ as shown in the screen 
shot below.  
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7) We are now ready to save the toolpath using the wrapping post-processor we copied into the 
PostP directory in Step 1. Select your ‘Wrapping’ post-processor and the ‘Wrapped Output’ dialog 
will appear as shown below …  
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Note that we have selected a wrapping post-processor (it has ‘Wrap’ as part of the name to 
distinguish it from a normal post-processor). Normally you will not need to change the values on this 
form other than  possibly ‘Z Zero Position On Cylinder’ the first time you run it. The rest of the values 
are filled in automatically based on the settings from the post-processor and the material thickness 
which should have been set to the radius of your cylinder by the ‘Wrapped Job Setup’ gadget in step 
2.  

For the Z Zero position, we would strongly recommend that you choose ‘Center of Cylinder’ as this 
should always remain constant irrespective of irregularities in the diameter of the piece you are 
machining or errors in getting your blank centered in your chuck. A useful tip for doing this is to 
accurately measure the distance between the centre of your chuck and a convenient point such as 
the top of the chuck or part of your rotary axis mounting bracket. Write down this z-offset 
somewhere, and zero future tools at this point and enter your z-offset to get the position of the 
rotary axis center. If you are roughing an oversize blank, you MUST zero from the center of the 
cylinder, as the ‘Surface of Cylinder’ option refers to the surface of the final blank NOT your rough 
blank.  

This has just been a brief overview of how wrapped machining works, and Vectric supply a number 
of other ‘gadgets’ to help perform common rotary machining tasks such as rounding square stock, 
creating fluted columns, laying out ‘barley-twist’ spirals etc. These gadgets are documented more 
fully on the gadget section of the Vectric web-site at … 

http://www.vectric.com/WebSite/Vectric/support/gadgets.htm
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Main Menu 
Clicking on any of the options  on the title bar (File, Edit, Model, Toolpaths, View, Gadgets,Help) will 
result in a drop-down menu appearing with choices related to that topic. Many of these are just an 
alternate way to access functions also accessed through the icons, however there are a few 
commands though that are unique to the Drop Down menu. Each menu and its contents are 
discussed later in this section of the manual. Only unique items which do not have an equivalent 
icon that has already been discussed in the manual will be dealt with in detail. 
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File 

File ►New 

Creates a New Aspire job/part file, the same as this icon  

File ►Open… 

Opens an existing Aspire job, the same as this icon  

File ►Close 
Closes the current file but leaves the software running 

File ►Save 
Saves the current Aspire file (*.crv3d) over the last saved version of the file. The same as this icon.

 

Note: This command will overwrite the old file with any changes made since the last save. If you are 
not sure of your changes then use the File►Save As… command instead option and give the file a 
new name.  

File ►Save As… 
Opens the standard File Save dialog so you can save the current file with a new name. 

File ►Import…►Import Vectors… 

File ►Import…►Import Bitmap… 

File ►Import…►Import Component / 3D Model… 

File ►Import…►Import PhotoVCarve or Cut3d Toolpaths… 
Give you options to Import either Vector data, Bitmap data, 3D Model/Component (the same as 

these 3 icons ) or a toolpath file created in another Vectric application. 

File ►Export…►Selected Vectors to EPS 

File ►Export…►Selected Vectors to DXF 

File ►Export…►Selected Vectors to AI 
Lets you export selected Vectors as either an eps, ai or dxf format vector file.  

Note: When exporting in DXF format, the layer information relating to the exported vectors is 
preserved. 

File ►Open Application Data Folder… 
Automatically opens the Windows folder where files used by the software are stored. This is useful 
for adding to the default files installed initially. The application files include: 

• Bitmap textures for creating custom materials. 
• Gadget scripts for customized automation of the software. 
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• Postprocessors 
• The Tool Database 
• Default toolpath strategy settings 
• Vector texture files. 

File ►Exit 

Closes the part and exits the software 
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Edit 

Edit ►Undo 
Clicking this option steps backwards through the last 5 changes made by the user, same as this icon 

 

Edit ►Redo 
Clicking this option steps forward through design steps that have been Undone using the Undo 
command (see above) to get back to stage that the user started using the Undo function. The same 

as this icon  

Edit ►Cut 
Removes the selected objects from the job and places them onto the clipboard, the same as this icon 

 

Edit ►Copy 

Copies selected objects to the clipboard, leaving the original in place, the same as this icon  

Edit ►Paste 
Pastes the contents of the Clipboard into the model (see cut and copy above), the same as this icon 

 

Edit ►Delete 
Deletes the selected object – same as hitting the delete key on your keyboard 

Edit ►Snap Options 
Opens the Snap Options menu – for details on this see the section on Rulers, Guidelines and the 
Snap Grid at the end of the 2D Design part of this manual. Shortcut key for this is F4 

Edit ►Select All Vectors 
Selects all the currently visible vectors in the part (vectors on invisible layers are not selected) 

Edit ►Select All Open Vectors 
Selects all the currently visible Open vectors in the part 

Edit ►Select All Duplicate Vectors 
Selects all the currently visible Duplicate vectors in the part – these are vectors which are exact 
copies of each other in terms of shape and location so that visually they appear to be only one 
vector. These can cause problems for some toolpath and modeling functions so it can be useful to 
delete them or move them to a new layer.  

Edit ►Select All Vectors On Current Layer 
Selects all the vectors on the selected layer. 

Edit ►Align Selected Objects 
Give the use all the options covered under the Align Objects section of the menu – see the Align 
Objects section of this manual for more details on all the options.  
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Edit ►Join Vectors 

Opens the Join Open Vectors command, the same as this icon  

Edit ►Curve Fit Vectors 
Allows arcs, Bezier curves or lines to be fitted to existing vectors to ‘smooth’ them 

Edit ►Nest Selected Vectors 
Nest selected vectors to improve material usage. 

Edit ►Job Size and Position 

Opens the Job setup form, the same as this icon  

Edit ►Trace Bitmap  

Opens the Trace Bitmap function, the same as this icon  

Edit ►Options 
Opens the Program options form to 
allow  the customization of certain 
aspects of the program. 

The options fall into four categories: 

• General Settings 
• Window Layout 
• 3D View Settings 
• Toolpath Settings 

Window Layout 

Save Tab Layout 
Save the layout and the 
“pinned” state of the command 
and toolpath flyout tabs. 

Save Dialog Layout 
Save the size, position and 
visibility for dialogs such as the 
Layer control and Toolpath 
Control dialogs. 

Save View Layout 
Save the layout of the 2D and 3D view windows. 

Display Splash Screen 
Display the program Splash Screen, whilst the program is loading. 
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3D View Settings 

Use Shaded Background 
Use a gradient shaded background for the 3D view. 

Background Color 
Change the background color used for the 3D view, click on the ... button to display the color 
selection dialog. 

Gradient Background Color 
Change the bottom (lightest) color used for the 3D view, click on the ... button to display the 
color selection dialog. 

Draw Origin 
Draw the origin arrows by default on startup. 

Toolpath Settings 

Show Toolpath Operations with Preview 
When the toolpath Preview form is visible, keep the ‘Toolpath Operations’ section visible 
(requires more screen space). 

Auto Open 3D view 
Automatically swap to 3D view after calculating a toolpath. 

2D Solid Preview Color 
Color used to draw the solid 2D toolpath preview with. 

Create 2D Previews 
Create 2D previews of toolpaths in 2D view. 

Toolpath Geometry Fixing Timeout 
Number of seconds the program will spend trying to fix problems with geometry when 
calculating toolpaths. 

2D Toolpath Tolerance 
Tolerance to apply to 2D toolpaths after calculating to reduce file size. 

3D Toolpath Tolerance 
Tolerance to apply to 3D toolpaths after calculating to reduce file size. 

VCarve Toolpath Tolerance 
Tolerance to apply to VCarve toolpaths after calculating to reduce file size. 
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Note: We strongly recommend that the Toolpath Tolerance should be left at their default 
settings unless different values are recommended by your machine tool manufacturer. If 
you do have a machine which struggles with the default settings, try doubling the values 
and cutting a test-piece to assess the tradeoff between machining time, file size and final 
machined quality. We have done some limited testing and on a sample complex 3D model, 
increasing the ‘3D Toolpath Tolerance’ to 0.001” gave a 40% decrease in file size and no 
noticeable difference in quality on the test machine and job. In the test case there was no 
measurable difference in machining time on the CNC machine the test was carried out on. 

General Settings 

Use Graphics tablet 
Switch on support for graphics tablet drivers, if installed - for use with the sculpting tool. 

Edit►Notes 
This opens a text box where you can record notes regarding this job, such as customer name, 
material required, special setup instructions etc. To allow this, we have added a ‘Notes’ dialog which 
can be accessed using ‘Edit - Notes’ from the main menu bar. 

 

If the text starts with a period / full stop ‘.’ , the Notes dialog will be displayed automatically each 
time the file is opened. The text from the Notes dialog can also be optionally output into the 
toolpath as a comment field. Please see the ‘Post-Processor Editing Guide’ for more information on 
how to do this (using the [FILE_NOTES] variable). 
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Model 

Model ► Create Shape From Vector 

Opens the Create Shape form, the same as this icon  

Model ► Two Rail Sweep 

Opens the Two Rail sweep modeling function form, the same as this icon  

Model ► Sculpt 

Opens the Sculpting form the same as this icon  

Model ► Create Component From Selected Bitmap 

Creates a new 3D Component from a selected Bitmap image, same as this icon  

Model ► Import Component from Selected Bitmap 

Model ► Reset Inside Selected Vectors 
Deletes everything in the Working Model contained INSIDE the selected vector/s, the same 

operation as this icon  

Model ► Reset Outside Selected Vectors 
Deletes everything in the Working Model contained OUTSIDE the selected vector/s, the same 

operation as this icon  

Model ► Distort Selected Component 
Opens the Distort Object form – see Distort Objects in the Drawing & Modeling Tools section of this 
manual. 

Model ► Split Selected Component 
Splite the currently selected component using a vector. See Split Component in Modeling Tools 
section of this manual. 

Model ► Create Vector Boundary From Selected Components 
Creates a new vector that matches the edge of the selected component. 

Model ► Bake Components 
See Baking Components in the Modeling Tools section of this manual. 

Model ► Adjust Component Properties 
Opens the Component Properties form on the Modeling tab. 

Model ► Smooth Selected Component 

Opens the Smooth Model form, the same as this icon  

Model ► Scale Model Z Height 

Opens the Scale Z Height function form, the same as this icon  
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Model ► Export as STL 
Opens the  

Export As Grayscale Bitmap 
This is export option will save the Composite Model (Working Model + visible Components) as a 
raster based image file (.bmp/.jpg/.gif format). This is mainly intended for users of Laser engraving 
equipment and CarveWright/CompuCarve machines. It could also be used to export the 3D as a 
grayscale for use with graphics programs.  

When the image is exported the highest areas in the model will be white and the lowest will be 
black, all the other depths in between will be assigned graduated levels of gray depending on their 
relative position between the top and bottom of the part. Below you can see an example of the 
Composite Model on the left and the grayscale that would be saved using this feature on the right.  

  

To use this function you must have either visible Components or something in the Working Model. 

Note: See the Import / Export 16 bit grayscale images as components section of the Modeling Tools 
section of this manual for more information. 

Model ► Create Component from Toolpath Preview 
This will take the current Toolpath Preview and create a Component model from it. There are two 
main applications for this feature: 

It can be useful for helping to identify areas which have not been machined so a smaller tool can be 
used to carve them with more detail.  

It can be used to create model Components where some of the shape has been created using the 
tool shape such as fluted veins on a leaf or a texture toolpath]. This second application would be 
particularly beneficial for customers who plan to save a grayscale image of the 3D model (for Laser 
or CarveWright) rather than running the actual toolpaths from the software. 

Once this is selected the current Toolpath Preview will be converted into a Component. This is then 
added to the Component List and will be called “Toolpath Preview”.  

If the part has been cut-out and the Delete Waste Material option has been used then just the parts 
left on the screen will become the Component. If the part is not fully cut-out or the waste material 
has not been deleted then the whole Toolpath Preview block will become the Component, including 



 

 
265 Navigation Homepage 

 
 

what may be scrap material. It is possible to avoid this even without deleting the waste by using the 
“Shift” key – see below for more information. 

By holding down either the “Ctrl” or “Shift” key, there are two options that can be activated when 
the Create Component from Toolpath Preview feature is selected.  

If you press the “Shift” key when you create the Component, the areas of the Toolpath Preview over 
transparent areas in the composite model will be discarded. This will give you a Component that 
represents the Toolpath Preview but deletes anything that is not within the area of the 3D model the 
toolpaths were created on in the first place.  

If you press the “Ctrl” key, the Component created will represent the difference between the 
composite model and the Toolpath Preview. The model this creates will look odd as it will just 
represent the material that was left by the radius of the tool on the finish cut. This can be useful if 
you want to machine those areas with a smaller tool as this model may then be used to create the 
vectors to limit the toolpath for that operation, minimizing the time to create a more detailed finish.  

The images below show the 3 options available. Below left is the standard Component created from 
a machined model which includes the waste block. The middle option shows the option when the 
“Shift” key is pressed which discards the Preview model outside of the original area of the machined 
part. Finally the right hand image shows the Component which is created when holding the “Ctrl” 
key down which is the different between the original part and the Preview model.  

         

IMPORTANT NOTE: When to use the Create Component from Toolpath Preview feature 

Although this option can be selected at anytime, it only makes sense to use this feature while the 
Toolpath Preview is active in the 3D View, this will ensure that the Component represents what can 
actually be seen. The Toolpath Preview can be accessed using the icon in the Toolpath Operations 
menu (shown below highlighted with a red box), this will also appear automatically after the 
calculation of any toolpath.  
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Toolpaths 

Toolpaths ► Tool Database 
Opens the Tool Database for adding or editing tools 

Toolpaths ► Recalculate All Toolpaths 

Recalculates all the Toolpaths in the part, the same as this icon  

Toolpaths ► Toolpath Drawing 
Moving the cursor over the Toolpath Drawing option displays 4 options to control whether the 
Rapid, Plunge and Retract moves on displayed toolpaths are drawn in the 3D view.  

The option to Automatically Open the 3D View after calculating a toolpath can be switched on or off. 
This option can be very useful when calculating multiple toolpaths that need to be selected in the 2D 
view, and stops the 3D view and Preview Toolpaths form from being shown. 

There are a further 3 options relating to the display of Wrapped toopaths. 

Toolpaths ► Toolpath Drawing ► Wrapping Off 
This is the default setting. The toolpaths are displayed flat. 

Toolpaths ► Toolpath Drawing ► Wrap Y Values (around X Axis) 
This is the default setting. The toolpaths are displayed flat. 

Toolpaths ► Preview Quality 
Controls the quality of the preview display. The speed that the simulation is created will depend 
upon the selected quality and the performance of the PC.  

• Standard Quality is the fastest mode and recommended for low performance PC's  
• High Quality displays good quality images and is for general use 
• Best Quality gives fantastic images, but may run slower on old PC hardware 

Toolpaths ► Templates ► Save Selected Toolpath as Template... 
Saves the toolpath that is currently selected as a template for re-use in another project. See the 
specific section on Toolpath Templates for more information. 

Toolpaths ► Templates ► Save All Visible Toolpaths as Template... 
Saves all of the currently visibile toolpaths as a single template for re-use in another project. See the 
specific section Toolpath Templates for more information. 

Toolpaths ► Templates ► Load Template... 
Loads a previously stored template containing all the settings for one or more toolpath strategies. 
These templates will need to be re-calculated using new artwork before the toolpath can be saved. 
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View 

View ► Zoom to Drawing 
Zooms the 2D view to fit the current Material size to the window so it shows as large as possible 
while still displaying the whole material area.  

View ► Refresh 2D View 
ShortCut key for this is F5. In situations where the complete vector geometry represents a very large 
job and the user zooms into a small region, the shape of arcs and curves may look faceted. Pressing 
F5 rebuilds the display information to correct the graphics being drawn on the screen. This is only a 
display issue and will not impact on the quality of toolpaths. 

View ► Guide Lines 
Allows Guide Lines to be made visible / invisible in the 2D view and gives access to  option to delete 
all Guide Lines. 

For more details see the section on Rulers, Guidelines and the Snap Grid at the end of the 2D Design 
part of this manual.  

View ► Color Shaded View 
Draws / Undraws the color shaded job in the 3D window. 

View ► Use Shaded Background 
Shows either the default gradient filled color background or a solid light blue color background. The 
solid color is very useful for saving images that need to be cropped out of the background in a 
graphics software package. 

View ► Light follows viewer 
The default light setting for the 3D window shines a light onto the job from the top left corner of the 
material bounding box. Checking this option can sometimes be used to help visualize the job more 
easily.  

View ► Draw Origin 
XYZ origin arrows can be toggled on and off in the 3D View to show exactly where the X0, Y0 and Z0 
origin is position is relative to the material.  

View ► Draw Modelling Plane 
This option controls the display of the semi-transparent ‘modeling plane’ which shows the position 
of the working model base plane.   

View ► Draw Material Block 
Toggles the drawing of a wireframe representation of the limits of the material block. This is useful 
for seeing how the 3D model will be positioned in the block of material it is being cut from. 

View ► Save Shaded Image 
Saves a color shaded image of the 3D view as a BMP, JPG or GIF file. 

Note Saving the image without the color shaded background is often useful when the image will be 
used on its own in a brochure or on a web site etc.  
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Gadgets (Optional) 
This is an optional menu option that will be present if a ‘Gadgets’ folder exists within the main 
installation folder. 

Gadgets are small add-on programs, produced by Vectric, which perform specialized tasks. Gadgets 
are distributed from the Vectric web-site and the list of available gadgets will expand over time. The 
content of the gadgets menu on the main menu bar is built dynamically when the program starts by 
scanning the ‘Gadgets’ directory under the installation folder for the program (usually C:\Program 
Files\Aspire V2.5\Gadgets). When a file ending with .VectricGadget, .exe or .bat is found in the folder 
(or sub-folder)  an entry is made in the Gadgets menu allowing you to run the program by clicking 
on its name.  

If you want direct access to a program you commonly use, just copy it into the Gadgets directory and 
restart Aspire and it will appear on the Gadget menu. Please note that many programs require other 
supporting files to run. An example is Notepad.exe which can simply be copied on its own for early 
versions of Windows, but for later versions it needs other supporting files and will not run if you just 
copy notepad.exe into the Gadgets folder. To run a program like this, create a text file with the 
contents as shown below .. 

 

and save its as “Run_Notepad.bat”  in the Gadgets folder. When you restart the program you will 
have an entry called ‘”Run Notepad” (NOTE: ‘_’ characters are replaced by a space in the menu 
entry). Clicking on this should run Notepad. 

As well as allowing direct access to other executable programs, Vectric supply a number of 
‘VectricGadget’ gadgets which interact with the program to perform a particular task. A simple 
example is the Keyhole toolpath gadget which creates a toolpath for machining keyhole slots in the 
back of your job. As well as creating the toolpath, the gadget can also create vectors on a separate 
layer showing the position and extents of the keyhole slot. 

 

If you run the gadget with no vectors selected, the following message will be displayed .. 

 

cd "C:\Windows"  

start Notepad 
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This is because the gadget uses vectors you draw on your design to specify the entry points for the 
keyhole slots. After you have drawn suitable vectors and selected them, re-running the gadget will 
display the following dialog… 

 

Gadgets are designed to be self-explanatory where ever possible and hopefully by reading the text 
on the  dialog and viewing the results users should find them easy to use.  

It is important to point out that the gadgets are NOT as polished as functionality which has been 
integrated into the main program. The gadget concept is intended to allow Vectric to produce simple 
add-ons which address minority requirements without cluttering up the main interface. As the 
Gadget library grows over time, we do not expect users to install every gadget, but only those that 
may be relevant to tasks they actually perform. We ship some gadgets which help perform common 
tasks for people with rotary axis. If a user has no interest in rotary machining, they can delete the 
‘wrapping’ gadgets from their gadgets folder and those options will no longer be available from the 
Gadgets menu. 

Documentation and new releases for gadgets will be available from the Vectric web-site 
at http://www.vectric.com/WebSite/Vectric/support/gadgets.htm 

http://www.vectric.com/WebSite/Vectric/support/gadgets.htm�
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Help 

Help ► Help Contents 
Displays an online version of the full reference manual that documents every feature and option 
available in the software. 

Note: The reference manual is not intended as a User Guide or introductory training resource – 
please don’t forget about the Getting Started guides and the extensive video tutorial library on your 
install DVD. 

Help ► Download Support Materials… 
When selected it will open a page to download the latest tutorials and support information for 
Aspire from the Vectric website. This requires a live internet connection to work correctly. Note that 
most of the support materials for Aspire are supplied on the program DVD. 

Help ► Enter License Code 
The license details provided when you purchase Aspire must be entered into this form. Your 
Registered User Name and License Code can be Copy and Pasted into the fields to ensure this works 
correctly. If you have problems then contact Vectric or the company who you purchased the 
software from ASAP. 

Help ► View the Aspire Online FAQ 
This option opens a browser window and links to the FAQ section on the Vectric web site. This 
requires a live internet connection to work correctly. 

Help ► View the Aspire User Forum … 
This option opens a browser window and links to the Vectric User Forum. We strongly recommend 
that you register and join the forum as this is a very useful source of information from the Vectric 
Team and Users all over the world. This requires a live internet connection to work correctly. 

Help ► What’s New 
This option will open a PDF document that highlights new features when software updates are 
issued. 

Help ►Post Processor Editing Guide 
Opens a PDF manual explaining how to create and edit your own post processors. 

Help ►Check for Updates 
Uses your internet connection to check if a later version of the software is available for download 
from Vectric. We recommend that you check this periodically and take advantage of any new 
software releases that become available. 

Help ► About Aspire… 
This window displays the version of the software being used, to whom the software is license and 
the type of license



 

 
273 Navigation Homepage 

 
 

Right Mouse Click menus 
Clicking the RIGHT hand mouse button in the 2D View will display a menu with choices which 
depend the current selection mode (Normal, Node Editing, Scale/Move/Rotate) and also what is 
currently selected. 
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2D View Right Mouse Menu 
The following menu is displayed when you have a vector selected or if you just RIGHT-click in the 
white background of the part. Most of these options repeat functions and icons described in this 
manual, you should refer to the appropriate section to view how these work. The move to Layer 
option is unique to the Right click menu and lets the selected objects me moved to any Layer or to a 
newly created Layer.  
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Span Editing Menu 
If the currently selection mode is set to Node Editing , one of 2 different menus will appear when the 
user clicks the RIGHT mouse button depending on whether the cursor is currently over a Node or a 
Span in the selected vector. These menus have functions in them that correspond specifically to this 
selection and position. The menu below will appear when the cursor is over the Span of a vector in 
Node editing mode. You can see a variety of choices to convert the span to a Line, Bezier (curve) or 
Arc, Insert a Point, Cut the Vector at that point or Delete the Span. All these have corresponding 
Short Cut keys (shown to the right of the command in the menu) which can be selected from the 
key-board when the mouse is in position (over a node-edit vector span) instead of Right Clicking the 
mouse button to access the menu.  
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Node Editing Menu 
The menu below will appear when the cursor is over the Node of a vector in Node editing mode. You 
can see a variety of choices to convert the span to Delete the Point, Smooth it, Cut the vector at that 
point or change the point to be the Start Point on the vector. From this menu you can also Close the 
vector, Exit the node editing mode and lastly see and edit the exact XY co-ordinate position of the 
node by selecting Properties. All these have corresponding ShortCut keys (shown to the right of the 
command in the menu) which can be selected from the key-board when the mouse is in position 
(over a node-edit vector node) instead of Right Clicking the mouse button to access the menu.  

.  
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Bitmap Properties Dialog 
When a Bitmap or Component Grayscale is the selected item and the RIGHT Mouse menu is 
activated then an option called Object Properties is available. For a Bitmap this will open the dialog 
shown below. This can be used to fade the Bitmap object to help see other overlapping objects or 
you can reduce the fade to see more details in the image, perhaps to help you manually trace 
vectors over it.  
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Component Grayscale Menu 
When a Component Grayscale is the selected item and Object Properties is selected it opens the 
Component Manager. Two other options are also available on the Right mouse click menu for a 
selected Component Grayscale. Move to Front and Move to Back. Clicking Move to Front will make 
the selected  Grayscale appear over all the other Grayscales on the same layer so you can see the 
selected one more easily. Move to Back will send the selected one behind all the others on the same 
layer so that it is easier to see all the other Grayscales in the part.  
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Glossary of Terminology 
2D View 
Shows the workspace defined when you create a new file. This is used to control the XY layout of 
vectors, bitmaps and the Component Grayscales. Typically you select an item from this view by 
clicking on it or dragging a box around it with the mouse. To move it you can click a selected item a 
second time to go into Transform mode. Some items when double clicked will open a form relating 
to the object and many have functions related to them displayed when you right mouse click over 
them. 

3D View 
This shows the Composite Model, visible Components and any visible Toolpaths. Also used to display 
the currently selected component and sculpting brush when using the Sculpting tool. 

Bitmap  
Generic term used to describe any raster (pixel) based image which can imported into Aspire using 
the Import bitmap for Tracing icon. File types supported are: bmp, jpg, gif, tif, png and jpeg. Bitmaps 
are primarily used for tracing vectors over to create toolpaths or to use with the modeling tools. 

Combine Mode 
Used to describe how different 3D entities combine with each where they overlap in the model. The 
Combine mode is used to control Components in the Component List and Model Tree. In this case 
you start at the top of the list with the first item and work down, each subsequent Component is 
integrated into the model using whichever combine mode is selected (as described below). The 
Combine mode is also available on the Create Shape and 2 Rail Sweep forms to define how the 
shape you are creating with them will be integrated into the Working Model. 

The four Combine Modes are: 

Add: Adds together any overlapping areas. Typically used when the shape is completely inside of the 
shape it is being combined with. 

Subtract: Subtracts overlapping any overlapping areas. Typically used when the shape is completely 
inside of the shape it is being combined with. 

High: Merges the overlapping areas together using the Modelling Plane as a base, what’s left are the 
parts of each shape which stick up the highest from the Plane (The union of the two 3D shapes if you 
think of a Boolean operation). Used in most cases where only part of each shape overlap. 
Low: Merges the overlapping areas of each part so only the lower parts of the overlapping areas are 
left, the intersection of the two 3D shapes if you think of a Boolean operation. Typically used when 
adding a dished or negative shape) to an existing shape. 

Component 
The building blocks of Aspire, a Component is a 3D shape, or set of shapes, which are combined with 
other Components to make the finished 3D part (for machining). Controlled mainly from the 
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Component Tree control on the drawing tab, position, size and orientation can be controlled by 
editing the Grayscale preview in the 2D View. Components can be created bitmap images, vector 
shapes or can be imported from other Aspire files, 3D Clip Art (V3M) or even other CAD modeling 
programs (STL).  

Component Tree 
Control on the Drawing Tab which lets you make changes to Components in the part. It allows you to 
draw and un-draw Components (simultaneously toggles visibility in 2D and 3D view) by checking the 
box next to the Components name. Also by clicking twice on a Components name you can re-name 
it. Multiple Components can be selected using by holding the Ctrl key as you select them. Below the 
tree are the 3D modeling tools, many of which work on the currently selected component in the 
tree. 

Group 
When you want to manipulate a number of objects together you can Group them. This is a 
temporary operation to ease the selection, movement, scaling, rotation etc. of several objects at 
once. It is reversed by Ungrouping. 

UnGroup 
Separates a set of Grouped Objects so that they can be manipulated independently again.  

Component Manager 
General name for the area of the Drawing tab (which includes the Component Tree and 3D Modeling 
tools) where the ordering , combining and management of the 3D Components can be controlled. 

File 
Generic name most often used to describe a complete Aspire project (CRV file) which contains all the 
2D, 3D and Toolpath information in a single saved file - also sometimes referred to as a Part. 

Grayscale 
2D View representation of a Component to allow selection and editing of size, position, rotation etc. 
Many of the Vector Editing tools also work with the Grayscale’s. 

Composite Model 
Generic name for the whole 3D part of a Aspire file comprising all of the currently visible 
Components and Component Groups, which are combined using their current combine modes. 

Modeling Tools 
 A selection of functions used to create and edit the shapes in the Working Model and ultimately to 
turn these into a new Component. The Modeling Tools comprise: 

Shape 
Generic name used in the documentation to refer to a 3D object, often used interchangeably 
between the Working Model and Components.  
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Short Cut Keys 
Keys on the keyboard which will activate certain commands when pushed. Example F8 to activate 
the Component Manager. You can find a full list of all the Shortcut keys in the online reference 
manual in the Frequently Asked Questions section. 

Vector 
A 2D object represented by lines, arcs or curves. Used to layout a design for 2D and 2.5D toolpathing 
and also used in Aspire to defined geometry to use with the Modeling Tools (e.g. Create Shape, 2 
Rail Sweep, Delete Inside and Delete Outside). 
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Frequently Asked Questions 
Short-Cut Keys 
Shortcut key  Description 
Ctrl A  Select All vectors  
Esc Unselect All vectors  
Select Right to Left  Selects all vectors inside and touching selection rectangle  
Select Left to Right  Only selects vectors fully inside selection rectangle 
    
N Toggles between Selection and Node Editing modes 
J Opens the Join form 
M Opens the Move form  
T Opens the Scale form for Transforming  the vectors  
R Opens the Rotate form  
F9 Moves selected vectors, bitmaps or Component grayscale  to the center 

of the material  
 Ctrl L  Opens the Layers form 
  
Space Bar  Finishes Drawing operation and stays in the same mode. 
    
Z Zoom - click top left and bottom right corners to zoom  
F Zoom to fit Material  
F6 Zoom to fit Material  
   
F1 Opens the Help File  
F2 Opens the 2D Drawing window  
F3 Opens the 3D Preview window  
F4 Opens the Snap Settings form  
F5 Refreshes the 2D window  
F6 Scales 2D view to fit material  
F8 Toggle display of the component manager 
F9 Center selected object tin view  
F11 Toggle drawing tab on  
F12 Toggle toolpath tab on  
    
Ctrl + Shift + H Creates a copy of the selection, horizontally mirrors the selection about 

the center of the material 
Ctrl + Shift + V Creates a copy of the selection, vertically mirrors the selection about the 

center of the material 
  
Groups   
G Creates a single group containing selected vectors / groups  
U Converts a Group to individual vectors or groups  
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Arrow keys  Nudge selected vectors using the Arrow keys  
  Holding Ctrl reduces the nudge distance  
  Holding Shift increases the nudge distance  
  
Node Editing    
I Insert a Point  
D Delete Point / Span  
S Smooth / Unsmooth Point  
C Cut Vector opens the vector  
B Convert span to Bezier  
A Convert span to Arc  
L Convert span to Line  
P Makes the selected node the Start Point for machining  
   
Right mouse click  Quick Edit and Quick View menus  
    
Ctrl Z  Edit Undo  
Ctrl Y  Edit Redo  
    
Ctrl C  Copy the selected vectors  
Ctrl V  Paste the selected vectors  
Ctrl & Drag  Pastes a copy of the selected vectors each time the left mouse button is 

released. 
Ctrl X  Cut the selected vectors  
   
Ctrl N  Create New file  
Ctrl O  Open an Existing  file  
Ctrl S  Save file  
  
F8 Toggles the Component Manager on or off 
  
Page Up Vertically tiles the 2D View and the 3D View window so you can see 

them both simultaneously. Currently Selected window is on the left – 
typically best to select the 2D View first when doing this. 

Page Down Horizontally tiles the 2D View and the 3D View window so you can see 
them both simultaneously. Currently Selected window is at the top – 
typically best to select the 2D View first when doing this. 
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What file formats can be used? 
Aspire will open files that have been saved in the following formats: 

Vectors 
File Suffix Format summary 
DXF Drawing Exchange Files from CAD systems 
EPS Encapsulated Postscript from Adobe Illustrator and Corel Draw etc. 
AI Adobe Illustrator 
PDF Portable Document Format for industry standard print data 
If the designs are being prepared with software such as Corel Draw or Adobe Illustrator we 
recommend that you convert the vector geometry and text to curves and switch off all patterns  or 
color fills before exporting, preferably as an EPS file. 

Images 
File Suffix Format summary 
BMP Windows Bitmap Format 
JPG, JPEG Compressed format commonly used for digital photographs & websites 
GIF A common web format, usually with a limited number of colors 
TIF, TIFF A compressed format, including a 16-bit version 
PNG More recent format with a good range of properties 
 

3D Models 
File Suffix Format summary 
STL CAD orientated 3D design packages and scanning systems 
DXF Many CAD systems – data must consist of meshes or triangles 
3DS 3D Studio and many other animation orientated packages 
OBJ Wavefront 
V3M VectorArt 3D clipart models 
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Where can I get Help? 
If you need assistance when using the software there are 5 primary places to look. 

• Program Help File - From the Main menu select Help 
• Video Tutorials - These are supplied on the installation DVD or can be downloaded from the 

Vectric website. 
• User Forum - The Vectric user forum at www.vectric.com/forum is a very useful resource for 

information on Aspire along with materials, cutters etc. and also to share knowledge and 
experiences.  

• E-mail Support: - The Vectric Support Team at support@vectric.com 
• Frequently Asked Questions (FAQ) - The support area on the Vectric web site 

at www.vectric.com maintains a list of the most frequently asked questions along with the 
answers. 

http://www.vectric.com/forum�
mailto:support@vectric.com�
http://www.vectric.com/�
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